THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCBs public domain version of the UNIX operating system. All rights reserved. Copyright 1981, Regents of the University of California.

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED "AS IS" WITH ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Cisco and the Cisco logo are trademarks or registered trademarks of Cisco and/or its affiliates in the U.S. and other countries. To view a list of Cisco trademarks, go to this URL: http://www.cisco.com/go/trademarks. Third-party trademarks mentioned are the property of their respective owners.

The use of the word partner does not imply a partnership relationship between Cisco and any other company. (1110R)

Any Internet Protocol (IP) addresses used in this document are not intended to be actual addresses. Any examples, command display output, and figures included in the document are shown for illustrative purposes only. Any use of actual IP addresses in illustrative content is unintentional and coincidental.

Copyright 2014 Cisco Systems, Inc. All rights reserved.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Table of Contents</td>
<td>iii</td>
</tr>
<tr>
<td>Preface</td>
<td>xvii</td>
</tr>
<tr>
<td>Purpose</td>
<td>xvii</td>
</tr>
<tr>
<td>Audience</td>
<td>xvii</td>
</tr>
<tr>
<td>Organization</td>
<td>xvii</td>
</tr>
<tr>
<td>Related Documentation</td>
<td>xviii</td>
</tr>
<tr>
<td>Document Conventions</td>
<td>xix</td>
</tr>
<tr>
<td>Obtaining Documentation, Obtaining Support and Security Guidelines</td>
<td>xix</td>
</tr>
<tr>
<td>Documentation Feedback</td>
<td>xx</td>
</tr>
<tr>
<td><strong>1 Getting Started</strong></td>
<td>1</td>
</tr>
<tr>
<td>1.1 The Basics</td>
<td>1</td>
</tr>
<tr>
<td>1.1.1 About Unified Contact Center Management Portal</td>
<td>1</td>
</tr>
<tr>
<td>1.1.2 About Different Kinds of User</td>
<td>2</td>
</tr>
<tr>
<td>1.1.2.1 Kinds of Unified CCMP User</td>
<td>2</td>
</tr>
<tr>
<td>1.1.2.2 Host Administrator</td>
<td>3</td>
</tr>
<tr>
<td>1.1.2.3 Tenant Administrator</td>
<td>3</td>
</tr>
<tr>
<td>1.1.2.4 Tenant User</td>
<td>3</td>
</tr>
<tr>
<td>1.1.2.5 Basic User</td>
<td>3</td>
</tr>
<tr>
<td>1.1.3 About Basic and Advanced Mode</td>
<td>3</td>
</tr>
<tr>
<td>1.2 Accessing The Web Application</td>
<td>4</td>
</tr>
<tr>
<td>1.2.1 Supported Browsers</td>
<td>4</td>
</tr>
<tr>
<td>1.2.2 Disabling Pop-up Blockers</td>
<td>4</td>
</tr>
<tr>
<td>1.2.3 Changing Your Language</td>
<td>5</td>
</tr>
<tr>
<td>1.2.4 Logging In to Unified CCMP</td>
<td>5</td>
</tr>
<tr>
<td>1.2.5 Logging In Using Single Sign On</td>
<td>6</td>
</tr>
<tr>
<td>1.2.6 Using Online Help</td>
<td>7</td>
</tr>
<tr>
<td>1.2.7 Logging Out</td>
<td>7</td>
</tr>
<tr>
<td>1.2.8 About the Home Page</td>
<td>7</td>
</tr>
<tr>
<td>1.2.8.1 Overview</td>
<td>7</td>
</tr>
</tbody>
</table>
# Table of Contents

1.2.8.2 The Top Menu ................................................................. 8
1.2.8.3 Basic Mode Options ...................................................... 8
1.2.8.4 Advanced Mode Options .............................................. 8
1.2.9 About the Folder Tree ........................................................... 9
  1.2.9.1 Overview ...................................................................... 9
  1.2.9.2 Contents and Organization ........................................ 10
  1.2.9.3 Folder Order ............................................................... 11
  1.2.9.4 Expanding and Collapsing the Folder Tree .................. 11
  1.2.9.5 Showing Child Folders .............................................. 11
  1.2.9.6 Selecting a Single Folder ........................................... 14
  1.2.9.7 Selecting Multiple Folders ........................................... 14
  1.2.9.8 Making Provisional Selections ..................................... 14
  1.2.9.9 Shortcut Menus ........................................................... 15
  1.2.9.10 Drag and Drop Operations ....................................... 16
  1.2.9.11 Keyboard Shortcuts .................................................. 16

2 Settings ....................................................................................... 18
  2.1 About Unified CCMP Settings ................................................. 18
  2.2 User Settings ....................................................................... 18
    2.2.1 Changing Your User Settings ......................................... 18
  2.3 Passwords ........................................................................... 19
    2.3.1 About Passwords .......................................................... 19
    2.3.2 Changing Your Password ............................................. 20
  2.4 System Settings .................................................................... 20
    2.4.1 About System Settings .................................................. 20
    2.4.2 Changing the System Settings ...................................... 21
    2.4.3 About the Top Menu ..................................................... 22
    2.4.4 Adding a Link to the Top Menu .................................... 22
    2.4.5 Editing a Link on the Top Menu .................................... 22
    2.4.6 Deleting a Link from the Top Menu ............................... 23
  2.5 Security Settings ................................................................... 23
    2.5.1 About Security Settings ................................................ 23
2.5.2 Changing the Security Settings ........................................... 23
2.6 Provisioning Settings ......................................................... 25
  2.6.1 Changing the Provisioning Settings ..................................... 25
2.7 Viewing the Unified CCMP Version .......................................... 26

3 Service Manager ................................................................. 27
  3.1 About Service Manager .......................................................... 27
  3.2 Configuring Access to the Service Management Tools ................. 27
  3.3 Agent Team Management ....................................................... 28
    3.3.1 About the Agent Teams Tool .............................................. 28
    3.3.2 Viewing an Agent Team ................................................... 28
    3.3.3 Viewing or Editing Agents ............................................... 28
    3.3.4 Changing an Agent’s Team ............................................... 30
    3.3.5 Adding a New Agent ...................................................... 30
    3.3.6 Adding a New Person ..................................................... 32
  3.4 Agent Reskilling ............................................................... 33
    3.4.1 About the Re-Skilling Tool ............................................... 33
    3.4.2 Viewing a Skill Group .................................................... 33
    3.4.3 Adding an Agent to a Skill Group ...................................... 34
    3.4.4 Removing an Agent from a Skill Group ............................... 34

4 Information Notices ........................................................... 35
  4.1 About Information Notices ................................................... 35
  4.2 Viewing Current Information Notices ..................................... 35
  4.3 Advanced Mode Options ...................................................... 36
    4.3.1 About Advanced Mode Options ......................................... 36
    4.3.2 Creating an Information Notice ......................................... 36
    4.3.3 Viewing Information Notices ............................................. 37
    4.3.4 Editing an Information Notice ........................................... 37
    4.3.5 Deleting an Information Notice ......................................... 37
    4.3.6 Moving an Information Notice .......................................... 37

5 Activity Monitor ................................................................. 38
  5.1 About the Activity Monitor .................................................. 38
5.2 Provisioning Queue Tab ................................................................. 38
5.3 Audit Detail Tab ............................................................................. 40

6 System Manager .............................................................................. 42
  6.1 Introduction .................................................................................. 42
    6.1.1 About System Manager .......................................................... 42
    6.1.2 System Management Tools ..................................................... 42
    6.1.3 System Manager User Interface .............................................. 43
      6.1.3.1 Overview ...................................................................... 43
      6.1.3.2 Folder Tree Panel .......................................................... 43
      6.1.3.3 Items Panel ................................................................... 44
      6.1.3.4 Details Panel .................................................................. 45
    6.1.4 Common Details Panel Tabs ................................................... 45
      6.1.4.1 Details Tab ................................................................. 45
      6.1.4.2 Associations Tabs ........................................................ 46
      6.1.4.3 Advanced Tab ............................................................. 46
      6.1.4.4 History Tab ................................................................... 46
      6.1.4.5 Custom Data Tab ........................................................... 47
  6.2 Folders .......................................................................................... 47
    6.2.1 About Folders ......................................................................... 47
    6.2.2 Creating a Folder .................................................................... 48
    6.2.3 Renaming a Folder ................................................................ 49
    6.2.4 Moving a Folder .................................................................... 49
    6.2.5 Deleting a Folder .................................................................. 50
    6.2.6 Bulk Uploading Folders ........................................................ 51
  6.3 Tenants and Prefix Rules ............................................................... 51
    6.3.1 About Tenants and Prefix Rules ............................................ 51
      6.3.1.1 Tenants .......................................................................... 51
      6.3.1.2 Prefix Rules ................................................................. 51
    6.3.2 Creating a Prefix Rule ............................................................ 52
    6.3.3 Editing a Prefix Rule .............................................................. 53
    6.3.4 Viewing a Prefix Rule ............................................................. 54
<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>6.5.6</td>
<td>Bulk Upload Person Template</td>
</tr>
<tr>
<td>6.5.7</td>
<td>Bulk Upload Agent Template</td>
</tr>
<tr>
<td>6.5.8</td>
<td>Bulk Upload Agent Desktop Template</td>
</tr>
<tr>
<td>6.5.9</td>
<td>Bulk Upload Agent Team Template</td>
</tr>
<tr>
<td>6.5.10</td>
<td>Bulk Upload Attributes Template</td>
</tr>
<tr>
<td>6.5.11</td>
<td>Bulk Upload Call Type Template</td>
</tr>
<tr>
<td>6.5.12</td>
<td>Bulk Upload Departments Template</td>
</tr>
<tr>
<td>6.5.13</td>
<td>Bulk Upload Dialed Number Template</td>
</tr>
<tr>
<td>6.5.14</td>
<td>Bulk Upload Enterprise Skill Group Template</td>
</tr>
<tr>
<td>6.5.15</td>
<td>Bulk Upload Folders Template</td>
</tr>
<tr>
<td>6.5.16</td>
<td>Bulk Upload Label Template</td>
</tr>
<tr>
<td>6.5.17</td>
<td>Bulk Upload Network VRU Scripts Template</td>
</tr>
<tr>
<td>6.5.18</td>
<td>Bulk Upload Precision Queues Template</td>
</tr>
<tr>
<td>6.5.18.1</td>
<td>Syntax for Precision Queue Steps</td>
</tr>
<tr>
<td>6.5.19</td>
<td>Bulk Upload Skill Group Template</td>
</tr>
<tr>
<td>6.5.20</td>
<td>Bulk Upload User Variable Template</td>
</tr>
<tr>
<td>6.5.21</td>
<td>Bulk Upload Users Template</td>
</tr>
<tr>
<td>6.6</td>
<td>Item Merge</td>
</tr>
<tr>
<td>6.6.1</td>
<td>About Merging</td>
</tr>
<tr>
<td>6.6.2</td>
<td>Merging Items</td>
</tr>
<tr>
<td>6.6.2.1</td>
<td>Overview</td>
</tr>
<tr>
<td>6.6.2.2</td>
<td>Master Item</td>
</tr>
<tr>
<td>6.6.2.3</td>
<td>Items to Merge</td>
</tr>
<tr>
<td>6.6.2.4</td>
<td>Filter Options</td>
</tr>
<tr>
<td>6.6.2.5</td>
<td>Merge</td>
</tr>
<tr>
<td>6.7</td>
<td>System Search Folders</td>
</tr>
<tr>
<td>6.7.1</td>
<td>About System Search Folders</td>
</tr>
<tr>
<td>6.7.2</td>
<td>Viewing Search Details</td>
</tr>
<tr>
<td>6.7.3</td>
<td>Running a Predefined Search</td>
</tr>
<tr>
<td>6.7.4</td>
<td>Refreshing the Search Results</td>
</tr>
<tr>
<td>6.7.5</td>
<td>Moving or Deleting Searches</td>
</tr>
</tbody>
</table>
7.5.1 About Attributes ................................................................. 113
  7.5.1.1 Attribute Examples ..................................................... 114
  7.5.2 Creating an Attribute ..................................................... 114
  7.5.3 Editing an Attribute ....................................................... 115
  7.5.4 Deleting an Attribute ..................................................... 115
  7.5.5 Bulk Uploading Attributes .............................................. 116
  7.5.6 Attribute Fields ............................................................. 116
7.6 Call Types ........................................................................... 118
  7.6.1 About Call Types ............................................................. 118
    7.6.1.1 Overview ................................................................. 118
    7.6.1.2 Call Types and Dialed Number Associations .................. 118
    7.6.1.3 Call Types and Routing Scripts ................................... 119
    7.6.2 Creating a Call Type ..................................................... 119
    7.6.3 Deleting a Call Type ..................................................... 120
    7.6.4 Bulk Uploading Call Types .......................................... 120
    7.6.5 Call Type Fields ........................................................... 120
7.7 Departments ......................................................................... 122
  7.7.1 About Departments .......................................................... 122
  7.7.2 Creating a Department .................................................... 123
  7.7.3 Editing a Department ....................................................... 123
  7.7.4 Deleting a Department ..................................................... 124
  7.7.5 Bulk Uploading Departments .......................................... 124
  7.7.6 Department Fields ........................................................... 124
7.8 Device Profiles ...................................................................... 125
  7.8.1 About Device Profiles ...................................................... 125
  7.8.2 Creating a Device Profile .................................................. 126
  7.8.3 Deleting a Device Profile .................................................. 126
  7.8.4 Device Profile Fields ....................................................... 126
7.9 Dialed Numbers ..................................................................... 129
  7.9.1 About Dialed Numbers ..................................................... 129
  7.9.2 Creating a Dialed Number ................................................ 129
7.14.4 Deleting an IVR App .................................................. 150
7.14.5 IVR App Fields ......................................................... 151
7.15 Labels ................................................................. 151
7.15.1 About Labels ......................................................... 151
7.15.2 Creating a Label .................................................... 151
7.15.3 Deleting a Label ..................................................... 152
7.15.4 Bulk Uploading Labels ............................................. 152
7.15.5 Label Fields ........................................................ 152
7.16 Media Files .......................................................... 154
7.16.1 About Media Files .................................................. 154
7.16.2 Creating a Media File .............................................. 154
7.16.3 Editing a Media File ............................................... 155
7.16.4 Deleting a Media File .............................................. 155
7.16.5 Media File Fields .................................................. 156
7.17 Network VRU Scripts ................................................. 156
7.17.1 About Network VRU Scripts ...................................... 156
7.17.1.1 Micro-Applications ............................................. 157
7.17.1.2 Network VRU Script Configuration ....................... 157
7.17.2 Creating a Network VRU Script ............................... 158
7.17.3 Associating an Audio File with a Network VRU Script .... 158
7.17.4 Editing a Network VRU Script .................................. 159
7.17.5 Deleting a Network VRU Script ................................ 160
7.17.6 Bulk Uploading Network VRU Scripts ....................... 160
7.17.7 Network VRU Script Fields ..................................... 160
7.18 Peripherals .......................................................... 164
7.18.1 About Peripherals .................................................. 164
7.18.2 Editing a Peripheral ............................................... 165
7.18.3 Peripheral Fields .................................................. 165
7.19 Persons .............................................................. 166
7.19.1 About Persons ..................................................... 166
7.19.2 Creating a Person .................................................. 166
7.19.3 Changing a Person's Password ........................................ 167
7.19.4 Deleting a Person ...................................................... 167
7.19.5 Bulk Uploading Persons ............................................. 167
7.19.6 Person Fields .......................................................... 167

7.20 Precision Queues ....................................................... 174
7.20.1 About Precision Queues ............................................. 174
   7.20.1.1 Precision Queue Steps ....................................... 174
   7.20.1.2 Consider If Conditions ...................................... 175
   7.20.1.3 Expressions .................................................... 175
   7.20.1.4 Attribute Comparisons ...................................... 175
7.20.2 Creating a Precision Queue ....................................... 176
7.20.3 Editing a Precision Queue ......................................... 176
7.20.4 Deleting a Precision Queue ....................................... 176
7.20.5 Bulk Uploading Precision Queues ................................ 177
7.20.6 Precision Queue Fields ............................................ 177

7.21 Services ................................................................. 184
7.21.1 About Services ..................................................... 184
7.21.2 Creating a Service .................................................. 184
7.21.3 Deleting a Service .................................................. 185
7.21.4 Service Fields ....................................................... 185

7.22 Skill Groups ............................................................. 188
7.22.1 About Skill Groups ................................................ 188
7.22.2 Creating a Skill Group ............................................ 189
7.22.3 Editing a Skill Group ............................................. 189
7.22.4 Deleting a Skill Group ............................................ 190
7.22.5 Bulk Uploading Skill Groups ................................... 190
7.22.6 Skill Group Fields ................................................ 190

7.23 User Variables .......................................................... 194
7.23.1 About User Variables ............................................. 194
7.23.2 Creating a User Variable ....................................... 194
7.23.3 Deleting a User Variable ....................................... 194
7.23.4 Bulk Uploading User Variables ........................................... 195
7.23.5 User Variable Fields .............................................................. 195
8 Security Manager ..................................................................... 197
  8.1 Security Features ................................................................... 197
    8.1.1 About Security ................................................................. 197
      8.1.1.1 Security and the Folder Structure ................................... 197
      8.1.1.2 Inheritance and Policy Root Folders ............................. 197
    8.1.2 About Users and Groups .................................................. 198
    8.1.3 About Default Groups ...................................................... 199
    8.1.4 About Permissions .......................................................... 199
    8.1.5 About Default Roles ...................................................... 200
    8.1.6 About Security Management Tools ................................... 200
  8.2 Global Roles ........................................................................ 201
    8.2.1 About The Global Role Manager ....................................... 201
    8.2.2 About Global Roles ......................................................... 201
    8.2.3 Managing Global Roles .................................................... 202
    8.2.4 Creating a Global Role ..................................................... 202
    8.2.5 Assigning a Global Role ................................................... 202
    8.2.6 Editing a Global Role ....................................................... 203
    8.2.7 Deleting a Global Role ..................................................... 203
  8.3 Folder Roles ......................................................................... 203
    8.3.1 About The Role Manager ................................................ 203
    8.3.2 About Folder Roles .......................................................... 203
    8.3.3 Managing Folder Roles ..................................................... 204
    8.3.4 Creating a Folder Role ...................................................... 204
    8.3.5 Assigning a Folder Role ................................................... 204
    8.3.6 Editing a Folder Role ....................................................... 205
    8.3.7 Deleting a Folder Role ..................................................... 205
  8.4 Users .................................................................................. 205
    8.4.1 About The User Manager ................................................ 205
    8.4.2 About Users ................................................................. 205
8.4.3 About ISE Enabled Users ............................................................ 205
8.4.4 Managing Users ........................................................................ 206
8.4.5 Creating a User .......................................................................... 206
8.4.6 Editing User Details ................................................................. 208
8.4.7 Moving a User ........................................................................... 209
8.4.8 Deleting a User .......................................................................... 209
8.4.9 Copying a User .......................................................................... 209
8.4.10 Viewing User Permissions ..................................................... 210
8.4.11 Changing User Permissions ................................................... 210
8.4.12 Changing the Groups a User Belongs To ................................ 211
8.4.13 Configuring Imported UCCE Users for ISE Integration .......... 211
8.4.14 User Fields ............................................................................. 213
  8.4.14.1 Fields Available When Creating a User ............................... 213
  8.4.14.2 Fields Available When Editing a User ................................. 216
8.5 Groups ......................................................................................... 218
  8.5.1 About The Group Manager ................................................... 218
  8.5.2 About Groups ........................................................................ 218
  8.5.3 Managing Groups .................................................................... 219
  8.5.4 Creating a Group ..................................................................... 219
  8.5.5 Editing Group Details ............................................................ 219
  8.5.6 Moving a Group ..................................................................... 220
  8.5.7 Deleting a Group .................................................................... 220
  8.5.8 Viewing Group Permissions .................................................. 221
  8.5.9 Changing Group Permissions ................................................ 221
  8.5.10 Changing the Members in a Group ......................................... 221
  8.5.11 Changing the Groups a Group Belongs To ......................... 222
  8.5.12 Group Fields ......................................................................... 223
    8.5.12.1 Fields Available When Creating a Group ....................... 223
    8.5.12.2 Fields Available When Editing a Group ......................... 223
8.6 The Security Manager ................................................................. 224
  8.6.1 About the Security Manager .................................................. 224
8.6.2 Viewing Folder Roles Assigned to a Folder ........................................... 225
8.6.3 Assigning Folder Roles to Users and Groups .......................................... 225
8.6.4 Changing the Inheritance for a Folder ................................................... 225
8.6.5 Viewing and Editing Folder Roles ............................................................ 226
8.6.6 Editing User Details ............................................................................... 226
8.6.7 Editing Group Details ............................................................................. 227

9 System Administration Tasks ........................................................................ 228
9.1 About Administrator Tasks .......................................................................... 228
9.2 Agent and Group Related Tasks .................................................................. 228
9.3 Contact Routing Tasks ................................................................................ 229

Glossary ........................................................................................................... 231
Preface

Purpose
This document explains how to use the Unified Contact Center Management Portal (Unified CCMP) to manage settings, services, security and your system using the Web Portal tool.

Audience
This document is intended for all users of Unified CCMP, from high-level administrators to team supervisors. The reader needs no technical understanding beyond a basic knowledge of how to use computers.

Organization
The sections of this guide are as follows:

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chapter 1</td>
<td>Getting Started</td>
<td>Provides basic information on the Unified CCMP environment and how to use the context-sensitive online help.</td>
</tr>
<tr>
<td>Chapter 2</td>
<td>Settings</td>
<td>Describes how users can change their settings, or the settings of others, such as email address, time-zone, or security privileges.</td>
</tr>
<tr>
<td>Chapter 3</td>
<td>Service Manager</td>
<td>Explains how supervisor users can use Unified CCMP for management of agents, teams, and skill groups.</td>
</tr>
<tr>
<td>Chapter 4</td>
<td>Information Notices</td>
<td>Explains how to view and edit information notices.</td>
</tr>
<tr>
<td>Chapter 5</td>
<td>System Manager</td>
<td>Describes the folder structure of Unified CCMP and explains how to set up and maintain agents, contacts, equipment, and other resources using Unified CCMP.</td>
</tr>
</tbody>
</table>
Chapter 6  System Manager Resource Guide  Provides detailed information about each provisionable resource type.

Chapter 7  Security Manager  Explains how to set up security settings for individual users by means of roles and tasks, and how users with the same permissions can be added to groups to simplify management.

Chapter 8  System Administration Tasks  Explains the main Unified CCMP administrative tasks.

Related Documentation

Documentation for Cisco Unified ICM/Contact Center Enterprise & Hosted, as well as related documentation, is accessible from Cisco.com at: http://www.cisco.com/cisco/web/psa/default.html.

- Related documentation includes the documentation sets for Cisco CTI Object Server (CTIOS), Cisco Agent Desktop (CAD), Cisco Agent Desktop - Browser Edition (CAD-BE), Cisco Unified Contact Center Management Portal, Cisco Unified Customer Voice Portal (CVP), Cisco Unified IP IVR, Cisco Unified Intelligence Center, and Cisco Support Tools.

- For documentation for these Cisco Unified Contact Center products, go to http://www.cisco.com/cisco/web/psa/default.html, click Voice and Unified Communications, then click Customer Collaboration, then click Cisco Unified Contact Center Products or Cisco Unified Voice Self-Service Products, then click the product/option you are interested in.

- For troubleshooting tips for these Cisco Unified Contact Center products, go to http://docwiki.cisco.com/wiki/Category:Troubleshooting, then click the product/option you are interested in.

- Documentation for Cisco Unified Communications Manager is accessible from: http://www.cisco.com/cisco/web/psa/default.html.


- The Product Alert tool is accessible from (sign in required): http://www.cisco.com/cgi-bin/Support/FieldNoticeTool/field-notice.

For a detailed list of language localizations, refer to the Cisco Unified ICM/Contact Center Product and System Localization Matrix available at the bottom of the following page:

Document Conventions

This document uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
</table>
| **boldface font**| Boldface font is used to indicate commands, such as entries, keys, buttons, folders and submenu names. For example:  
  - Choose **Edit > Find**  
  - Click **Finish** |
| *italic font*     | Italic font is used to indicate the following:  
  - To introduce a new term; for example:  
    A **skill group** is a collection of agents who share similar skills  
  - For emphasis; for example:  
    **Do not** use the numerical naming convention  
  - A syntax value that the user must replace; for example:  
    IF (**condition**, **true-value**, **false-value**)  
  - A title of a publication; for example:  
    Refer to the **Cisco CRS Installation Guide** |
| **window font**   | Window font, such as Courier, is used for the following:  
  - Text as it appears in code or that the window displays; for example:  
    `<html><title>Cisco Systems, Inc. </title></html>` |
| <>                | Angle brackets are used to indicate the following:  
  - For arguments where the context does not allow italic, such as ASCII output  
  - A character string that the user enters but that does not appear on the window, such as a password |

Obtaining Documentation, Obtaining Support and Security Guidelines

For information on obtaining documentation, obtaining support, security guidelines, and also recommended aliases and general Cisco documents, see the monthly What’s New in Cisco Product Documentation, which also lists all new and revised Cisco technical documentation, at:

Documentation Feedback

You can provide comments about this document by sending an email message to the following address: ccbu_docfeedback@cisco.com

We appreciate your comments.
This page intentionally blank.
1 Getting Started

1.1 The Basics

1.1.1 About Unified Contact Center Management Portal

Unified Contact Center Management Portal (Unified CCMP) is a browser-based management application designed for use by contact center and system administrators, business users, and supervisors. It is a dense, multi-tenanted provisioning platform that overlays the contact center equipment. The contact center equipment is viewed as consisting of configuration items, generally known as resources, such as agents or skill groups, and events logged when the resources are used by the equipment, such as call record statistics.

Unified CCMP partitions the resources in the equipment using a familiar folder paradigm. These folders are then secured using a sophisticated security structure that allows administrators to specify which users can perform which actions within the specified folders. Unified CCMP supplies a number of tools that operate on the configuration and statistics data and allow users to monitor and modify both the contact center and Unified CCMP itself. The tools are all inherently multi-tenanted and those currently supported are:

- the **Information Notices** tool provides a "Message of the Day" functionality
- the **Service Manager** tool enables the dynamic modification of Agent Teams and Skill Groups
- the **System Manager** tool enables users to create and modify resources such as agents or call types, and organize them into a hierarchical folder structure
- the **Security** tool enables administrators to set up and manage security permissions.

Unified CCMP focuses on supplying multi-tenancy functionality, playing to the business plans of hosts and large enterprises by enabling distributed or disparate contact center equipment to be partitioned.
• Unified CCMP abstracts and virtualizes the underlying contact center equipment, thereby allowing centralized deployment and decentralized control which in turn gives economies of scale while supporting multi-level user command and control.

• Unified CCMP allows the powerful and flexible native provisioning operations to be abstracted into simple, high level tasks that enable business users to rapidly add and maintain contact center services across the virtualized enterprise (or portion thereof).

• Unified CCMP users can only see the resources in the platform that they are entitled to see, thereby giving true multi-tenancy.

• Unified CCMP users can only manipulate resources visible to them, by using the tools and features they are authorized to use, thereby giving role-based task control.

Unified CCMP maintains a complete data model of the contact center equipment to which it is connected which is periodically synchronized with the equipment. In addition to the configuration information such as agent and skill-groups, Unified CCMP records the events logged by the equipment, such as call records, to provide management information.

1.1.2 About Different Kinds of User

1.1.2.1 Kinds of Unified CCMP User

There are a number of different kinds of Unified CCMP user:

• A host administrator is responsible for the whole platform and therefore has a view across all the equipment, tenants and their resources.

• A tenant administrator is responsible for the administration of the slice of the system assigned to them by the host administrator. This will usually be the part of the system that belongs to a single tenant.

• A tenant user has access only to the resources and tools assigned to them by the tenant administrator. Several sub-classes of tenant user may be created by the tenant administrator using user groups and roles to achieve their business requirements. For example one class of user may be able to add information notices.

• A basic user has limited access to the system to manage one or more agent teams.

When Unified CCMP is first installed, the host administrator configures up the platform and creates the tenant administrators. Each tenant administrator configures the tenant area and creates the tenant users.
1.1.2.2 **Host Administrator**

A host administrator is responsible for:

- Ensuring that the tenant equipment (peripherals) are correctly located in the tenant or Shared folders.
- Creating an administrator user for each tenant.
- Adding them to the tenant administrators group and assigning any specific roles.

1.1.2.3 **Tenant Administrator**

A tenant administrator is created by the host administrator and is responsible for:

- Creating a resource folder structure that maps onto the tenant's business.
- Moving the tenant's resources into the relevant subfolders.
- Creating security groups which provide the required role based access to the subfolders.
- Creating the required number of users and assigning them to the security group(s) relevant to the role of the user.

1.1.2.4 **Tenant User**

A tenant user is created by the tenant administrator. Tenant users can select the following tools from the home page, depending on the privileges they have been assigned:

- **Information Notices**: view or manage information notices
- **Security Manager**: manage users and security groups.
- **System Manager**: manage resources (sometimes referred to as dimensions).
- **Service Manager**: view and manage teams and agent reskilling.

1.1.2.5 **Basic User**

A basic user can be created by the tenant administrator or by a tenant user with sufficient privileges. Basic users have a restricted user interface that allows them to perform functions related to day-to-day team management only.

1.1.3 **About Basic and Advanced Mode**

Unified CCMP provides two user modes, basic mode and advanced mode.

- **Basic Mode** provides a simplified interface that allows supervisors to manage their teams. Basic mode users can perform a limited set of agent management functions, access information notices, and modify their own
user settings. There is no access to advanced functions like system or security management. Only options for which users have permission will be displayed.

**Advanced Mode** provides a more comprehensive interface with additional functionality. Depending on their security permissions, users may be able to:

- manage resources (Agent Teams and Skill Groups)
- manage security
- manage folders
- manage information notices

Advanced mode users can also switch between basic and advanced modes.

### 1.2 Accessing The Web Application

#### 1.2.1 Supported Browsers

The Unified CCMP web application supports the following browsers:

- Internet Explorer version 7 or later
- Google Chrome version 25 or later
- Mozilla Firefox version 18 or later.

#### 1.2.2 Disabling Pop-up Blockers

The Unified CCMP web application may be affected by browser or third-party pop-up blocking utilities. If you have trouble viewing the Unified CCMP web application, you may need to disable pop-up blocking, or enable pop-ups for Unified CCMP only.

To disable pop-up blocking (in other words, to enable pop-ups):

- In Internet Explorer, click **Tools > Internet Options**.
- Select the **Privacy** tab.
- At the bottom of the window, make sure the **Block pop-ups** is cleared.
- Click OK.

To enable pop-ups for Unified CCMP only, use Unified CCMP normally until a message displays at the top of the browser window telling you a pop-up has been blocked. Click on this and choose to permanently allow pop-ups from Unified CCMP, while remaining protected against pop-ups from other sites.
1.2.3 Changing Your Language

For new users, Unified CCMP recognizes supported languages from Internet Explorer.

To change your language preferences in your web browser before you first login follow these steps:

1. Click **Tools > Internet Options**.
2. Click **Languages**.
3. Click **Add** to add a language to your list.
4. Use the **Move Up** and **Move Down** buttons to change a language’s priority. For example, if you understand both English and French but prefer to read web pages in French, your list would contain both English and French (fr-FR), with French at the top.

To change the language settings for a user that has already accessed the system, go to the **Settings** section of the interface using the link available in the header. From there the user culture can be selected from the list of supported languages.

1.2.4 Logging In to Unified CCMP

To **login** to the system:

1. Open your web browser and in the browser’s address field, enter the address of the server that is running Unified CCMP. This will be in the format:

   \[ \text{http://<Unified CCMP server>/portal} \]

   For example: \[ \text{http://webserver1/portal} \].

2. The security access page containing the login message is displayed.

   **Tip**

   If you do not see the login message, then your system has probably been set up to use single sign on (see section 1.2.5 "Logging In Using Single Sign On").

3. Click **Agree**.
4. The Login page displays.
5. Enter your username and password and click **Login**. If the login is successful, your home page displays.

   **Notes**
   - The password field is case sensitive. If your password is 'password1' and you type 'PASSWORD1' your login will fail. If you have difficulty logging in, make sure that you have not accidentally pressed the Caps Lock key.
By default, you have a maximum of three attempts to log into the system. If, after three attempts, you have not logged in correctly, your user account may be locked. If this happens, contact the administrator responsible for re-enabling it.

If the web page is already open when you want to login, click Logout. The system displays the normal login window.

Default Host Administrator User

Before the system is used for the first time, the User Name for the host administrator is automatically set to administrator, with a blank password. A new password must be set immediately after login.

First Time Users

The first time you access Unified CCMP you may be prompted to accept a security certificate. Accept this security certificate then proceed.

After you have logged in for the first time, you may have to change your password immediately. If prompted to change your password you must do so, otherwise further access will be denied.

Automatic Logout

You will be automatically logged out if:

- you close your web browser window
- you have not performed any action on the system for twenty minutes.

1.2.5 Logging In Using Single Sign On

The administrator may have set up Unified CCMP so that it recognizes the Windows users who are able to access it. In this case, as long as you are logged into Windows as yourself, you should not need to log in to Unified CCMP at all.

The first time you access Unified CCMP using Single Sign On (SSO) a dialog box may pop up, requesting your Windows username and password. To sign in automatically in future, you need to add the Unified CCMP website to your browser's list of local intranet sites.

To do this in Internet Explorer:

1. Click Tools > Internet Options, and select the Security tab.
2. Select the Local intranet zone and click the Sites button.
3. Click Advanced to add the Unified CCMP site to Internet Explorer's list of local intranet sites.
4. Enter the URL of the Unified CCMP website in Add this website to the zone, and click Add.
5. Click OK when prompted until you are returned to the browser window.

1.2.6 Using Online Help

To open the online help, click Help in the top right hand corner of the screen. The online help opens in a separate window of your web browser.

The online help has the following sections:
- the toolbar which runs across the top. You can use the toolbar to move between topics, print topics, add a topic to your favorite topics and enter search text. Hover over a toolbar icon to see what it does (you may need to click on the toolbar first).
- the right hand pane which contains the help text
- the left hand pane which contains tabs for search and navigation. Click on a tab to open it in the left hand pane. The tabs are:
  - Contents to see and select the available help topics
  - Search to search for a help topics that include a specific word or phrase
  - Glossary to see definitions of terms used by Unified CCMP

When you first click Help, you will see help about your current task. There are several ways see other help topics.
- You can use the Contents or Search tabs in the left hand pane to choose another topic.
- You can use the Back and Forward icons on the toolbar to move backwards and forwards between the topics you have just displayed.
- You can use the Previous Topic and Next Topic icons on the toolbar to move backwards and forwards between the topics in the contents.

1.2.7 Logging Out

To log out of Unified CCMP, click Logout in the top menu. After logging out, close your browser session to ensure that no other user can interfere with your account. Alternatively, closing the web browser window logs you out of Unified CCMP automatically.

1.2.8 About the Home Page

1.2.8.1 Overview

After you have logged in, your personalized home page displays. Your home page is the launch pad for accessing the rest of the system.
If you are a **basic mode** user, you will see your team management page.
If you are an **advanced mode** user, you will see the Tools page.

1.2.8.2 The Top Menu

The menu across the top of the screen displays further functions, which may vary depending upon the system functions you are using and the permissions granted to you:

- **Home.** Click to return to your home page.
- **Tools.** Click to display a tiled view of all the tools available to you. Click on a tool to open that tool.
- **Help.** Click to display the online help. It contains everything you need to understand and use the system features. For more information see section 1.2.6 "Using Online Help".
- **Settings.** Click to change user or system settings. For more information see section 2.1 "About Unified CCMP Settings".
- **Logout.** Click to end your session. For more information see section 1.2.7 "Logging Out".

Other options may have been provided by your system administrator.

1.2.8.3 Basic Mode Options

After logging in as a basic mode user, your team management page displays. You can return to this page at any time by clicking **Home** on the top menu.

The following functions are available on your home page:

- **Agent Teams:** allows you to manage your agent teams.
- **Re-Skilling:** allows you to manage your skill groups.

You can also select **Tools** from the top menu at any time to access any of these tools.

1.2.8.4 Advanced Mode Options

Advanced mode provides access to system management functions.

To switch between basic mode and advanced mode, click **Settings > User Settings**. Select the **Advanced Mode** check box then click **Save** and **Back**.
After logging in as an advanced mode user, your home page displays. Your home page shows the tools available to you. You can return to your home page at any time by clicking **Home** on the top menu.

The following tools may be available (depending on your security permissions):

- **Information Notices** enables you to create and manage online notices; a messaging feature which informs and updates system users with important information.

- **Security** enables you to manage security by creating and managing users and groups, their roles, which define the tasks they can perform and the customer data and system functions they can access.

- **Service Manager** enables you to view and manage individual Agent Teams and Skill Groups.

- **System Manager** enables you to provision and manage the entire system.

You can also select **Tools** from the top menu at any time to access any of these tools directly.

**Note**

If you think you should have access to some of these tools but cannot see them, contact your system administrator.

### 1.2.9 About the Folder Tree

#### 1.2.9.1 Overview

**Note**

The folder tree is only available to advanced mode users. Basic mode users have a simplified interface that just shows a list of the resources that are available to them.

The Unified CCMP folder tree defines the hierarchical structure of tenants and resources in the system. It is used by many of the tools available in advanced mode. The folder tree allows users to move around the hierarchy, to view resources, and modify items, depending on the user permissions applied to the folder in the hierarchy.

Users with suitable privileges can:

- use **System Manager** to modify the structure and contents of the folder tree (see section 6.1.1 "About System Manager”)

- use **Security Manager** to apply security settings to control access to sections of the folder tree (see section 8.6.1 "About the Security Manager”).
Information Notices also uses the folder tree to display the hierarchy and to view and modify items in it.

The following sections describe the general features of the folder tree. Unless otherwise stated, the features are available everywhere the folder tree appears.

**Note**

Most users cannot access everything in the folder tree. A user can only see and modify the folders and items allowed by their user permissions.

Usually, only host administrator users can see and modify the whole folder tree. Tenant administrator users can typically see and modify the items that belong to their tenant. Other users are likely to have greater restrictions.

### 1.2.9.2 Contents and Organization

The top of the folder tree is a root folder. This usually corresponds to the service provider. Beneath the root folder are the customers, their resources and the users who can access them.

The following types of folder can occur below the root folder:

- **Search folders.** These folders contain a number of predefined searches and are only visible to users with appropriate permissions. For more information, see section 6.7.1 "About System Search Folders".

- **System folders.** These folders can only occur immediately below the root folder:
  
  - **Shared system folder.** This is a single system folder that contains resources that may be shared across all tenants. This folder can only be accessed by the Host Administrator.
  
  - **Unallocated system folder.** This is a single system folder that contains all the resources that are not allocated to a specific tenant or shared across all tenants. By default, this folder can only be accessed by the Host Administrator.

- **Tenant folders.** These folders can only occur immediately below the root folder. Each tenant has one top-level folder. The folder contains all the resources that belong to that tenant. Tenant folders are usually created by the Host Administrator when the system is first configured.

- **Resource folders (or resource filters),** containing resources of a single type. They provide quick access to all resources of that type in a folder.
Some resource types can exist at a system level or below a tenant, but some
resource types can only be associated with a tenant. For more information
see section 6.4.1 "About Resources".

- **Other folders**, which may in turn contain any of the folder types in this
  section except system folders and tenant folders. These may occur anywhere
  in the hierarchy.

**Note**

Search folders and resource folders are only shown in the folder tree in the
System Manager tool. They are not shown in the other tools.

**1.2.9.3 Folder Order**

At each node in the folder tree, folders are ordered as follows:

- Search folders, in alphabetical order (System Manager only).
- System folders, in alphabetical order.
- Tenant folders, in alphabetical order.
- Other non-resource folders, in alphabetical order.
- Resource folders, in alphabetical order (System Manager only).

**1.2.9.4 Expanding and Collapsing the Folder Tree**

Nodes in the folder tree can be expanded and collapsed using the + (plus) and -
(minus) icons displayed next to a folder. Any folder with the + icon displayed next
to it is a parent folder that contains subfolders or child folders. Click on the + icon
to expand the tree at that point and display the child folders. Similarly, click the -
icon to collapse the tree at that node and hide the child folders.

**1.2.9.5 Showing Child Folders**

To improve performance, if there are many child folders below a parent folder, not
all of them are shown when the parent folder is expanded. The number that are
shown is user configurable (Settings > User Settings > Folder Paging Size, see
section 2.2.1 "Changing Your User Settings").

If a node contains more items than the folder paging size:

- If there are more items above the first item shown in an expanded folder, the
  Page Up icon is shown at the top of the contents of the expanded node. Click
  on Page Up to scroll one page further up the items.
If there are more items below the last item shown in an expanded folder, the Page Down icon is shown at the top of the contents of the expanded node. Click on Page Down to scroll one page further down the items.

Each time the user clicks Page Down or Page Up, the items below the unexpanded node scroll down or up by the folder paging size.

Figure 1.1  Expanded Folder with More Items Below the Items Displayed
Figure 1.2  Expanded Folder with More Items Above and Below the Items Displayed

Figure 1.3  Expanded Folder with More Items Above the Items Displayed
1.2.9.6 Selecting a Single Folder
When you select a single folder in the folder tree, it is shown in dark blue highlight. What happens next depends on the tool you are using and the type of folder you have selected.

- When you select a single folder in most tools, you will see a list of items in that folder with check boxes. Clicking the check box to select an item will allow you to perform a range of actions on that item, for example, editing it, moving it or deleting it.
- When you select a single folder in System Manager, you will see a summary list of the different item types and the number of each item type in that folder. Clicking an item type will display the list of items of that type in the folder (for more information see section 6.1.3.3 "Items Panel").

1.2.9.7 Selecting Multiple Folders
You can select multiple folders in the folder tree in one of the two ways:

- select several individual folders by selecting each folder with CRTL + Click
- select a range of consecutive folders by selecting the first one in the range using Click as usual, and the last one in the range using SHIFT + Click.

Note
Even though you have selected multiple folders, some folder tree commands (for example, Delete, Create) will only apply to the first folder in a multiple selection. The main use for multiple selections is when using drag and drop to move folders (see section 1.2.9.10 "Drag and Drop Operations").

1.2.9.8 Making Provisional Selections
You can make a provisional selection by hovering over another folder in the tree with the mouse, or by using the arrow keys on the keyboard to move from the currently selected folder to another folder in the tree.

If there is a provisionally selected folder, it is shown in lighter blue.

The provisional folder does not become the selected folder until it is explicitly selected, either by clicking on it with the mouse (left or right click) or by pressing the SPACEBAR. To improve performance, the rest of the user display is not updated until the provisional folder is selected as the current folder.
1.2.9.9 Shortcut Menus

You can right click on most folders in the folder tree to get a shortcut menu. The options shown on the shortcut menu depend on the type of folder you choose. The following options may be shown:

- **Create Folder**: Create new folder below the selected folder, if you have sufficient permissions. The folder is created with a default name of `New N`, a blank description, and inherits the permissions of the parent folder. You cannot insert a folder below the search folder or any of the predefined searches, or below a resource folder.

- **Delete Folder**: Delete the selected folder, if you have the permission to delete that folder. You will be asked to confirm the deletion. You cannot delete the root folder, the search folder, any of the predefined searches, the shared folder, the unallocated folder, or a resource folder.

- **Rename Folder**: Make the folder name available for editing. Any text you enter will overwrite the existing folder name. You cannot rename the root folder, the search folder, any of the predefined searches, the shared folder, the unallocated folder, or a resource folder.

- **Refresh**: Refresh the folder tree at the selected node to show the latest information. If there is an associated Items panel display, that is refreshed too.
1.2.9.10 Drag and Drop Operations

You can select one or more folders in the folder tree and move them to another location in the tree using your mouse to drag and drop the selected items to a new location.

While you are dragging the folders, if it is valid to drop them at the current location, you will see a green tick beside the folders you are dragging. If you cannot drop the folders at the current location, you will see a red cross beside the folders you are dragging.

While you are dragging the folders, if you pause with your mouse over a folder that is currently collapsed, it will expand so you can see the subfolders.

When the move operation starts, you will see a message saying the items in the folder are being moved. You will see another message confirming that the move has completed. Click OK when you see the confirmation message.

Note
When you use drag and drop to move folders and the items they contain, the usual rules for moving items of that type apply. For example, if you move some resources from one tenant to another, existing relationships may be broken, or existing resources deleted and new ones recreated. See section 6.4.8 "Purging Resources" for more details.

1.2.9.11 Keyboard Shortcuts

You can use the following keyboard shortcuts in the folder tree:

- **INS**: insert a new folder below the currently selected folder (if the operation is supported and you have the permission to create a folder there). The folder is created with a default name of **New N**, a blank description, and which inherits the permissions of the parent folder. You cannot insert a folder below the search folder or any of the predefined searches, or below a resource folder.
**DEL**: display a warning message asking if you want to delete the currently selected folder (if the operation is supported and you have the permission to delete that folder). You cannot delete the root folder, the search folder, any of the predefined searches, the shared folder, the unallocated folder or a resource folder.

**LEFT ARROW**: if the provisional selection is on an expanded node of the folder tree, collapse the node, otherwise move the provisional selection one position up the folder tree.

**DOWN ARROW**: move the provisional selection one position down the folder tree.

**UP ARROW**: move the provisional selection one position up the folder tree.

**RIGHT ARROW**: if the provisional selection is on a collapsed node of the folder tree, expand the node. If not, move the provisional selection one position down the folder tree.

**SPACEBAR**: if the provisional selection is different from the current selection, make the provisional selection into the current selection. But if the provisional selection is on the Page Up or Page Down command, action the command.

**F2**: make the currently selected item available to be renamed.
2 Settings

2.1 About Unified CCMP Settings
The Settings page allows you to customize several areas of Unified CCMP operation.

- **User Settings** enables users to change their time zone, culture, name, description and various display parameters. Advanced users can also change their home page settings.
- **Change Password** enables users to change their password.
- **System Settings** enable users with host administrator permissions to set system options such as the login message.
- **Security Settings** enables users with host administrator permissions to set system security options such as password requirements or the default security groups created in each policy root.
- **Provisioning Settings** enables users with host administrator permissions to set resource management options such as whether agent states can be traced.
- **About** enables you to see the version of Unified CCMP that is being used.

2.2 User Settings

2.2.1 Changing Your User Settings
Click **Settings** to display the Settings page. Select **User Settings** from the left menu panel. The Update settings for this user page displays.

- **Timezone**: local time region. Select a zone from the drop-down list.
- **Report Timezone**: the timezone used by reports. This setting is not used by Unified CCMP.
- **Culture**: local language. Select from the drop-down list.
- **First Name** and **Last Name**: your preferred names identifying you in Unified CCMP.
- **Email Address**: email address to which Unified CCMP may send any emails if necessary.
- **Description**: a suitable description of yourself (such as job title or departmental role).
- **Data Paging Size**: dictates the number of selected items to be displayed per page, for example, in the central Items panel of the System Manager. Numbers above 20 are not recommended.
- **Folder Paging Size**: specifies the number of folders to be displayed at one time in an expanded node of the folder tree. Low numbers reduce the time taken to generate and display the folder tree.
- **Show Default Parameter Set**: displays available parameter sets of the correct type when the user is viewing a report. This setting is not used by Unified CCMP.

### Additional Fields for Advanced Mode Users

Users who are able to use advanced mode can access further options.

- **Advanced Mode**: Select to use the advanced mode user interface, clear to use the basic mode user interface. In advanced mode your home page is the Tools page, whereas in basic mode, your home page will show your team management page.
- **User Home Folder**: the folder you work in by default. This must be a folder on which you have security permissions.
- **Show Deleted Resources**: select this check box to view all deleted items you have permission to see, or clear it to view only active and pending items.

Select or overwrite the required fields and click **Save** to save your settings.

### 2.3 Passwords

#### 2.3.1 About Passwords

You need to change/set your password when:

- You log in to Unified CCMP for the first time.
- Your password has expired.
- Others know your password.
2.3.2 Changing Your Password

Tip
Create a secure password by choosing a memorable phrase. For example, choose your favorite proverb or line of a poem, selecting the first letters of each word in the phrase. Turn some of those letters into numbers. For example, the proverb 'a chain is no stronger than its weakest link', can be shortened to 'acinstiwl', which you can then turn into a password 'AC1nst1WL' which is easy to remember, but difficult for a hacker to crack.

Note
Your password cannot be the same as your login name, and must meet any password restrictions specified by the system administrator in Settings > Security Settings.

To change your password:
1. Click Settings, and then click Change Password on the left menu-panel. The Change your password settings page is displayed.
2. Enter your old password.
3. Enter a new password.
4. Re-enter your new password in the Confirm Password field.
5. Click Save and then Back.

2.4 System Settings

2.4.1 About System Settings

The System Settings allow a user with sufficient privileges to:

- change the message that is displayed at system login
- add additional customized links to the commands available on the top Unified CCMP menu.
2.4.2 Changing the System Settings

Only users with sufficient permissions can access and manage system settings.

To display the Settings page click the **Settings** link and select **System Settings** from the left menu panel.

- **Product Name** field displays the name of the application.
- **Set for Language** allows you to modify the messages displayed for users of specific languages. Selecting the value (Default Entry) allows you to edit the messages displayed to users accessing the application using an unconfigured language.
- **Login Message** allows you to set the message displayed to a user before the user logs into the system (this is known as the splash screen). By default a WYSIWYG editor is used, but by clicking on the <> button you can choose to work in plain text or insert your own HTML tags instead. Click the <> button again to return to the WYSIWYG editor. You can remove the splash screen entirely by setting a blank message.
- **Login Message, Message Agreement Link** field contains the text to display on the button that the user must click to proceed from the login message to the login page. This text should be no longer than 40 characters.
- **Post Login Message** allows you to set the message displayed to a user after the user has logged into the system. Again, you can set a blank message to remove this screen entirely.
- **Post Login Message, Message Agreement Link** field contains the text to display on the button that the user must click to proceed from the post login message to the application. This text should be no longer than 40 characters.

**Notes**

- Ideally, the login and post login messages should not exceed six lines (about 500 characters) in the default 8 point font or three lines in 14 point font.
- The login and post login messages have a maximum limit of 2000 characters. This includes the HTML tags embedded in the plain text.
- To use the WYSIWYG editor to format the login message or post login message, you must highlight the text to be formatted and use the appropriate editor function.
When the system is first installed, the login message is set to a default message. This is pre-translated for the following language and culture settings: Chinese (People's Republic of China), Chinese (Taiwan), Danish (Denmark), Dutch (Netherlands), French (Canada), French (France), German (Germany), Italian (Italy), Japanese (Japan), Korean (Korea), Portuguese (Brazil), Russian (Russia), Spanish (Spain) and Swedish (Sweden). For all other language and culture settings, the default login message is in English, although you may change it if you wish.

When the system is first installed, the post login message is not set.

### 2.4.3 About the Top Menu

The top menu is displayed at the top right of every screen. Users with sufficient permissions can customize the top menu to include their own links.

**Note**
Changes to the top menu are system-wide and will be applied to all tenants.

### 2.4.4 Adding a Link to the Top Menu

To add a new custom link to the top menu:

1. In the System Settings screen, click the **Customize Top Menu** button to open the Customize Top Menu page.
2. In the Create a new menu item section:
   - **Name** Enter the text to be shown in the top menu
   - **Link** Enter the URL to link to. You can check that this is valid by clicking the **Check Link** (✓) icon to the right of the link.
3. Click **Add**.

### 2.4.5 Editing a Link on the Top Menu

To edit an existing custom link on the top menu:

1. Click **Customize Top Menu** option in the toolbar to open the Customize Top Menu page.
2. Existing links are shown in the Existing editable menu-items list. Point to one of these to bring up the **Edit** icon (✓) and the **Delete** (✗) icon for that item.
3. Click **Edit**.
4. Change the link details as desired.
5. Click the **OK** icon (✓) to save your changes, or the **Cancel** icon (✗) to exit without saving your changes.

**Note**
The custom link is not changed until you select Back and return to the System Settings page.

### 2.4.6 Deleting a Link from the Top Menu

To delete an existing custom link from the top menu:

1. Click **Customize Top Menu** option in the toolbar to open the Customize Top Menu page.

2. Existing links are shown in the Existing editable menu-items list. Point to one of these to bring up the **Edit** icon (✎) and the **Delete** (✗) icon for that item.

3. Click **Delete**, and then **OK** at the confirmation dialog.

4. Click **Back** to return to the System Settings page. The custom link will be removed.

**Note**
The custom link is not removed until you select **Back** and return to the System Settings page.

### 2.5 Security Settings

#### 2.5.1 About Security Settings

Security settings cover all aspects of system security, from password restrictions to security groups. Typically, only a user with host administrator permissions has the right to access and manage security settings.

#### 2.5.2 Changing the Security Settings

To change the system’s security settings, click the **Settings** link. Then click **Security Settings**. The following security settings are available:

- **New Folder Inheritance Default**. If checked, then, when creating new folders, the Inherit Permissions check box is checked by default.

- **Password Format**. The required format for the password entered by a user. The options are:
- **Custom.** A custom string defined by a regular expression. This is for system administrators only, and requires a knowledge of regular expressions.

- **Low Security.** Any string of any length.

- **Medium Security.** Any string between the minimum and maximum password length.

- **Medium/High Security.** Any string between the minimum and maximum password length, containing at least one lowercase value, one uppercase value and one numeric value.

- **High Security.** Any string between the minimum and maximum password length, containing at least one lowercase value, one uppercase value and one numeric value, and at least one of the following special characters: @ # $ % ^ & + !

**Note**

Not all the settings below apply to all password formats, but where a setting is available for a password format, it is independent of the password format. For example, you may specify that the password follows the Medium Security format, and that the minimum password length is 6 (instead of the default value of 8). If you later change the password format to High Security, the previously-set minimum password length of 6 will still apply to the new password format, unless you change it again.

- **Password Expression.** A regular expression defining the required password format. Only shown when the selected Password Format is Custom.

- **Minimum Password Length.** The lowest number of characters the system will accept as valid for a password. Only shown when the selected Password Format is one of Medium Security, Medium/High Security or High Security.

- **Maximum Password Length.** The highest number of characters the system will accept as valid for a password. Only shown when the selected Password Format is one of Medium Security, Medium/High Security or High Security.

- **Minimum Password Age (days).** The number of days a user must wait between password changes.

- **Password Expiry (days).** The number of days before the user is asked to change their password.

- **Number of previous passwords to check.** The number of previous passwords the user cannot reuse when choosing a new password.

- **Login attempts before lockout.** The number of times the user can enter the wrong password before being locked out of the system.
- **User Folder Default Role.** The default folder role that a new user is given on the user folder when the Create a New Folder for This User option is selected during user creation. This is a drop-down containing a list of the folder roles available in the system (for more information see section 8.3.1 "About The Role Manager"). Note that you will still need to give the user the correct global roles so that they can actually use these permissions (for more information see section 8.2.1 "About The Global Role Manager").

- **User Folder Suffix.** (Optional) The suffix which, when added to a user's name, becomes the name of the personal folder created when the Create a new folder for this user option is checked during user creation. This is a drop-down containing a list of the folder roles available in the system (for more information see section 8.3.1 "About The Role Manager").

- **Groups to create when removing inheritance.** The groups that are automatically created when a folder becomes a policy root, and the permissions that they are assigned within that folder and its child folders. You can select a group and assign it a custom role, or clear the group, so that is not created automatically when a policy root folder is created. If you clear the check box for all groups, no groups will be created automatically. See section 8.1.1.2 "Inheritance and Policy Root Folders" for more information on policy roots.

**Note**

It is not currently possible to change the global roles that groups are assigned by default. The Basic User and Supervisor User groups will therefore always have the permissions of the Basic global role, and the Advanced User group will have the permissions of the Advanced global role.

### 2.6 Provisioning Settings

#### 2.6.1 Changing the Provisioning Settings

Typically, only a user with host administrator permissions has the right to access and manage provisioning settings.

To change the settings for provisioning on your system, click the Settings link. Then click Provisioning Settings. The following provisioning settings are available:

- The Agent State Trace Enabled check box determines whether or not the State Trace check box on the Agent Details page can be selected. When the State Trace check box for an agent is selected, Unified CCE will capture details of every state transition made by the agent.
An individual agent’s state will only be traced if the State Trace option is selected. To view the status of this feature click **Agent > Select an Agent > Advanced** tab.

**Note**
Agent State Trace must be limited due to the additional load it places on Unified CCE. Please see the *Cisco Unified Contact Center Enterprise Solution Reference Network Design Guide (SRND)* for details.

### 2.7 Viewing the Unified CCMP Version

The About This Installation page describes the version of Unified CCMP that is installed on your system.

To view the version of Unified CCMP installed on your system, click the **Settings** link. Then click **About**.
3 Service Manager

3.1 About Service Manager

The Service Manager provides advanced mode users with the ability to quickly and directly manage the service that is provided by the contact center, using tools that are also available directly to basic mode users. The Service Manager provides the following tools:

- **Agent Teams**, to manage agents
- **Re-Skilling**, to manage skill groups and agent reskilling.

3.2 Configuring Access to the Service Management Tools

To manage agents using the Agent Teams tool or the Re-Skilling tool, the Unified CCMP user must be associated with a related Unified CCE Person resource. This Unified CCE Person must be associated with the supervisor agent for the agent team that contains the agents to be managed.

The Agent Teams tool and the Re-Skilling tool rely on agent teams and their associated supervisors being configured correctly in Unified CCMP. Once the agent team and the associated supervisor agent exist then you can create a Unified CCMP user that can use these tools. To create the user:

1. Sign in to Unified CCMP using an Administrator account.
2. Open **System Manager** and go to the folder containing the supervisor agent.
3. Open the supervisor agent and choose the **Person** tab.
4. Click **Edit Person** (green arrow).
5. Go to the **Portal** tab.
6. Select the Portal Account (this will display **None** if no user is mapped).
7. Select **Create User** to create a new user account.
8. Specify **User Name** and **Password** for the new Unified CCMP user.

9. In the group membership screen select the **Basic User** and **Supervisor** groups for default permissions at the required location.

10. Click **Save** to create the Unified CCMP user.

### 3.3 Agent Team Management

#### 3.3.1 About the Agent Teams Tool

The Agent Teams tool allows supervisor agents to manage the Persons and Agents in their Agent Teams.

Each Agent must be associated with a Person, which represents an actual physical person who performs customer contact duties. A Person may be associated with more than one Agent. For example a person who alternates between two teams on different peripherals would need to be associated with two Agents, one on each peripheral. So John Smith, who uses voice equipment and email equipment will need:

- a person record for his details
- an associated agent record for his voice equipment
- an associated agent record for his email equipment.

To start the Agent Teams tool, click **Tools > Agent Teams**.

#### 3.3.2 Viewing an Agent Team

To see an agent team, click on the **My Agent Team** drop-down box and select the team you wish to work with. A list of the agents in the team will be shown below the box.

The agent list shows each agent's name, their status within the system (such as Ready or Pending Active), and the date from which they have been active in the system (an **Active From Date** in the future indicates an agent who has not yet started work). There is also an agent details icon ( ) that allows you to view and edit agent details, and a copy icon ( ) that allows you to create a copy of an agent (for example, if you wish to add to your team a new agent who has exactly the same skills as an existing agent).

#### 3.3.3 Viewing or Editing Agents

To view or edit an agent:

1. Select an agent team from the drop-down list.
2. Click on the agent details icon. The Edit the current Agent page will open, showing you the agent's details.

3. Make any changes to the agent. Selecting a different tab (such as Supervisor or Agent Teams) will show a different set of fields. You can always go back to previous tabs.

4. Click **Save** to save your changes or **Cancel** to leave the agent's details as they were before you started editing.

**Note**
You are unlikely to need to use the Advanced tab unless you are changing start or finish dates for an agent.

To set an agent's starting or leaving date:
1. Select an agent team from the drop-down list.
2. Click on the agent icon for the agent you wish to edit. The Edit the current Agent page will open, showing you the agent's details.
3. To set or change an agent's starting date (Active From Date) or finishing date (Active To Date), select the **Advanced** tab. You can only change the Active From Date if it is in the future – otherwise it is greyed out. To change the Active To Date, first untick the Forever box, if it is ticked.
4. To change a date, you can:
   - either use the UP and DOWN arrow keys to adjust the date and time in the date/time box
   - or click on the calendar icon beside the Active From Date or Active To Date field. A calendar popup appears.
     - To change the year, click on the drop-down arrow to select the year you want.
     - To change the month, either click on the drop-down arrow to select the month you want, or click on **Prev** or **Next** to go backwards or forwards one month at a time.
   - Select the day of the month.
5. Use the UP and DOWN arrow keys to set the time on the selected date on which the agent is starting or finishing (for example, 17:00:00 for someone leaving at the end of business hours).
6. Click **Save** to save your changes or **Cancel** to leave the agent's details as they were before you started.
3.3.4 Changing an Agent’s Team

To change an agent’s team:

1. Select the agent team to which the agent belongs from the drop-down list.
2. Click on the agent details icon (not the copy icon beside it) for the agent you wish to edit. The Edit the current Agent page will open, showing you the agent's details.
3. Click on the Agent Teams tab. The agent’s current team membership is shown.
4. Select the check box for the agent team and click Remove.
5. You may optionally select a team from the list below and click Add to add the agent to that team. You can add the agent either as a member of that team by checking the Member box, or as a primary or secondary supervisor if they are a supervisor agent.
6. Click Save.

3.3.5 Adding a New Agent

To add a new agent:

Note
All agents must be associated with a person. If a person record for the new agent does not already exist on the system, you can create one as part of adding the new agent.

1. Click New Agent menu option. The Create a New Agent page displays.
2. Fill in the fields for each tab. All mandatory fields are marked with a red asterisk. These fields are on the Details tab. Save will not be enabled until all the required fields have been filled in.
3. On the Details tab:
   - Fill in the Agent's Name (such as BOates or Beth_Oates).
   - Give a Description of the agent (such as a job title).
   - Select a Peripheral to create the agent on (this will usually be the same peripheral that you use).
   - Choose whether to associate the agent with an existing Person, or to create a new one. A Person can have more than one agent identity if all those agents are created on different peripherals.
- **Select Existing Person** Select a person from the drop-down list, or search for a specific person by typing a part of their name in the Search box. The new agent will use the details specified in that Person’s Peripheral Login box to log on to their Agent Desktop.

- **Create New Person** Enter the first name and last (or family) name for the person, and fill in the details they will use to login to the peripheral. The person will be automatically created and associated with the agent.

**Note**
Multiple Agents may be associated with a single Person, if all Agents involved are on different peripherals

4. In the **Supervisor** tab:
   - If the agent is to be a supervisor, check the Supervisor check box.
   - If the Supervisor box is checked, the agent must be associated with a Domain Account (the account they will use to log into a computer on the contact center network). Type in part of the account name, click Find and then select the correct account.

**Note**
You cannot set up a domain account from Unified CCMP. Contact your IT department if you are uncertain of the domain account to use.

5. In the **Agent Teams** tab:
   - Select an agent team for the agent to belong to. Agents may only be a member of a single team, but a supervisor can supervise multiple teams. Use the Selected Path drop-down to see agent teams in other folders.
   - Click **Add** to associate the team with this agent.
   - Check the Member box to make the agent a member of the team. Supervisors can supervise a team without being a member.
   - If the agent is a supervisor, select a primary or secondary supervisory role for any team they are to supervise. They may or may not also be a member of this team.

6. In the **Skill Groups** tab:
   - Select skill groups for the agent to belong to. Use the **Selected Path** drop-down to change folders.
7. In the **Advanced** tab:

**Note**
You will probably only edit these settings to set an agent's start or finish date.

- **Enterprise Name** is the name the agent is known as within Unified CCMP
- **Agent Extension** is the internal extension number for the agent
- **Agent Desktop** allows you to specify the agent's desk settings (also called the Desk Setting)
- **Check State Trace** if you wish to let the system track the agent’s state, such as whether they are logged off or talking
- Use the **Active From Date** box to set the agent's starting time and date (you may enter the date manually in day/month/year format, or select a date from the calendar)
- Use the **Active To Date** box to set the agent's leaving date

8. Check the **Create Another** check box to create another agent whose settings are identical to this agent’s except for their name and login details

9. Click **Save** to create the agent, or Cancel to cancel agent creation and return to your home page.

### 3.3.6 Adding a New Person

To add a new person:

1. Click **Create Person** option.

2. All mandatory fields are marked with a red asterisk. These fields are on the Details tab. **Save** will not be enabled until all the required fields have been filled in

3. In the **Details** tab:
   - **Person's First Name** (such as Janet or John)
   - **Person's Last Name** or family name (such as Smith or Black)
   - **Description** of the Person (such as a job title)
   - **Login Name** they should use to log onto the Peripheral
   - **Password** they should use to log onto the Peripheral, and confirm it

4. In the **Portal** tab:
Select the **None** option to present the Portal Account interface. When prompted select the **Create User** option to add a new Unified CCMP user mapped to this Person.

- Fill in the **Login Name** they should use to log onto Unified CCMP.
- Fill in the **Password** they should use to log onto Unified CCMP, and confirm it. Passwords may be required to be of a certain length, or to contain lower case letters, upper case letters and numbers. If you have difficulty supplying a valid password, contact your system administrator.
- You may optionally add the user to any security Groups you yourself are a member of, such as your company's Supervisors group if they will need to manage teams.

5. **On the Advanced tab:**
   - Use **Active From Date** box to set the person's starting time and date (you may enter the date manually in day/month/year format, or select a date from the calendar).
   - Use **Active To Date** box to set the person's leaving date.

6. Check the **Create Another** check box to create another person after saving the current one.

7. Click **Save** to create the person, or Cancel to cancel person creation and return to your home page.

### 3.4 Agent Reskilling

#### 3.4.1 About the Re-Skilling Tool

The Re-Skilling tool allows you to view and edit agent skill group memberships. To start the Re-Skilling tool, click **Tools > Re-Skilling**.

**Note**

Unified CCMP limits the number of skill groups to which an agent can belong, to avoid affecting performance.

#### 3.4.2 Viewing a Skill Group

To see a skill group, click on the **Skillgroup** drop-down box and select the skill group you wish to work with. A list of the agents associated with the skill group
will be shown below the box. A complete list of all the agents who can be associated with the skill group (those who are on the same peripheral as the skill group) is shown below that.

The agent list shows each agent’s name, their status (such as Ready or Pending Active), and the date from which they are active in the system (an Active From Date in the future indicates an agent who has not yet started work). Clicking on the Edit icon (edit) allows you to edit the agent.

### 3.4.3 Adding an Agent to a Skill Group

To add an agent to a skill group:

1. Select a skill group for the agent or agents to belong to.
2. Select agents to belong to the skill group using the check boxes. Use the Selected Path drop-down to see agents in other folders.
3. You can type part of an agent’s name into the search box, and then click Search to filter the list of agents by the specified search string.
4. Click Add to associate the agents with this skill group
5. Click Save to save your changes, or Cancel to leave the details as they were before you started

### 3.4.4 Removing an Agent from a Skill Group

To remove an agent from a skill group:

1. Select a skill group to remove an agent or agents from.
2. In the top list, select the agents to remove from the skill group using the check boxes.
3. You can type part of an agent’s name into the search box, and then click Search to filter the list of agents by the specified search string.
4. Click Remove to remove the agents from this skill group.
5. Click Save to save your changes, or Cancel to leave the details as they were before you started.
4 Information Notices

4.1 About Information Notices

Information notices (also sometimes called system notices) are similar to a notice board or *Message of the Day* feature. Information notices are a useful way to inform all contact center staff of general information in one action and in one location, rather than having to inform each staff member individually. Notices may typically include changes to agent assignments or important customer information.

Once you have logged in, if there are any current information notices that apply to you, you will see the Information Notice icon ( ), beside the top menu at the top right corner of the screen.

4.2 Viewing Current Information Notices

To view an information notice:

1. Click the icon beside the top menu to display the Information Notices dialog box showing the information notices available, and then click on the name of the notice you wish to read from the list. The notice text will be displayed in full.

2. Once you have finished reading the notices, click the X in the top right hand corner of the Information Notices dialog box.

**Note**

The information notices panel only shows current notices. Notices which have expired (with a *Valid To* date in the past) or pending (with a *Valid From* date in the future) are not shown.
4.3 Advanced Mode Options

4.3.1 About Advanced Mode Options
Advanced mode users are able to create and edit information notices as well as view the current information notices.

To start the Information Notices tool, click Tools > Information Notices.

4.3.2 Creating an Information Notice
To create an information notice:

2. Select the folder containing the users who need to see the new notice. The folder name will be displayed at the top of the page. Then perform the following:
   - In the Subject field enter a title for the notice.
   - In the Text field enter the text. You can format the text as required by using the editor buttons displayed above the text field. Move the mouse pointer over an editor button to see what it does. Click the Show Source (<>) editor button to switch between the WYSIWYG editor and plain text with HTML tags.

   **Note**
   To format the information notice text, highlight the text to be formatted then click the appropriate editor button. The editor functions do not allow you to format the text as you type, for example, clicking the / button does not turn on italics mode for the text you type afterwards.

   - In the Valid From and Valid To fields, enter start and end dates to refine the lifetime of the notice, by clicking on the calendar icons and selecting the appropriate months and days.
   - Select the Create Another check box if you wish to add another notice after the creation of the current notice.
3. Click Save.

   **Tip**
   You can also create a notice by clicking on the Create a Notice link on the Information Notice section of the Home page.
4.3.3 Viewing Information Notices

When you select the Information Notices tool, the initial view shows a list of all information notices. This list includes all information notices, including expired information notices (with a Valid To date in the past) and pending information notices (with a Valid From date in the future).

Tip
You can also view all information notices by clicking on the View Notices link on the Information Notices section of the Home page.

4.3.4 Editing an Information Notice

To edit an information notice:

1. Select the Information Notices tool and in the list of information notices, click the name of the notice to be modified. The notice displays.
2. Click Edit. The Edit Information Notices page displays.
3. Make the required modifications to the notice in the fields provided, as explained for creating an information notice above.
4. Click Save to save your changes.

Tip
You can also edit a notice by clicking on the Edit Notice link on the Information Notice section of the Home page.

4.3.5 Deleting an Information Notice

To delete one or more information notices from the list of information notices, check the boxes by the notices you want to delete, and then click Delete.

To delete an information notice you are editing, select the Delete menu option.

4.3.6 Moving an Information Notice

To move an information notice:

1. In the list of information notices, check the box or boxes of the notice or notices to be moved. Click the Move button. The folder tree displays.
2. Select the folder to move the notice to and click Save.
5 Activity Monitor

5.1 About the Activity Monitor
The Activity Monitor allows you to view the current status of the provisioning queue and provides basic audit reporting for provisioned resources.
To start the Activity Monitor, click Tools > Activity Monitor.

5.2 Provisioning Queue Tab
Resource Displays
The Provisioning Queue tab provides two status monitors, showing a summary of provisioning information for:
- Resources I Control: the provisioning status of the remote resources that you are authorized to view or edit.
- All Resources: the provisioning status of all remote resources below the root folder, to help understand the state of the entire system.
The status monitors show real-time data that is updated every 20 seconds. Each status monitor shows:
- Errors: the number of resources that are currently in an error state. In the status display for Resources I Control, you can click on this number to view the details of the errors.
- Provisioning: the number of resources that are currently in the pending active state or awaiting deletion state. In the status display for Resources I Control, you can click on this number to view the details of these resources.
- A performance indicator: the overall system performance recently. This is to the right of the provisioning information and is one of the following symbols:
  - \( \downarrow \): the number of items in the provisioning queue is decreasing
  - \( \Rightarrow \): the number of items in the provisioning queue remains approximately constant
  - \( \uparrow \): the number of items in the provisioning queue is increasing.
- The provisioning activity graph: a graph showing the state of the provisioning queue at 20 second intervals over the last 15 minutes. At each time interval the items in the queue are color-coded as follows:
• **Green:** this represents the number of items at the time of sampling that have been in the provisioning queue for less than the time specified by the **Provisioning Warn Threshold**

• **Orange:** this represents the number of items at the time of sampling that have been in the provisioning queue for more than the time specified by the **Provisioning Warn Threshold** but less than the time specified by the **Provisioning Max Threshold**

• **Red:** this represents the number of items that have been in the provisioning queue for more than the time specified by the **Provisioning Max Threshold**.

**Note**
The Provisioning Warn Threshold and Provisioning Max Threshold values are configurable using the ICE System Properties tool (see the *Administration Guide for Cisco Unified Contact Center Management Portal*, section System Properties Manager). The default values are:

- Provisioning Warn Threshold: 5 minutes
- Provisioning Max Threshold: 10 minutes.

**Error and Provisioning Details**
Click on the number of error or provisioning resources in the Resources I Control status display to see a list of resources in that state, and the details about each operation. Some of the fields in the list are hyperlinks, so you can click on these to get more information about the item. You can also click on some of the column headers to sort the items in the list by the values in that column.

The fields that are available are:

<table>
<thead>
<tr>
<th>Field</th>
<th>Meaning</th>
<th>Hyperlink?</th>
<th>Sortable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>The date and time the event occurred, in the time zone of the current user.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Item Type</td>
<td>The type of resource affected by the event.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the resource affected by the event.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Path</td>
<td>The location of the item in the folder hierarchy.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Related Item Name</td>
<td>The name of the related resource associated with this event, if applicable.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Field                      | Meaning                                                                 | Hyperlink? | Sortable?
---                          | ---                                                                     | ---         | ---
Related Item Path            | The location of the related item in the folder hierarchy, if applicable. | No          | Yes
Last Modified by             | The login name of user that last modified the item.                    | No          | Yes
Status                       | The status of the event.                                              | No          | Yes
Internal Error (for Error Resources only) | A description of the error that occurred.                          | No          | Yes

#### 5.3 Audit Detail Tab

The Audit Detail tab shows an audit history report for provisioned resources.

The following filters are available to restrict the number of items shown in the report:

- **Path**: Click on the drop down arrow to choose the folder path for the resources you are interested in. The default folder path is your root folder.
- **Include Subfolders**: Select the checkbox to include items in subfolders in the audit history report.
- **Item Type**: Click the drop down arrow to see the available item types, then select the required items from the list. By default, no item types are selected.
- **Date from**: Select the date and time of the oldest events to display. The default value is midnight, one week ago.
- **Date to**: Select the date and time of the newest events to display. The default value is today and now.
- **Event Outcome**: Select the event outcome or outcomes you want to view. The default is to view events with both success and failure outcomes.

When you have selected your filters, click **View** to see the audit details. Some of the fields in the list are hyperlinks, so you can click on these to get more information about the item. You can also click on some of the column headers to sort the items in the list by the values in that column.

The fields that are shown are:

[Table with fields and meanings]
<table>
<thead>
<tr>
<th>Field</th>
<th>Meaning</th>
<th>Hyperlink?</th>
<th>Sortable?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Date/Time</td>
<td>The date and time the event occurred, in the current user’s time zone.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Event Description</td>
<td>The event details.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Item Type</td>
<td>The type of item affected by the event.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Name</td>
<td>The name of the resource affected by the event.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Path</td>
<td>The location of the resource in the folder hierarchy.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Related Item Name</td>
<td>The name of the related resource associated with this event, if applicable.</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Related Item Path</td>
<td>The location of the related resource in the hierarchy, if applicable.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Related Item Type</td>
<td>The type of the related resource.</td>
<td>No</td>
<td>No</td>
</tr>
<tr>
<td>Equipment</td>
<td>The equipment the item is located on.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>User</td>
<td>The login name of the user that initiated the event.</td>
<td>No</td>
<td>Yes</td>
</tr>
<tr>
<td>Event Outcome</td>
<td>The result of the event (success or failure)</td>
<td>No</td>
<td>Yes</td>
</tr>
</tbody>
</table>
6 System Manager

6.1 Introduction

6.1.1 About System Manager

The System Manager tool creates resource folders and resources and allows the user to partition the resources in a hierarchical structure. This is achieved by the use of a Folder Tree panel located at the left hand side of the tool. The user may view the subfolders of specific folders by selecting them. Users with sufficient security permissions can access and manage the entire contents of the system via the System Manager interface. The Unified CCMP web application lets you remotely configure and administer key aspects of your Unified CCE system including:

- agents, agent teams, skill groups and desktop settings
- dialed numbers and call types.

Note

You cannot use System Manager to manage security in Unified CCMP. To manage security, use the Security Manager (see section 8.6.1 "About the Security Manager").

To start System Manager, click Tools > System Manager

6.1.2 System Management Tools

Unified CCMP provides the following tools to manage your system.
<table>
<thead>
<tr>
<th>Tool Name</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Monitor</td>
<td>Allows you to monitor and inspect:</td>
</tr>
<tr>
<td></td>
<td>* the current status of the provisioning queue</td>
</tr>
<tr>
<td></td>
<td>* the audit history for remote resources.</td>
</tr>
<tr>
<td>System Manager</td>
<td>Allows you to create and modify folders and resources, to partition</td>
</tr>
<tr>
<td></td>
<td>the resources in a hierarchical structure and (for users with suitable</td>
</tr>
<tr>
<td></td>
<td>privileges) to manage the entire contents of the system.</td>
</tr>
</tbody>
</table>

These tools are available from the **Tools** menu.

### 6.1.3 System Manager User Interface

#### 6.1.3.1 Overview

The System Manager tool consists of the following panels:

- The standard toolbar, the breadcrumb trail (which shows the path by which the user accessed the current page) and the Information Management panels are displayed at the top of the browser.

- The **Folder Tree panel** displays on the left of the browser. It shows a hierarchical structure of all the resources the user is allowed to see based on their security permissions. There is a minimize bar containing two small arrowheads located on the right hand edge of the Folder Tree panel. Click on this bar to close the Folder Tree panel and give more screen space if the Folder Tree panel is not required.

- The **Items panel** displays in the middle of the browser. It shows the items contained in the currently selected folder. There is a minimize bar containing two small arrowheads located on the right hand edge of this panel. Click on this bar to give more screen space if the Items panel is not required.

- The **Details panel** displays on the right hand side of the browser. This panel displays the details of the most recent resource item selected in the Items panel. If you have sufficient security permissions, you can edit these details.

#### 6.1.3.2 Folder Tree Panel

For general information about the folder tree see section 1.2.9 "About the Folder Tree".

In System Manager, the Folder Tree panel also contains these buttons:

- **System**: allows you to create new system resource items
- **Resource**: allows you to create new remote resource items
- **Upload**: allows you to perform bulk uploads (for more information, see section 6.5.1 "About Bulk Upload").

**Caution!**
Ensure that no folder contains more than 1000 of any one type of resource. For example, a folder can contain 900 Agent resources and 900 Agent Desktop resources, but should not contain 1800 Agent resources.

### 6.1.3.3 Items Panel

**Description**
When you select an item in the Folder Tree panel, the Items panel displays the contents of that folder. Depending on what you have selected in the Folder Tree panel, the Items panel may show a list view, or a summary view.

- If the selected item is a resource folder, the Items panel is a list view. The list view show a list of each of the items of that resource type in the resource folder. Each item has a check box beside it to allow it to be selected for a move or delete operation. Click on the item itself to display the item details in the Details panel.

- If the selected item is any other sort of folder, the Items panel is a summary view. The summary view shows a summary list of each of the resource types in that folder, and the number of each resource type. When you click on a resource type in the summary list, the Items panel displays a list view containing each of the items of that resource type in the resource folder.

**Note**
In Unified CCMP 9.1 and later, the summary view in the Items panel does not have a separate summary list item for tenants. Tenants are included in the folders summary item.

**List View Buttons**
The Items panel (list view) contains the following buttons:

- **Move**: allows you to move selected items in the list view to another location.
- **Delete**: allows you to delete selected items from the database.
- **Merge**: allows you to merge selected items into a single item (for more information, see section 6.6.1 "About Merging").
List View Pages

To improve performance, if there are many items to show in the Items panel list view, they will be shown in pages. You can use the page numbers or the arrows at the bottom left of the Items panel to move through the pages.

Note
You can change the number of items shown in each page of the Items panel, list view, using Settings > User Settings > Data Paging Size.

List View Display Options

To filter the list of items, type part of a resource name into the search box, and then click Search to show just the resource items that match that text.

To refresh the list of resource items click the Refresh icon (    ).

To toggle the display names between the user-entered names and the enterprise names click the Display icon (    ).

6.1.3.4 Details Panel

Description

Use the Details panel to view or change the details and associations of the resource item that is currently selected in the Items panel (list view).

The Details panel contains a tabbed dialog, where each tab represents an operation to be performed. For a description of the tabs that are common to several resources, see section 6.1.4 "Common Details Panel Tabs".

Anchoring Resources

When you select a tab in the Details panel, and then change the selected item in the center Items panel (list view), the view is anchored by the Details panel so that the same tab will be viewed for the new item.

The reverse is also true: if you select an associated resource that is shown in the Details panel (for example, a Skill Group would be an associated resource shown for an Agent), the type of resources shown in the Items panel (list view) will also change.

6.1.4 Common Details Panel Tabs

The following sections describe the contents of some tabs that are common to several resource types.

6.1.4.1 Details Tab
The details tab is a form which contains a series of fields for information that belong to the resource, such as Name in the case of an Agent. Each field may be either mandatory, optional or read-only (that is, Unified CCMP fills it in automatically). Each field has a help text item to guide the user on its use and an indication as to whether it is mandatory or not.

6.1.4.2 Associations Tabs

Depending on the type of resource there may be one or more association tabs that allow the user to associate other resources with this resource. For example, if a Skill Group has been selected then there will be an Agents tab to allow the user to specify which agents are to be associated with this skill group.

**Tip**
The associations can usually be modified from either side of the association. For example, to add an Agent to a Skill Group you can either select the skill group and use the agents tab or select the agent and use the skill groups tab.

Each association tab has two sub-panels, one above the other. The top sub-panel shows the resource items that are already associated with this resource, the bottom sub-panel shows the available resources that may be added. The contents of this available items sub-panel is filtered by the logged in user's security permissions and any other pertinent business rule. For example, if adding Agents to a Skill Group then the sub-panel will only show those agents who are on the same peripheral as the skill group.

The user can move resource items between the bottom and top panels to make and break associations as required.

To improve performance, if there are many items to show, they will be shown in pages. You can use the page numbers or the arrows at the bottom left of the panel to move through the pages.

**Note**
You can change the number of items shown in each page using Settings > User Settings > Data Paging Size.

6.1.4.3 Advanced Tab

Depending on the type of resource there may also be an advanced tab. This shows information that is normally set by the system but may be overridden by the user.

6.1.4.4 History Tab
Note
This tab is only shown for remote resources, and only after they have been created in Unified CCMP. It is not shown for a system resource, or when a remote resource is first created.

The history tab shows audit information for the resource.

Where an event involves another resource, for example adding an agent to a skill group, the resource is linked to in the description. If a drop-down arrow is shown beneath an event, you can click on it for more information (such as the user who performed the event). A Request event indicates a change made using Unified CCMP's user interface; an Execution event indicates that the requested changes were successfully made on Unified CCE. Success or failure of the event is shown by a green tick or red cross.

If the audit history for a resource is long, you can use the Edit Filter link to show only certain events, such as unsuccessful change attempts.

6.1.4.5 Custom Data Tab
Some remote resources have a custom data tab, which allows you to specify your own key fields and corresponding values for these keys.

Each resource can have a maximum of ten custom data keys.

If a resource has several custom data keys, you can type a key value into the key text box to quickly show that key and the corresponding key value.

An example of how custom data can be used is:

- to hold emergency contact numbers that the system can be configured to notify if the service level drops below a certain threshold.

6.2 Folders
6.2.1 About Folders
Unified CCMP uses folders to allow the user to partition resources in a hierarchical structure.

For more information about the folder tree and how to use it, see section 1.2.9 "About the Folder Tree".

You can use System Manager to create, edit, rename, move and delete folders.
6.2.2 Creating a Folder

Method 1 – Specifying the Folder Properties
To create a folder and specify all the folder properties:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the new folder.
2. In the Folder Tree panel, click System, and then click Folder.
3. In the Name field enter a name for the new folder.
4. In the Description field enter any explanatory text for the folder, if required.
5. If required, uncheck the Inherit Permissions check box to turn this folder into a policy root that does not inherit security permissions from its parent folder.
6. Select the Create Another check box if you wish to create further folders at the same point in the tree structure.
7. Click Save to save the new folder in the tree.

Method 2 – Using the Default Values for Folder Properties
To create a folder, using the default values for folder properties:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the new folder.
2. Create the folder in one of the following ways:
   - Press the INS key on the keyboard.
   - Right click at the position where you want to create the new folder and select Create Folder.
3. A new folder is created with the following default values:
   - Name: New followed by a unique number
   - Description: no value (left blank)
   - Permission: inherit permissions from the parent.
4. Enter a new name to replace the default name if required.

Notes
To change the security permissions for the folder, you need to use the Role Manager tool. For more information, see section 8.3.1 "About The Role Manager".
6.2.3 Renaming a Folder

You can rename a folder in one of the following ways:

- In System Manager, select the folder in the Folder Tree panel and press F2 on the keyboard.
- In System Manager, right click on the folder in the Folder Tree panel and select Rename Folder.

Tip
You can use either of these methods to rename tenants as well as folders.

6.2.4 Moving a Folder

To move a folder:

Method 1 – Using Drag and Drop
1. In System Manager, in the Folder Tree panel, select the folder or folders you want to move (to learn how to select multiple folders, see section 1.2.9.7 "Selecting Multiple Folders").
2. Drag and drop the selected folders to the new location (for more information about drag and drop, see section 1.2.9.10 "Drag and Drop Operations").

Method 2 – Using the Move Button
1. In System Manager, in the Folder Tree panel, select the folder that contains the folder or folders you want to move. The Items panel displays a list of the resource types contained in that folder.
2. In the Items panel click on Folders The Items panel changes to a list view showing the folders in this location.
3. Check the box or boxes of the folder or folders to be moved.
4. Click the Move button.
5. The Move the Current Items page will be displayed, showing the folder tree.
6. In the folder tree, select the location to move the folder or folders to.
7. Click Save.

Note
If the folder is moved to a different tenant then any remote resources it contains will be marked as deleted and recreated under the new tenant. For more information about the effects of this, see section 6.4.9 "More About Moving Resources".
6.2.5 Deleting a Folder

**Note**
If the folder to be deleted contains resources, you must move them to another location before you can delete the folder. This includes deleted resources, which can be shown by selecting **Settings > User Settings > Show Deleted Resources**.

To delete a folder:

**Method 1 – Using the Folder Tree**
1. In **System Manager**, in the Folder Tree panel, select the folder or folders you want to delete (to learn how to select multiple folders, see section 1.2.9.7 "Selecting Multiple Folders").
2. In the Folder Tree panel, either press the **DEL** key on the keyboard, or **right click** to see the shortcut menu, and select **Delete Folder**.
3. In the Delete Folder dialog, select **OK**. The selected folders and any subfolders will be deleted.

**Method 2 – Using the Delete Button**
1. In **System Manager**, in the Folder Tree panel, select the folder that contains the folder or folders you want to delete. The Items panel displays a list of the resource types contained in that folder.
2. In the Items panel click **Folders**. The Items panel changes to a list view showing the folders in this location.
3. Check the box or boxes of the folder or folders to be deleted.
4. Click **Delete**.
5. In the Delete folder dialog, select **OK**. The selected folders and any subfolders will be deleted.

**Notes**
You may receive the message “WARNING: This folder [/path] has a direct mapping to the remote equipment…”. Deleting the folder will result in a change to the importer’s logic surrounding the placement of new resources. Please ask an administrator or refer to the *Administration Guide for Cisco Unified Contact Center Management Portal*, section *Equipment Mapped Folders*.

The folder may contain resources that are not visible to you. If so, you will be prompted to find an administrator to move these resources elsewhere.
6.2.6 Bulk Uploading Folders
In addition to creating folders one at a time, you can also bulk load folders previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

6.3 Tenants and Prefix Rules

6.3.1 About Tenants and Prefix Rules

6.3.1.1 Tenants
A tenant represents a real world organization which has been configured as a customer definition in Unified CCE. For each customer definition created in Unified CCE (a remote tenant), a corresponding tenant can be created in Unified CCMP. Just as Unified CCE enforces telephony isolation between tenants, visibility and management of tenants is controlled within Unified CCMP via the security model.

The isolation of each tenant within Unified CCMP means that a tenant folder does not inherit the permissions and properties of the Root folder. Each tenant folder has an individual set of security permissions and user groups. While users who are members of the customer organization that the tenant represents will need access to view and manage resources within a tenant, only system wide or host administrators should be given access to manage the tenants themselves.

**Note**
Tenants cannot be created or deleted in Unified CCMP. They are set up using the Integrated Configuration Environment (ICE) Cluster Configuration tool. See the *Installation and Configuration Guide for Cisco Unified Contact Center Management Portal* for more details.

6.3.1.2 Prefix Rules
A prefix rule is a rule which is used by Unified CCMP to move remote resources to a specific folder based on a naming convention or taxonomy. Prefix rules are matched against the Internal Name (Enterprise Name) of an item.

When remote resources such as Agents, Call Types and Dialed Numbers are first imported into Unified CCMP they are placed in a default location based on the following rules:
If Unified CCMP can determine the tenant which owns the item from information stored in Unified CCE then the item will be placed in the root of the owning tenant.

If Unified CCMP cannot determine the tenant which owns the item from information stored within Unified CCE then the item will be placed in the corresponding ‘equipment’ folder under the Unallocated folder. The Unallocated folder contains an equipment folder for each Unified CCE which is configured for use with Unified CCMP.

Using prefix rules to automate the movement of remote resources reduces the administrative overhead of manually moving items which are imported into Unified CCMP from Unified CCE which can be significant for large systems with complex folder structures.

The movement of items according to prefix rules is carried out by a scheduled process which runs overnight.

If a resource which matches a prefix rule is manually moved to a location within the same tenant or a to location in the Unallocated folder, the resource will be moved back to the location defined by the rule the next time the prefix management process runs unless the rule is disabled or deleted.

### 6.3.2 Creating a Prefix Rule

To create a prefix rule for a tenant do the following:

1. In System Manager, in the Folder Tree panel, select the folder containing the tenant you want to create a prefix rule for. The Items panel displays a list of the resource types contained in the folder.

2. Select Folder (at this level tenants are just another type of folder). The Items panel changes to a list view showing each of the folders and tenants at this location.

3. Click on the name of the tenant. The tenant details are displayed in the Details panel.

4. Click Prefixes tab. Any existing prefixes associated with the selected tenant display in a table.

5. Click Add New Row (.addButton) to add a prefix.

6. Fill in the fields as follows:

   - In Prefix field enter the new prefix that will be used to match against resource names. The ‘%’ character is used to match against zero or more occurrences of any character.

   For example, the prefix ‘%SAL.ENG.%ag’ would match:
BOS.SAL.ENG.JohnSmith.ag
CHI.SAL.ENG.SamirPatel.ag

It would not match:
BOS.SAL.SPA.JohnSmith.ag
BOSSAL.ENG.JohnPatel.ag

By default the rules are case insensitive, unless case sensitivity was enforced in the database management system when Unified CCMP was installed.

- From **Type** drop-down list, select the remote resource type that the rule will apply to.
- In **Priority** field enter a unique numerical value (0 - 9999). The priority value must be unique among prefix rules within the tenant. If a resource matches more than one rule for its type, the rule with the highest value priority number will take precedence.
- To enable the prefix, select **Enabled** check box.
- Click in the **Path** field to display the folder tree, and then select the destination folder for matching resources.

7. **Click Submit** to create the prefix rule.

### 6.3.3 Editing a Prefix Rule

To edit a prefix rule for a tenant do the following:

1. **In System Manager**, in the Folder Tree panel, select the folder containing the tenant with the prefix rule you want to edit. The Items panel displays a list of the resources contained in the folder.
2. Select **Folder** (at this level tenants are just another type of folder). The Items panel changes to a list view showing each of the folders and tenants at this location.
3. **Click on the tenant you want to edit**. The tenant details are displayed in the Details panel.
4. **Click the Prefixes tab**. Any existing prefixes associated with the selected tenant display in a table.
5. Click on a prefix to select it.
6. **Click **Edit selected row ( ) at the bottom of the table to edit the selected prefix rule.**
7. **Amend the required field(s).**
8. Click **Submit** to finish editing the rule.

### 6.3.4 Viewing a Prefix Rule

To view a prefix rule for a tenant do the following:

1. In **System Manager**, in the Folder Tree panel, select the folder containing the tenant with the prefix rule you want to view. The Items panel displays a list of the resources contained in the folder.

2. Select **Folder** (at this level tenants are just another type of folder). The Items panel changes to a list view showing each of the folders and tenants at this location.

3. Click on the tenant you want to edit. The tenant details are displayed in the Details panel.

4. Click the **Prefixes** tab. Any existing prefixes associated with the selected tenant display in a table.

5. Click on a prefix to select it.

6. Click **View selected row** (ד) at the bottom of the table to view the selected prefix rule.

7. If there is more than one prefix rule for the tenant, you can use the < and > symbols at the bottom left corner of the dialog box to view the other prefix rules.

8. Click **Close** to finish viewing the rule.

### 6.3.5 Deleting a Prefix Rule

To delete a prefix rule for a tenant do the following:

1. In **System Manager**, in the Folder Tree panel, select the folder containing the tenant with the prefix rule you want to delete. The Items panel displays a list of the resources contained in the folder.

2. Select **Folder** (at this level tenants are just another type of folder). The Items panel changes to a list view showing each of the folders and tenants in this location.

3. Click on the tenant you want to edit. The tenant details are displayed in the Details panel.

4. Click the **Prefixes** tab. Any existing prefixes associated with the selected tenant display in a table.

5. Click on a prefix to select it.
6. Click **Delete Selected Row** ( ) at the bottom of the table to delete the selected prefix rule.

7. Click **Delete** to confirm the deletion of the rule.

### 6.3.6 More About Tenants and Prefix Rules

#### 6.3.6.1 Prefixes and Multi-tenanted Environments

When more than one tenant shares the same Unified CCE environment, resources may be shared between them. The host administrator must ensure that different prefix rules are used for each tenant that shares the same Unified CCE environment.

If a resource matches prefix rules on more than one tenant on the same Unified CCE equipment, the tenant that is ordered first alphabetically within Unified CCMP will ‘own’ that shared resource and the movement of that resource. Rules configured for subsequent tenants on the same equipment will not be applied.

If resources are moved between different tenants on the same Unified CCE equipment, any prefix rules that applied to the resource on the original tenant will not apply until the resource is moved back to the previous tenant or the Unallocated folder. This is because a prefix rule only applies within the scope of the tenant for which it is defined and the Unallocated folder.

### 6.4 Resources

#### 6.4.1 About Resources

#### 6.4.1.1 Resource Types

Each tenant in the system has resources assigned to them, such as *dialed numbers*, *agents* and so on. These resources are used on a daily basis as a part of contact center network operations. However it is important to differentiate between the types of resources used by the system. There are two different types:

- **System Resources** (users, folders and so on) are entities which can be created and managed by Unified CCMP. These resources are local to Unified CCMP, and not provisioned onto the remote equipment. Unified CCMP resources may or may not be associated with a tenant.

- **Remote Resources** (agents, dialed numbers and so on) are entities which exist on the remote equipment. Some remote resources can be created or edited in Unified CCMP and provisioned onto the remote system. Other
Remote resources can be accessed by Unified CCMP but cannot be created, edited or provisioned in Unified CCMP. All remote resources must be associated with a specific tenant.

6.4.1.2 System Resources

You can create and manage the following types of system resource:

- **Folder.** A placeholders in the system for related information. For more information see section 6.2.1 "About Folders".
- **Group.** A set of Unified CCMP users who share the same security permissions. For more information see section 8.5.1 "About The Group Manager".
- **Information Notice.** The ‘Message Of The Day’ facility. For more information see section 4.1 "About Information Notices".
- **User.** The contact center members who are permitted to access Unified CCMP. For more information see section 8.4.1 "About The User Manager".

6.4.1.3 Remote Resources

You can create and manage the following types of remote resource:

- **Agent.** A person who handles customer contacts. For more information see section 7.2.1 "About Agents and Supervisor Agents".
- **Agent Desktop.** A set of permissions or settings for a particular agent, such as how much time is allocated to wrap up a call and what outbound calls can be made. For more information see section 7.3.1 "About Agent Desktops".
- **Agent Team.** A group of agents, managed by one or more supervisors. For more information see section 7.4.1 "About Agent Teams".
- **Attribute.** User-defined information that can be associated with an agent. It defines the agent’s knowledge or experience in a particular area and the level of that knowledge or experience. For more information see section 7.5.1 "About Attributes"
- **Call Type.** A category of incoming routable task. The call type determines the routing script that is run for the call. For more information see section 7.6.1 "About Call Types".
- **Department.** A a way of grouping related resources according to user-defined business needs. For more information, see section 7.7.1 "About Departments".
- **Device Profile.** A telephone template that a user can use to retain their specific phone configuration across a number of different physical phones. For more information see section 7.8.1 "About Device Profiles".

- **Dialed Number.** The number dialed by the caller. This helps to determine the call type. For more information see section 7.9.1 "About Dialed Numbers".

- **Directory Number.** The line connected to an IP Phone. For more information see section 7.10.1 "About Directory Numbers".

- **Enterprise Skill Group.** A logical grouping of skill groups. These may be from different media routing domains. For more information see section 7.11.1 "About Enterprise Skill Groups".

- **Expanded Call Variable.** A variable used to pass information about calls. For more information see section 7.12.1 "About Expanded Call Variables".

- **IP Phone.** An IP device with a single line used by an agent to make and receive calls. For more information see section 7.13.1 "About IP Phones".

- **IVR Application.** A voice XML (VXML) application that runs on a CVP IVR app server and is used to control call routing. For more information see section 7.14.1 "About IVR Apps".

- **Label.** A string that is passed to a routing client for each network target. For more information see section 7.15.1 "About Labels".

- **Media File.** A .wav file that is used by IVR to play back prompts and messages to callers. For more information see section 7.16.1 "About Media Files".

- **Network VRU Script.** A script used by the voice response unit to play a message to the caller. For more information see section 7.17.1 "About Network VRU Scripts".

- **Peripheral.** A connected system such as an ACD switch that routes customer phone calls to contact center staff. For more information see section 7.18.1 "About Peripherals".

**Notes**

You cannot provision a peripheral through Unified CCMP, you can only change its associated user for Unified CM provisioning.

- **Person.** The representation of a physical person on the system. A person can be a user and/or one or more agents. For more information see section 7.19.1 "About Persons".
- **Precision Queue.** A mechanism to define how to route calls to agents depending on the agents’ proficiency attributes and availability. Precision queues can be referenced in routing scripts to define how calls are routed. For more information see section 7.20.1 "About Precision Queues".

- **Service.** A Unified CCE Service, with associated Skill Groups and Peripherals. For more information see section 7.21.1 "About Services".

- **Skill Group.** A collection of agents with the same skills and assigned to a single media routing domain. For more information see section 7.22.1 "About Skill Groups".

- **User Variable.** A named object that holds a value - often used in routing scripts. For more information see section 7.23.1 "About User Variables".

You can view the details of other remote resources provisioned through Unified CCE, such as Media Routing Domain or Script, but you cannot edit these.

**Note**

If your Unified CCMP deployment is connected to an HCS 500, 1000 or 4000 Agent Unified CCE configuration, then the predefined capacity limits of that deployment type will be enforced by Unified CCMP. An error message is displayed if you request a change that exceeds one of these capacity limits, for example, if you try to add a (Precision Queue) Attribute to an Agent that already has the maximum number of Attribute memberships. You can see the capacity limits that are enforced by the application using the ICE System Properties tool, under the Capacity Properties tab (for more details about the ICE System Properties tool, see the Administration Guide for Cisco Unified Contact Center Management Portal).

### 6.4.1.4 Resource States

Each remote resource in Unified CCMP can be in one of five states that indicate its stage in the resource life cycle.
When a resource is successfully created or changed using the Unified CCMP web application, its state is set to Pending Active (sometimes shortened to just Pending). This indicates that while it has been provisioned successfully within Unified CCMP, it has not yet been fully provisioned on the remote system. A resource can be deleted while it is in this state.

**Note**
A resource can be successfully provisioned in Unified CCMP even if it cannot be provisioned on the remote system. In this case it will remain in the Pending Active state.

When a resource has been successfully provisioned in Unified CCMP and pushed to the remote system its state will be set to Ready. A resource will normally remain in this state until it is deleted.
6.4.2 Creating a Resource

To create a new resource:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the new resource.
   - To create a System resource item, click on System, and then select the type of resource you want to create from the drop-down list.
   - To create a remote resource, click on Resource, and then select the type of resource you want to create from the drop-down list.

2. A new page will be displayed. The contents of this page depend on the resource that is being created. Fill in the details and press Save to confirm or Back to cancel the operation.

3. You will be returned to the System Manager and the new resource item will appear in the resource item list in the Items panel.

For more information about resource properties, see the detailed description for each resource. For system resources see section 6.4.1.2 "System Resources" and for remote resources see section 6.4.1.3 "Remote Resources".
6.4.3 Viewing Resources

Viewing Resources Using the Summary View in the Items Panel

You can view the resources of a particular resource type in a folder by selecting the resource type from the Items panel, summary view, as follows:

1. In System Manager, in the Folder Tree panel, click on the folder that contains the resources you want to view. The Items panel displays a summary view, showing a list of the resource types contained in the folder. If the Items panel was minimized then it will automatically be opened to display the summary view.

2. In the Items panel, click on the resource type you want to view. The Items panel changes to a list view showing a list of the resources of that type in this location.

3. To view the details for an individual resource, in the Items Panel, click on the resource you want to view. The resource details are displayed in the details panel.

Viewing Resources Using a Resource Filter in the Folder Tree

You can also view the resources of a particular resource type in a folder by selecting the resource type filter from the Folder Tree panel, as follows:

1. In System Manager, in the Folder Tree panel, go to the folder that contains the resources that you want to view, and click on the resource filter for the type of resource you want to view. The Items panel displays a list view showing the resources of that type at that location. If the Items panel was minimized then it will automatically be opened to display the list view.

2. To view the details for an individual resource, in the Items Panel, click on the resource you want to view. The resource details are displayed in the details panel.

6.4.4 Selecting Resources

There are two ways to select resources from a list view in the Items panel, depending on the action you want to take next.

- To select one or more resources to move or delete (or to merge, if applicable), select the check boxes to the left of the resource.
To view or edit the properties of a single resource, click on the name of the resource. The properties of the resource will be shown in the Details panel.

For more details about the properties of a specific resource type, see the description for that resource. The location of the relevant information is listed in section 6.4.1.2 "System Resources" for system resources and section 6.4.1.3 "Remote Resources" for remote resources.

### 6.4.5 Viewing Resource Status

To see the current status of a resource:

1. View the resource details (see section 6.4.3 "Viewing Resources"). The resource status is shown as an icon at the bottom of the details panel. This is green if the resource is Ready, orange if the resource is Pending Active and red if the resource is in the Error state. You may also see information about the status of related resources and memberships.

2. If required, click the status icon to see the status dialog box, showing more information about the status of the resource and of any related resources or memberships. The status dialog box may also contain a Purge button if the resource is in the Error state or appears to be stuck in the Pending Active state. You can click this to purge a stuck resource (see section 6.4.8 "Purging Resources").

#### Note

Status information is only available for remote resources (for example, Agents, Skill Groups, Precision Queues). It is not available for Unified CCMP Resources (for example, Folders, Users, Groups).

### 6.4.6 Moving Resources

1. In System Manager, in the Folder Tree panel, select the location that contains the resource or resources you want to move.

2. If you selected a resource filter from the Folder Tree panel then the Items panel shows a list view showing the resources of that type at that location.

3. If you selected any other folder from the Folder Tree panel, the Items panel shows a summary view, showing the resource types at that location. In this case, click on a resource type to see the list of resources of that type.

4. Check the box or boxes of the resource or resources to be moved.

5. Click the Move button.

6. The Move the Current Items page will be displayed, showing the folder tree.
7. In the folder tree, select the location to move the item or items to.
8. Click **Save** to begin the move operation.
9. A confirmation message is displayed. You will be returned to the main System Manager page automatically after 5 seconds, or you can click **OK** to return to the main System Manager page immediately.

**Note**
To move a resource, you need the appropriate permissions to manage the resource type, and to access the source and destination folders. The resource inherits the security defined for the new location.

When a remote resource is moved to a different tenant, the resource is marked as deleted at its old location and recreated under the new tenant. For more information about the effects of this, see section 6.4.9 "More About Moving Resources".

### 6.4.7 Deleting Resources
To delete one or more resources items:

1. In **System Manager**, in the Folder Tree panel, select the location that contains the resource or resources you want to delete.
2. If you selected a resource filter from the Folder Tree panel then the Items panel shows a list view showing the resources of that type at that location.
3. If you selected any other folder from the Folder Tree panel, the Items panel shows a summary view, showing the resource types at that location. In this case, click on a resource type to see the list of resources of that type.
4. Check the box or boxes of the resource or resources to be deleted.
5. Click the **Delete** toolbar button and a confirmation dialog will be displayed.
6. Click **OK** button to start the delete operation.

For more information about the effect of deleting a specific resource type, see the description for each resource. For system resources see section 6.4.1.2 "System Resources" and for remote resources see section 6.4.1.3 "Remote Resources".

### 6.4.8 Purging Resources
If a remote resource has been in the Pending Active state for a long time or is in the Error state (see section 6.4.1.4 "Resource States"), you can click **Purge** in the Status dialog (see section 6.4.5 "Viewing Resource Status") to delete the resource and break any relationships with other resources. The resource will be re-imported into Unified CCMP on the next import cycle.
6.4.9 More About Moving Resources

This section contains additional information for users who need to understand more about moving resources.

Note
For detailed information about moving resources, see the information about equipment mappings in the Administration Guide for Cisco Unified Contact Center Management Portal

6.4.9.1 Moving a Resource to a Different Tenant

When a resource is moved out of a tenant, the resource is no longer owned by that tenant. The original resource is deleted and a new resource is recreated at the new location. The user is asked whether related audit data should be moved with the resource, or remain with the deleted resource.

No changes are performed on the remote equipment during this change.

6.4.9.2 Moving Remote Resources Owned by Remote Tenants

In Unified CCE the following types of resource can belong to a Remote Tenant:

- Dialed Number
- Call Type
- Label
- Network VRU Script
- Scheduled Target
- Routing Script

Unified CCMP automatically manages which resources belong to which Remote Tenant according to where they are located in the folder tree. A resource which is located anywhere under a Remote Tenant mapped folder is associated with and belongs to that Remote Tenant.

If a resource is moved out of a Remote Tenant folder then the user is prompted for confirmation. If the user continues, the resource is disassociated from the Remote Tenant on the Unified CCE, and deleted and recreated at the new location. The user is asked whether related audit data should be moved with the resource, or remain with the deleted resource.
When a resource is moved into a Remote Tenant mapped folder, an association to that Remote Tenant is created on the Unified CCE. If the resource is referenced by a customer-specific Unified CCE script or has a membership to any other items which have a Remote Tenant mapping then it cannot be moved to another Remote Tenant. For example, you cannot move a label out of a folder which has a Remote Tenant mapping if the label is referenced by a script which has a Remote Tenant association. To move the label, first remove it from the script or make the script visible to all customers using the Unified CCE Script Editor.

Provisioning of Scheduled Targets is not supported, so any move which requires a change of Remote Tenant will not be allowed. Likewise if a Routing Script move results in a change of Remote Tenant ownership and Script Provisioning is disabled in Cluster Configuration, the move operation will be aborted.

Resources owned by Remote Tenants that do not have a folder mapping will not have their Remote Tenant ownership changed unless they are moved under a folder with a Remote Tenant mapping.

### 6.4.9.3 Moving Resources Using AW tools

If the ownership of a resource is changed outside Unified CCMP, by using the Admin Workstation (AW) and changing the Customer Definition ID, the change will be imported into Unified CCMP on the next import cycle. This change will disable the resource at the old location and create a new instance of the resource under the new tenant.

The old resource instance will retain its historical audit data. Any new audit data since the change of ownership will be associated with the new resource instance.

### 6.5 Bulk Upload of Resources

#### 6.5.1 About Bulk Upload

The bulk upload tool is used for importing large numbers of resource items into Unified CCMP. It is used to generate resources such as Agents or Skill Groups by filling in resource attributes using the standard CSV format.

All CSV files require headers that dictate where each value goes. These headers are provided by templates that can be downloaded from the appropriate Bulk Upload page in Unified CCMP.
6.5.1.2 **Resources That Can Be Bulk Uploaded**

You can bulk upload the following resources:

- Agents
- Agent desktops
- Agent teams
- Attributes
- Call Types
- Departments
- Dialed Numbers
- Enterprise Skill Groups
- Folders
- Labels
- Network VRU Scripts
- Persons
- Precision Queues
- Skill Groups
- Users
- User Variables

6.5.2 **Editing CSV files**

You can use Notepad or any other text-based editor to edit CSV files for use with bulk upload. Excel also offers support for CSV files so you can edit these in a familiar environment while maintaining the integrity of the CSV format.

**Note**

Editing CSV files in Excel can cause missing commas.

6.5.3 **Using the Bulk Upload Tool**

6.5.3.1 **Starting a Bulk Upload**

To use the bulk upload tool:

1. Open the **System Manager** page.
2. Select the required folder.
3. Click on **Upload** in the Folder Tree panel and then select the item type you want to bulk upload from the drop-down list. The **Bulk Upload Control** page displays.

4. Select a template for your chosen resource. The template link is present in the horizontal toolbar near the top of the page. Once selected, a download box is presented allowing you to save this CSV file onto your machine.

5. Open the template in the editor you require (such as Notepad) and begin to enter your data or paste it from another source.

6. Return to the **Bulk Upload Control** page and make sure the path is set correctly.

   **Note**
   This path will only be used if you have removed the Path column in the CSV file. This option is not available for folders.

7. Browse to the CSV file you have just entered the data into.
8. Click **Upload**.

   A progress bar at the bottom of the screen displays the upload progress.

   **Caution!**
   Do not upload more than 500 items per CSV file.

### 6.5.3.2 Bulk Upload Errors

If something goes wrong during the bulk upload, you may want to pause the upload and check why an item failed. For more information about possible reasons for bulk upload failures, see section 6.5.3.3 "Reasons for Upload Failure".

If the upload tool encounters a problem that affects all rows and not just the current one, an alert box appears that describes the problem’s description and returns you to the Bulk Upload Control page.

Once every row has been processed a summary dialog appears to inform you of how many rows failed and how many passed. Please note this dialog does not give you the result of provisioning these items onto the host system, only the result of uploading the items into Unified CCMP.

### 6.5.3.3 Reasons for Upload Failure

The table below details some reasons why an upload might fail.
<table>
<thead>
<tr>
<th>Exception Type</th>
<th>Reason</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Capacity Left</td>
<td>The capacity limit has been reached.</td>
</tr>
<tr>
<td>Enterprise Name Already Exists</td>
<td>The enterprise name already exists.</td>
</tr>
<tr>
<td>Login Name Already Exists</td>
<td>The peripheral login name already exists.</td>
</tr>
<tr>
<td>SQL Exception</td>
<td>SQL error during upload, usually due to bad data.</td>
</tr>
<tr>
<td>Argument Exception</td>
<td>An attribute contains a bad value. This usually occurs when you have an empty string in the Path column when attempting to upload items which cannot be contained in the Root folder.</td>
</tr>
<tr>
<td>Security Exception</td>
<td>You do not have security permissions to upload to the folder.</td>
</tr>
<tr>
<td>Format Exception</td>
<td>Invalid data in a column.</td>
</tr>
<tr>
<td>No Identity Available</td>
<td>Identity not available.</td>
</tr>
</tbody>
</table>

### 6.5.4 Bulk Upload Data Types

Bulk upload uses the following data types:

- **SNC** means Standard Naming Convention. This is alphanumeric data with no exclamation marks or hyphens, although underscores (_) are permitted.
- **BOOLEAN** means one of the following values:
  - TRUE
  - FALSE
  - Empty field. Leaving these fields empty defaults the field to FALSE.
- **Y/N** is similar to Boolean however it can only contain the values Y or N.
- Date format is the universal date format `<Year>-<Month>-<Day>` for example 2006-08-30.
- **CSS** means a valid CSS (Cascading Style Sheet) style definition, for example `color: black; background-color: #e08000`
• CSS Styled List
• Any Data Type marked with a hyphen (-) means that there are no constraints on what you can put in the field (except for the constraints imposed by the native CSV format).

Where a column supports a list of values (for example, an agent may belong to multiple skill groups) separate each skill group with a semi-colon (;) character, for example Skillgroup1; Skillgroup2; Skillgroup3.

**Note**
Make sure that the value you specify for each field is a valid value for that data type. The upload will fail with an error if any values are invalid.

### 6.5.5 Global Bulk Upload Columns

These columns are common to every bulk upload template file except where stated.

The **Required?** column in the tables below indicates whether the column must be present.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Path</td>
<td>Path</td>
<td>No</td>
<td>Describes where in the tree the resource will be created. If you wish to supply the path in the bulk upload screen, you must remove this column. <strong>Note</strong> If you leave the column present and do not set a value, it will attempt to upload into the Root directory, which is valid for items such as folders, but not for resources such as Agent or Skill Group. Removing the column completely will upload the resources into the folder you were working in when you initiated the bulk upload.</td>
</tr>
<tr>
<td>Name</td>
<td>SNC</td>
<td>Yes</td>
<td>The name of the resource in Unified CCMP. This must be a unique name. In most cases, this will not be provisioned.</td>
</tr>
<tr>
<td>Description</td>
<td>-</td>
<td>No</td>
<td>Describes the dimension being created. This is never provisioned.</td>
</tr>
</tbody>
</table>
### 6.5.6 Bulk Upload Person Template

This table shows the columns required when bulk loading Persons.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>EquipmentName</td>
<td>SNC</td>
<td>No</td>
<td>The instance name of the Unified CCE or Unified CM you want this person added to. This will correspond directly with the equipment instance name that was specified when configured via the Unified CCMP ICE Cluster Configuration utility (see Administration Guide for Cisco Unified Contact Center Management Portal). Omit this item or leave it blank to automatically add this Person to all available equipment. To add this Person to multiple equipment instances, specify each of the equipment instance names you want to add this person to, separating each equipment instance with a &quot;;&quot; (semi-colon) character.</td>
</tr>
<tr>
<td>FirstName</td>
<td>SNC</td>
<td>Yes</td>
<td>The first name of the person.</td>
</tr>
</tbody>
</table>
### Column Name | Data Type | Required? | Description
--- | --- | --- | ---
LastName | SNC | Yes | The last name of the person.
LoginName | SNC | Yes | The peripheral login name for the person.
PassPhrase | Password | Yes | The peripheral login password for the person.

**Note**
When uploading Person records to a location where both Unified CCE and Unified CM resources exist, the Person will be attached to all pieces of equipment unless the equipment field is set in the bulk load template.

### 6.5.7 Bulk Upload Agent Template

This table shows the columns required when bulk loading Agents.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>DefaultSkillGroup</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The default skill group to be used when the skill group routing is not available. This skill group will be automatically included in the SkillGroupMember field if it is not already present.</td>
</tr>
<tr>
<td>Peripheral Number</td>
<td>Numeric</td>
<td>Yes</td>
<td>The service number as known at the peripheral. Autogenerated if not supplied.</td>
</tr>
<tr>
<td>Peripheral Name</td>
<td>SNC</td>
<td>No</td>
<td>The name identifying the agent on the associated peripheral.</td>
</tr>
<tr>
<td>Supervisor</td>
<td>Boolean</td>
<td>No</td>
<td>Indicates whether the agent is a supervisor. This will not create a Unified CCMP user, as this is a future feature, however it enables you to bind this agent to a domain login name.</td>
</tr>
<tr>
<td>Column Name</td>
<td>Data Type</td>
<td>Required?</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>------------------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>AgentState Trace</td>
<td>Y/N</td>
<td>No</td>
<td>Indicates whether the software collects agent state trace data for the agent.</td>
</tr>
<tr>
<td>DomainLogin Name</td>
<td>NETBIOS Login Name</td>
<td>If Agent is a supervisor</td>
<td>The login name for the domain user this Agent is associated with. This will often be of the form &lt;domain&gt;&lt;username&gt;</td>
</tr>
<tr>
<td>DomainUser Name</td>
<td>NETBIOS Username</td>
<td>If Agent is a supervisor</td>
<td>The username of the domain user this Agent is associated with. In the above Domain Login example, this would be simply &lt;username&gt;</td>
</tr>
<tr>
<td>Peripheral Member</td>
<td>Enterprise Name</td>
<td>Yes</td>
<td>The Peripheral to assign this Agent to.</td>
</tr>
<tr>
<td>AgentDesktop Member</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The Desktop this Agent will use.</td>
</tr>
<tr>
<td>PersonMember</td>
<td>Login Name</td>
<td>Yes</td>
<td>The Person that this Agent represents.</td>
</tr>
<tr>
<td>AgentTeamMember</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The team this agent belongs to. The team must be on the same Peripheral otherwise provisioning will fail. This column may also be subject to capacity limitations. For example, there may only be so many agents allowed in a team and that team has already reached its capacity.</td>
</tr>
<tr>
<td>SkillGroupMember</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The skill group or skill groups this agent belongs to. The skill groups must be on the same Peripheral otherwise provisioning will fail. To specify multiple skill groups, separate each skill group with a semi-colon (;) character.</td>
</tr>
<tr>
<td>PrecisionAttributeMember</td>
<td>-</td>
<td>No</td>
<td>The attributes that this agent has and the values of each. Assign values using &quot;=&quot; and separate multiple attributes with a semi-colon (;). For example, Spanish=5; MortgageTraining=True for an agent with a proficiency of 5 in Spanish and who is trained in mortgages.</td>
</tr>
</tbody>
</table>

### 6.5.8 Bulk Upload Agent Desktop Template

This table shows the columns required when bulk loading Agent Desktops.
Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>WrapupData IncomingMode</td>
<td>Numeric</td>
<td>No</td>
<td>Indicates whether the agent is allowed or required to enter wrap-up data after an incoming call. 0: Required, 1: Optional, 2: Not allowed. If not supplied, defaults to 1.</td>
</tr>
<tr>
<td>WrapupData OutgoingMode</td>
<td>Numeric</td>
<td>No</td>
<td>Indicates whether the agent is allowed or required to enter wrap-up data after an outgoing call. 0: Required, 1: Optional, 2: Not allowed. If not supplied, defaults to 1.</td>
</tr>
<tr>
<td>WorkModeTimer</td>
<td>Numeric</td>
<td>No</td>
<td>The amount of time in seconds (1-7200) allocated to an agent to wrap up the call. If not supplied, defaults to 7200.</td>
</tr>
<tr>
<td>RemoteAgentType</td>
<td>Numeric</td>
<td>No</td>
<td>Indicates how mobile agents are handled. 0: No remote access, 1: Use call by call routing, 2: Use nailed connection, 3: Agent chooses routing at login. If not supplied, defaults to 0.</td>
</tr>
</tbody>
</table>

### 6.5.9 Bulk Upload Agent Team Template

This table shows the columns required when bulk loading Agent Teams.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".
<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>Peripheral Member</td>
<td>Enterprise Name</td>
<td>Yes</td>
<td>The peripheral to assign this Agent Team to.</td>
</tr>
<tr>
<td>DialedNumber Member</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The dialed number to use for this Agent Team.</td>
</tr>
</tbody>
</table>

### 6.5.10 Bulk Upload Attributes Template

This table shows the columns required when bulk loading Precision Attributes.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>AttributeDataType</td>
<td>Numeric</td>
<td>Yes</td>
<td>Type of data to associate with attribute. One of: 3: boolean (true or false only) 4: proficiency (a numeric range).</td>
</tr>
<tr>
<td>MinimumValue</td>
<td>Numeric</td>
<td>Yes, for proficiency data types only. Null otherwise.</td>
<td>Minimum value that the attribute can have. Must be between 1 and 10.</td>
</tr>
</tbody>
</table>
### 6.5.11 Bulk Upload Call Type Template

This table shows the columns required when bulk loading Call Types.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MaximumValue</td>
<td>Numeric</td>
<td>Yes</td>
<td>Maximum value that the attribute can have. Must be between 1 and 10.</td>
</tr>
<tr>
<td>DefaultValue</td>
<td>Boolean or Numeric, according to AttributeDataType</td>
<td>No</td>
<td>Default value to be used when an attribute is assigned to an agent if no explicit value is specified.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>ServiceLevelType</td>
<td>Numeric</td>
<td>No</td>
<td>Indicates how the system software calculates the service level for the skill group. If this field is 0, Unified CCE uses the default for the associated Peripheral/MRD pair. Valid numbers are as follows: 0 or blank: Use Default 1: Ignore Abandoned Calls 2: Abandoned Call Has Negative Impact 3:Abandoned Call Has Positive Impact.</td>
</tr>
<tr>
<td>ServiceLevelThreshold</td>
<td>Numeric</td>
<td>No</td>
<td>The service level threshold, in seconds, for the service level. If this field is negative, the value of the Service Level Threshold field in the Peripheral table is used.</td>
</tr>
</tbody>
</table>

### 6.5.12 Bulk Upload Departments Template

There are no extra columns required when bulk loading Departments.
Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

### 6.5.13 Bulk Upload Dialed Number Template

This table shows the columns required when bulk loading Dialed Numbers.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>Dialednumber</td>
<td>SNC</td>
<td>Yes</td>
<td>The string value by which the Agent/IVR Controller identifies the Dialed Number.</td>
</tr>
<tr>
<td>RoutingClientMember</td>
<td>SNC</td>
<td>Yes</td>
<td>The name of the routing client (such as NIC or PG) that this number should use to submit routing requests to the Unified CCE.</td>
</tr>
<tr>
<td>MediaRoutingDomainMember</td>
<td>SNC</td>
<td>Yes</td>
<td>The name of the media routing domain.</td>
</tr>
</tbody>
</table>

### 6.5.14 Bulk Upload Enterprise Skill Group Template

This table shows the columns required when bulk loading Enterprise Skill Groups.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>SkillGroupMember</td>
<td>Enterprise Name</td>
<td>No</td>
<td>The skill group or skill groups associated with this enterprise skill group. The skill groups must be on the same Peripheral otherwise provisioning will fail. To specify multiple skill groups, separate each skill group with a semi-colon (;) character.</td>
</tr>
</tbody>
</table>
6.5.15 **Bulk Upload Folders Template**

This table shows the columns required when bulk loading Folders.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns"

**Note**

Folders do not use the Enterprise Name, Effective To or Effective From global columns.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security</td>
<td>CSS Styled List</td>
<td>No</td>
<td>Allows you to set security on the folder you upload. See below for an example of the syntax for this field.</td>
</tr>
</tbody>
</table>

**Security Field Example**

DOS-styled syntax example:

```
<USERNAME>:<ROLENAME>;<USERNAME>:<ROLENAME>[<MULTIPLEROLENAMES>]
```

This is an example of what can be put into the Security field in the agent CSV file:

- A single user with a single role
  
  `Administrator:Advanced Users`

- A single user with more than one role
  
  `Administrator:Advanced Users:Supervisors`

- Multiple users
  
  `Administrator:Advanced Users:Supervisors;User1:Basic Users`

Users are separated by semicolons. Users are separated from roles by colons. This is similar to CSS syntax except that a user can have multiple roles.

**Note**

Group permissions on a folder cannot be set during bulk upload.

6.5.16 **Bulk Upload Label Template**

This table shows the columns required when bulk loading Labels.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns"
6.5.17 Bulk Upload Network VRU Scripts Template

This table shows the columns required when bulk loading Network VRU Scripts. Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RoutingClient Member</td>
<td>SNC</td>
<td>Yes</td>
<td>The name of the routing client (such as NIC or PG) that this number should use to submit routing requests to the Unified CCE.</td>
</tr>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>VRUScriptName</td>
<td>SNC, plus commas(.)</td>
<td>Yes</td>
<td>Up to 39 characters. This is a composite string identifying the micro-application to run, the name of the associated media file (if applicable) and any options that need to be specified for that micro-application.</td>
</tr>
<tr>
<td>Timeout</td>
<td>Numeric</td>
<td>Yes</td>
<td>The number of seconds to wait for a response after the script starts executing.</td>
</tr>
<tr>
<td>NetworkVruMember</td>
<td>SNC</td>
<td>Yes</td>
<td>The network VRU to associate with this Network VRU Script.</td>
</tr>
</tbody>
</table>

6.5.18 Bulk Upload Precision Queues Template

This table shows the columns required when bulk loading Precision Queues. Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".
### Column Name | Data Type | Required? | Description
--- | --- | --- | ---
DepartmentMember | SNC | No | The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.
Steps | - | Yes | Specification of the steps in this precision queue. See below for syntax of this field.
AgentOrdering | Numeric | Yes | The way to choose an agent to handle the call if more than one agent satisfies the precision queue criteria. One of:
   1: agent that has been available the longest
   2: most skilled agent
   3: least skilled agent
ServiceLevelThreshold | Numeric | Yes | The service level threshold, in seconds, for allocating the call to a suitable agent using the rules in the precision queue. 0 to 2147483647
ServiceLevelType | Numeric | No | Indicates how to handle abandoned calls in service level calculations. One of:
   1: ignore abandoned calls
   2: abandoned calls have negative impact (that is, exceed the service level threshold)
   3: abandoned calls have positive impact (that is, meet the service level threshold)

#### 6.5.18.1 Syntax for Precision Queue Steps
The Precision Queue Steps field consists of one or more steps. Each step is broken down into several parts. The parts are:

- The **ConsiderIf** Condition (optional). If present, this specifies the circumstances to which the step applies. For example, a step might only apply if there has been a higher than usual number of unanswered calls that day. Do not specify a ConsiderIf condition for the last step in a Precision Queue.

- The **condition expressions** (always required for each step). This specifies the attributes an agent must have to receive the call. It may be a simple comparison, or it may involve multiple comparisons linked by “and” or “or”. For example, the condition expressions might specify an agent who can speak Spanish, and is trained to sell mortgages and is based in London.
- The **WaitTime** (optional). Specifies the amount of time in seconds to wait before moving on to the next step if the conditions in this step cannot be met. For example, a wait time value of 20 would mean that if no agent matching the conditions for that step was available at the end of 20 seconds, the next step would be considered. If a wait time is not specified then a default of 0 is used. Do not specify a wait time for the last step in a Precision Queue.

To build the Steps field from these components, separate the parts of each step with a colon (:) and separate each step with a semi-colon (;). Do not add a semi-colon at the end of the last step.

The example below shows a Steps field with three steps, The first step has a **WaitTime** expression and the condition expression. The second has a **ConsiderIf** expression and a **WaitTime** expression as well as the condition expression. The third step is the last step, so can only have a condition expression.

**Step 1**
Specify the time in seconds to wait for the conditions in the step to be met. This ends with a colon as it is part of the step.

*WaitTime*=10:
Specify the condition expression to be used. This ends with a semi-colon as it is the end of the step, and another step follows it.

*Spanish >= 5 && MortgageTrained == True && Location == London;*

**Step 2**
Specify the circumstances to consider this step. This ends with a colon as it is part of the step. See the note below for the syntax for the ConsiderIf statement.

*ConsiderIf=TestForSituation:*
Specify the time in seconds to wait for the conditions in the step to be met. This ends with a colon as it is part of the step.

*WaitTime*=20:
Specify the condition expression to be used. This ends with a semi-colon as it is the end of the step, and another step follows it.

*Spanish >= 5 && MortgageTrained == True;*

**Step 3**
Specify the condition expression to be used if the previous steps have all failed. This has no semi-colon at the end as it is the final step.

*(Spanish >= 5) || (Spanish >=3 && MortgageTrained == True)*
Notes
In the example above the Step field has been separated into sections so you can see how it is constructed. When used in a bulk upload script, enter it as a single string in the same record as the other Precision Queue fields.

The ConsiderIf part of the test is not parsed by Unified CCMP but is passed directly to Unified CCE. For more information about the syntax of ConsiderIf expressions, see the Unified CCE documentation at http://docwiki.cisco.com/wiki/Precision_Routing_Release_9.0(1).

In the condition expression, you can use the following
- for joining conditions & & (AND) or || (OR)
- for comparisons of Boolean attributes == (is equal to) or != (is not equal to)
- for comparisons of proficiency attributes, == (is equal to), != (is not equal to), < (is less than), <= (is less than or equal to), > (is greater than) >= (is greater than or equal to).

6.5.19 Bulk Upload Skill Group Template
This table shows the columns required when bulk loading Skill Groups.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DepartmentMember</td>
<td>SNC</td>
<td>No</td>
<td>The department that this item belongs to. This field is only valid if the tenant is associated with a Unified CCE instance running Unified CCE version 10.0 or later. Otherwise, an error will be reported if this field is present.</td>
</tr>
<tr>
<td>PeripheralNumber</td>
<td>Numeric</td>
<td>No</td>
<td>The service number as known at the peripheral. If not supplied, an auto-generated number is used.</td>
</tr>
<tr>
<td>PeripheralName</td>
<td>SNC</td>
<td>No</td>
<td>The name of the Peripheral as it is known on the site.</td>
</tr>
<tr>
<td>AvailableHoldOff</td>
<td>Numeric</td>
<td>No</td>
<td>The value for this Skill Group instead of using the one associated with this peripheral.</td>
</tr>
<tr>
<td>Delay</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Priority</td>
<td>Numeric</td>
<td>No</td>
<td>The routing priority for the skill. This should be set to 0.</td>
</tr>
<tr>
<td>Column Name</td>
<td>Data Type</td>
<td>Required?</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------</td>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Extension</td>
<td>Numeric</td>
<td>No</td>
<td>The extension number for the service (used by Lucent DEFINITY ECS).</td>
</tr>
<tr>
<td>IPTA</td>
<td>Y/N</td>
<td>No</td>
<td>Indicates whether the Unified CCE picks the agent.</td>
</tr>
<tr>
<td>ServiceLevel Threshold</td>
<td>Numeric</td>
<td>No</td>
<td>The service level threshold, in seconds, for the service level. If this field is negative, the value of the Service Level Threshold field in the Peripheral table is used.</td>
</tr>
<tr>
<td>ServiceLevelType</td>
<td>Numeric</td>
<td>No</td>
<td>Indicates how the system software calculates the service level for the skill group. If this field is 0, Unified CCE uses the default for the associated Peripheral/MRD pair. Possible values: 0 = Use Default; 1 = Ignore Abandoned Calls; 2 = Abandoned Call Has Negative Impact; 3 = Abandoned Call Has Positive Impact.</td>
</tr>
<tr>
<td>DefaultEntry</td>
<td>Numeric</td>
<td>No</td>
<td>Normal entries are 0 (zero). Any records with a value greater than 0 are considered a default skill group for configuration purposes. Records having a value of 1 are used by Unified CCE as the default target skill group.</td>
</tr>
<tr>
<td>PeripheralMember</td>
<td>Enterprise Name</td>
<td>Yes</td>
<td>The peripheral to assign this skill group to.</td>
</tr>
<tr>
<td>RouteMember</td>
<td>SNC</td>
<td>No</td>
<td>The Routes associated with this skill group. To supply a list of routes, separate the routes in the list with a semi-colon (;). Note: The specified route or routes must not already exist. They will be created as part of the bulk upload of the skill group.</td>
</tr>
<tr>
<td>MediaRouting DomainMember</td>
<td>Numeric</td>
<td>Yes</td>
<td>The Media Routing Domain. This cannot be changed after skill group upload.</td>
</tr>
</tbody>
</table>

### 6.5.20 Bulk Upload User Variable Template

This table shows the columns required when bulk loading User Variables. Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".
6.5.21 Bulk Upload Users Template

This table shows the columns required when bulk loading Users.

Columns that are common to many resources are described in section 6.5.5 "Global Bulk Upload Columns".

**Note**

Users use only the Path and Description global columns from the Global Template.

<table>
<thead>
<tr>
<th>Column Name</th>
<th>Data Type</th>
<th>Required?</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LoginName</td>
<td>SNC</td>
<td>Yes</td>
<td>The login name of the user that will be used for application logon.</td>
</tr>
<tr>
<td>Password</td>
<td>Password</td>
<td>Yes</td>
<td>The password for the new user account</td>
</tr>
<tr>
<td>AdvancedMode</td>
<td>Boolean</td>
<td>No</td>
<td>Determines if the user is advanced or not</td>
</tr>
<tr>
<td>FirstName</td>
<td>SNC</td>
<td>No</td>
<td>The first name of the user</td>
</tr>
<tr>
<td>LastName</td>
<td>SNC</td>
<td>No</td>
<td>The last name of the user</td>
</tr>
<tr>
<td>ChangePasswordOnNextLogon</td>
<td>Boolean</td>
<td>No</td>
<td>Determines if after the initial logon the user should be prompted to reset their password</td>
</tr>
</tbody>
</table>
### 6.6 Item Merge

#### 6.6.1 About Merging

The Merge function allows items from multiple pieces of equipment to be combined into one single item. By merging items together common properties may be provisioned in one single place, reducing the time involved with creating and updating resource items.

#### 6.6.2 Merging Items

##### 6.6.2.1 Overview

The Merge function is accessed using the **Merge** button in the Items panel of the **System Manager** tool.

**Note**

The Merge function is only supported for Person items. You can use the Merge function to merge a Unified CCE Person and a Unified CM End User to create a single person.

##### 6.6.2.2 Master Item

The master item is the item to which all other items will be merged into. The master item may already be selected for you based on selections made in System Manager before entering the page. The equipment that the item is currently located on is shown in brackets after the item name.
To select a new master item, click on a row in Selectable Items table.

### 6.6.2.3 Items to Merge

The Items to Merge section of the page displays the current list of items to be merged into the master item. These items may already be selected for you based on selections made in System Manager before entering the page.

To add an entry to the Items to Merge list you must first locate the item in the Selectable Items sections of the page. Once the item is located, expand the row using the cross to show a list of equipment which the item is located on. Select which item equipment mappings you wish to merge into the master item by selecting the check-boxes.

To remove an entry from the Items to Merge list, click the cross located next to the item name.

### 6.6.2.4 Filter Options

You can filter the Selectable Items table using the Filter Options section of the page. Enter part or all of an item name and press the Find button.

You can filter a search by a specific piece of equipment using the Filter by Equipment drop-down box. You can search for an item across all pieces of equipment by selecting the All Equipment option.

### 6.6.2.5 Merge

When you have selected one or more Items to Merge, select the Merge button to merge the items into the Master Item. This will display a confirmation message for you to check that the items being merged are correct. Press the Confirm button to commit the changes.

### 6.7 System Search Folders

#### 6.7.1 About System Search Folders

If you have a global role that includes the Browse Search Folders permission then you may be able to see search system folders containing predefined searches in the Folder Tree panel (more information about global roles, see section 8.2.2 "About Global Roles"). System search folders may exist at root level, or in subfolders, or in both locations.

By default, Unified CCMP is configured with these predefined searches, located in Search Folders, immediately below the root folder:
- **Awaiting Deletion**: shows the user a flat list of all the items in the system that they have permission to see and are currently at Awaiting Deletion status.
- **Error**: shows the user a flat list of all the items in the system that they have permission to see and are currently at Error status.
- **Pending Active**: shows the user a flat list of all the items in the system that they have permission to see and are currently at Pending Active status.
- **Recently Modified**: shows the user a flat list of all the items in the system that they have permission to see and have been modified in the last hour.

**Note**
Depending on your system configuration, there may also be other search folders containing customized searches at other locations in the hierarchy.

### 6.7.2 Viewing Search Details
1. In the Folder Tree panel, click on **Search Folders**.
2. In the Items panel (summary view) you will see a single summary entry representing the searches in the folder. Click on the summary entry to show the list of searches in the Items panel (list view).
3. In the Items panel (summary view), click on a search to see the search details in the Detail panel.

### 6.7.3 Running a Predefined Search
1. To run a predefined search, in the Folder Tree panel, click on the + beside **Search Folders** to expand it, and then click on the search folder that contains the search you want to run. This runs the search.
2. The Items panel displays a summary list of the item types that match the search criteria. Click on an item type in the summary list to see the items of that type that match the search criteria.

### 6.7.4 Refreshing the Search Results
Right click on a search and select refresh to refresh the search results.

### 6.7.5 Moving or Deleting Searches
The searches are predefined. You cannot move or delete searches using the functionality in the Folder Tree panel or in the Items panel.
6.7.6 **Viewing or Editing Search Results**

To view or edit the items returned in a search:

1. In the Folder Tree panel, below Search Folders, identify the search you are interested in.
2. Next
   - either click on the search to see a summary view of the results in the Items panel, and then click on a resource type to see a list of the items of that type.
   - or click on a resource folder below the search to see a list view of the resource items of that type in the Items panel.
3. Click on an item in the Items panel to view the details for that item.
4. Optionally, edit the item details, as required, and then click **Save** to apply any changes, or **Cancel** to revert the changes.

**Note**

If you edit the item, you are editing the actual item, not just the search result.

6.7.7 **Moving Items in Search Results**

To move one or more items returned in a search:

1. In the Folder Tree panel, below Search Folders, identify the search you are interested in.
2. Next,
   - either click on the search to see a summary view of the results in the Items panel, and then click on a resource type to see a list of the items of that type.
   - or click on a resource folder below the search to see a list of the items of that type in the Items panel.
3. Check the box or boxes of the item or items to be moved.
4. Click the **Move** button.
5. The Move the Current Items page will be displayed, showing the folder tree.
6. Select the location in the folder tree to move the folder or folders to.
7. Click **Save**.
**6.7.8 Deleting Items from Search Results**

To delete one or more items returned in a search:

1. In the Folder Tree panel, below Search Folders, identify the search you are interested in.
2. Next,
   - either click on the search to see a summary view of the results in the Items panel, and then click on a resource type to see a list of the items of that type.
   - or click on a resource folder below the search to see a list of the items of that type in the Items panel.
3. Check the box or boxes of the item or items to be deleted.
4. Click **Delete**.
5. At the confirmation message, click OK to start the deletion.

**Notes**

If you delete an item, you are deleting the actual item, not just the search result.
7 System Manager Resource Guide

7.1 About Resource Types
This chapter describes:
- each resource type
- how to create, edit and delete that resource type (as applicable)
- other operations that can be performed on that resource
- the fields that can be set for that resource, and what each field means.

7.2 Agents

7.2.1 About Agents and Supervisor Agents

7.2.1.1 Agents
An Agent is a person who handles customer contacts. In Unified CCE, each agent can be a member of one or more skill groups. You can group agents into agent teams, which associate each with a specific supervisor or supervisors.

Each agent record must be associated with a Person. During agent creation, you can choose either to associate the agent with an existing person, or to create a new person for that agent. Multiple agents can be associated with a single person, should it be necessary (for example, someone who provides cover for teams on different peripherals will need to be represented by a separate agent account on each peripheral used).

You can use System Manager to create, edit, and delete agents, and to define agent properties such as passwords, skill group associations, and desk settings.
In order to use non-voice applications agents must be enabled for non-voice use via the administration interfaces for these multi-channel applications. Thus, while you can create all of your new agent records using Unified CCMP, you will need to use the administration interfaces of these non-voice applications to configure agents for their use.

7.2.1.2 Supervisor Agents

A supervisor agent is an agent, often with a user account on Unified CCMP, who can administer specific agents and agent teams. While a supervisor agent does not have to be assigned to supervise a specific team, an agent must be a supervisor agent to supervise a team.

A team supervisor may be a primary or secondary supervisor. A team may have any number of secondary supervisors, but only one primary supervisor.

You can define an agent to be a supervisor agent by checking the Supervisor check box.

Notes

If an agent is a supervisor agent, and if the associated Person has a Unified CCMP user account, that user should be added to the Supervisors security group, which allows users to edit agents and agent teams.

If an agent is a supervisor agent, then the agent must be associated with a domain account before they can have attributes associated with them.

7.2.1.3 Agent Example

ExampleCorp has ten agents in its New York contact center, and five in San Francisco. These agents are to be divided into three teams.

First, ExampleCorp creates two teams (Green and Blue) in New York, and one (Red) in San Francisco. Then it creates five Persons in San Francisco and ten Persons in New York, creates an Agent associated with each, and adds each Agent to a team.

ExampleCorp wants the two teams in New York to be supervised by the same senior supervisor agent. ExampleCorp therefore edits this agent to make her into a supervisor agent, and adds her as a Primary Supervisor to both teams. An agent can only be a member of a single team, however this supervisor supervises the Blue Team without being a member of it.
The user account of the Person associated with this supervisor agent is added to the ExampleCorp.Supervisors user group.

A primary supervisor is also assigned to the Red Team.

ExampleCorp then assigns secondary supervisors. It decides that the senior supervisor agent in New York should also be a secondary supervisor of the Red Team in San Francisco. Since it is possible to have any number of secondary supervisors for each team, this does not prevent them assigning a San Francisco agent as secondary supervisor to this team as well.

See Figure 7.1 "Agent Teams Example" for a diagram of this scenario.

![Agent Teams Example Diagram]

**Figure 7.1  Agent Teams Example**

### 7.2.2 Creating an Agent

To create an agent:

1. In **System Manager**, in the Folder Tree panel, select the folder where you want to create the agent.

2. In the Folder Tree panel, click **Resource**, and then click **Agent**.

3. Enter a Name, and select a Peripheral and Person to associate the agent with. You can choose either to associate the agent with an existing Person, or to create a new Person for that agent as follows:

   - **Select Existing Person**: Select a person from the drop-down list, or search for a specific person by typing a part of their name in the Search box. The new agent will use the details specified in that Person’s Peripheral Login box to log on to their Agent Desktop.
• **Create New Person.** Enter the first name and last (or family) name for the person, and fill in the details they will use to login to the peripheral. The person will be automatically created and associated with the agent.

4. Complete the remaining fields as described in section 7.2.7 "Agent Fields". Active from and to dates can be set in the **Advanced** tab.

5. Click **Save**.

Once you've created an agent, you can assign that user as the member of an Agent Team, and to one or more Skill Groups.

---

### 7.2.3 Adding an Agent to a Team

You can use the Agent Teams tab to change the team an agent is a member of and, in the case of a supervisor agent, to set the agent as primary or secondary supervisor for one or more teams.

**Note**

A supervisor agent does not need to be a member of a team to supervise it.

To add an agent to a team as either a supervisor or a member:

1. In **System Manager**, go to the folder containing the agent you want to update, and view the agents in that folder using the Items panel list view.

2. In the Items panel, click on the agent you want to add to a team. The details of this agent are displayed in the Details panel.

3. In the Details panel, click on the **Agent Teams** tab. The upper box shows a list of teams the agent is currently assigned to, and the lower box shows a list of teams available in the current folder. You can see the agent teams in other folders using the Selected Path drop-down folder list. The dates between which each team is active are displayed, as is the primary supervisor for that team.

4. Select teams in the lower box and click on the **Add** button to add the agent to them. They will automatically be moved into the upper box.

5. Check the **Member** box if the agent is to be a member of the team. This box should be checked in most cases.
An agent cannot be a member of more than one team, though a supervisor can supervise multiple teams.

- If the agent is a supervisor agent, you may choose to assign them as a supervisor to that team. Select **Primary Supervisor** or **Secondary Supervisor** from the drop-down list. A team can have multiple secondary supervisors but only one primary supervisor.

If you replace an existing primary supervisor, the replaced supervisor will automatically become a secondary supervisor for that team.

- You can remove the agent from a team by selecting the team (or teams) in the upper box and clicking on the Remove button.

6. Click **Save**.

### 7.2.4 Editing an Agent

To edit an agent:

1. In **System Manager**, go to the folder containing the agent you want to edit, and view the agents in that folder using the Items panel list view.
2. In the Items panel, click on the agent you want to edit. The details of this agent are displayed in the Details panel.
3. In the Details panel, click on the appropriate tab and make the desired changes.

If you select the Person tab and edit the details for the associated person, then the existing person record is updated when the agent changes are saved.

4. Click **Save**.

### 7.2.5 Deleting an Agent

To delete one or more agents:

1. In **System Manager**, go to the folder containing the agent or agents you want to delete, and view the agents in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the agent or agents to be deleted.
3. Click **Delete**.
4. In the Delete Agent dialog box, select **OK**. The agent or agents will be deleted.

**Notes**
Deleting an agent or agent supervisor will automatically remove that agent from any associated teams or skill groups, including multi-channel skill groups.
Deleting an agent or agent supervisor does not delete the associated person.

### 7.2.6 Bulk Uploading Agents

In addition to creating agents one at a time, you can also bulk load agent records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

### 7.2.7 Agent Fields

This table shows the tabs and fields available for the Agent resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the entry. This may be the same as the login name, last name or first name fields. Your company may specify a convention for this field (such as <code>&lt;first name&gt; &lt;last name&gt;</code>) to make it easier to identify agents.</td>
<td>Unique. Up to 32 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the agent.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The peripheral to be used for the agent.</td>
<td>Select from list.</td>
<td>Default Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
<td>-------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Create New Person or Select Existing Person option</td>
<td>Only shown when resource is first created. The kind of person to associate this agent with. <strong>Create New Person</strong>: The agent record is for a new employee, or one who has not previously existed as a Person within Unified CCMP. <strong>Select Existing Person</strong>: The person to be associated with this agent record already exists within the system, for example if the Person record for a new employee was created before it was clear which peripheral they would be using.</td>
<td>Select one of the options, and then complete the remaining fields for that option as shown below.</td>
<td>Create New Person</td>
<td>Yes</td>
</tr>
<tr>
<td>Create New Person &gt; First Name</td>
<td>The person's first name.</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Create New Person &gt; Last Name</td>
<td>The person's last name.</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Create New Person &gt; Login Name</td>
<td>A unique login name for the person to allow them to login to the peripheral. <em>Note: The Unified CCE database is case-insensitive in determining whether a login name is unique - for example, it considers &quot;joe_smith&quot; and &quot;JOE_SMITH&quot; to be the same. Further, agent login to agent desktop software (such as CTI OS) is not case-sensitive.</em></td>
<td>Unique. Up to 32 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Create New Person &gt; Password</td>
<td>The password that the person will use to log in to the system.</td>
<td>Unique. At least five letters long. Longer passwords, including numbers and other characters, may be required. Ask your system administrator for details.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Create New Person &gt; Confirm Password</td>
<td>Confirmation of the password.</td>
<td>The same as for the Password field. This ensures that the person is not prevented from logging in by typographical errors made when setting his or her password.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Select Existing Person &gt; List of persons</td>
<td>List of available persons, optionally filtered by the search field.</td>
<td>Select the person corresponding to this agent.</td>
<td>First person in list.</td>
<td>Yes</td>
</tr>
<tr>
<td>Select Existing Person &gt; Search filter</td>
<td>Optional search field to filter results in list of persons.</td>
<td>Type a partial name to restrict the list of available persons to those which include that name.</td>
<td>None (complete list of persons shown).</td>
<td>No</td>
</tr>
</tbody>
</table>

**Person Tab (not shown when creating an agent)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Name</td>
<td>The person's first name.</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Last Name</td>
<td>The person's last name.</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>The person’s description</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-----------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Login Name</td>
<td>A unique login name for the person associated with this agent to allow them to login to the peripheral.</td>
<td>Unique. Up to 32 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Login Enabled</td>
<td>Check this box to allow the person associated with the agent to log on to peripheral</td>
<td>Check box.</td>
<td>Checked.</td>
<td>No</td>
</tr>
<tr>
<td>Reset Password</td>
<td>Check this box to reset the password for the person associated with this agent.</td>
<td>Check box.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Password</td>
<td>The new password that the person uses to log in to the system. Only shown if Reset Password is checked.</td>
<td>Unique. At least five letters long. Longer passwords, including numbers and other characters, may be required. Ask your system administrator for details.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Confirmation of the changed password. Only shown if Reset Password is checked.</td>
<td>The same as for the Password field. This ensures that the person is not prevented from logging in by typographical errors made when setting his or her password.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Supervisor Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Supervisor</td>
<td>Check this box if an agent is to be considered a supervisor agent. This does not require that they supervise a team.</td>
<td>Check box.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Associate with Domain Account</td>
<td>Associates a supervisor agent with an existing domain account (the account used to log onto the network and to WebView). Note: The supervisor agent must be associated with a domain account before they can have attributes assigned to them.</td>
<td>Check box.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Login Name</td>
<td>The domain login name to be used by the supervisor agent.</td>
<td>Existing domain login name. Select from list of possibilities by typing part of the login name.</td>
<td>Null</td>
<td>If Associate with Domain Account checked</td>
</tr>
<tr>
<td><strong>Agent Teams Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agent Teams</td>
<td>The supervisory teams with which the agent is associated.</td>
<td>Select from lower list of available agent teams and click Add to include agent in the checked teams. To remove an agent from an existing agent team, select agent team from upper list and click Remove.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>
### Skill Groups Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Skill Group</td>
<td>The skill group or groups of which the agent is a member. Changes to an agent's skill group membership take place immediately within the agent's current session.</td>
<td>Select from lower list of available skill groups and click <strong>Add</strong> to include the agent in the selected skill groups. To remove the agent from an existing skill group, select from upper list and click <strong>Remove</strong>. To set the default skill group for the agent, firstly, ensure that the agent is in the required skill group as above, then select the <strong>Default</strong> check box beside the skill group. To revert the default skill group for this agent to the system default, clear the selected <strong>Default</strong> check box.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

### Attributes Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
</table>
| Attribute | The attribute or attributes associated with the agent. Changes to an agent's attribute association take place immediately within the agent's current session.  
*Note: If the agent is a supervisor agent, they must be associated with a domain account before they can have attributes assigned to them.* | Select from lower list of available attributes and click **Add** to associate the agent with the checked attributes. To remove an agent association with an existing attribute, select from upper list and click **Remove**. To specify the value for an attribute associated with the agent, select the value from the drop down list in the value column. | Null    | No       |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name used to identify the agent within the system</td>
<td>Unique. Up to 32 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Auto-generated from the agent name. The system reserves 5 characters for tenant, 5 characters for peripheral, 17 characters taken from the agent name, and 2 characters for dimension type, plus 3 separating dots.</td>
<td>No</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Agent ID</td>
<td>The internal extension number that can be used to call the agent.</td>
<td>Up to 18 numbers.</td>
<td>Auto-generated.</td>
<td>No</td>
</tr>
<tr>
<td>Agent Desktop</td>
<td>The desktop settings to be associated with the agent.</td>
<td>Select from list of available agent desktops.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>------------------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>State Trace</td>
<td>Enables the system to track the agent’s state transitions such as Available or Talking. This check box is dimmed by default and must be made available by a System Administrator before it can be used (using Settings &gt; Provisioning Settings &gt; Agent State Trace Enabled). Note: Cisco state that tracking agent state data puts additional load on UCCE. Please consult the Cisco documentation before using this feature.</td>
<td>Check box.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the agent will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the agent should be deleted from the system.</td>
<td>Either leave Forever checked, or uncheck Forever and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
### Custom Data Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null.</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (ئة) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (حذف), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.3 Agent Desktops

#### 7.3.1 About Agent Desktops

Agent Desktops associate a set of permissions or characteristics with specific agents. The settings are comparable to Class of Service settings on a PBX or ACD. You assign Agent Desktops to each agent via the Agent record.
When you create an Agent Desktop definition, you specify the amount of non-active time after which an agent is automatically logged out, whether wrap-up is required following incoming and outbound calls, the amount of time allocated for wrap-up, and the method used for assist and emergency calls. You also specify settings for the Re-route on No Answer feature.

Unified CCE ships with a system default Agent Desktop. New agent records are automatically assigned this default unless you specify otherwise when creating an agent.

You can use System Manager to create, edit, and delete Agent Desktops.

7.3.2 Creating an Agent Desktop

To create an Agent Desktop record:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the Agent Desktop.
2. In the Folder Tree panel, click Resource, and then click Agent Desktop.
3. Enter unique name of up to 32 characters for the record. This name can use alphanumeric characters, periods, and underscores.
4. Complete the remaining fields as described in section 7.3.6 "Agent Desktop Fields".
5. Click Save.

7.3.3 Editing an Agent Desktop

To edit the details of an Agent Desktop:

1. In System Manager, go to the folder containing the Agent Desktop you want to edit, and view the Agent Desktops in that folder using the Items panel list view.
2. In the Items panel, click on the Agent Desktop you want to edit. The details of this Agent Desktop are displayed in the Details panel.
3. In the Details panel, click on the appropriate tab and make the desired changes.
4. Click Save.

7.3.4 Deleting an Agent Desktop

Note
You cannot delete an Agent Desktop if it is being referenced by an Agent record or if it is the default desktop.
To delete one or more Agent Desktops:

1. In **System Manager**, go to the folder containing the Agent Desktops you want to delete, and view the Agent Desktops in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the Agent Desktops to be deleted.
3. Click **Delete**.
4. In the Delete Folder dialog box, click **OK**. The Agent Desktops will be deleted.

### 7.3.5 Bulk Uploading Agent Desktops

In addition to creating Agent Desktops one at a time, you can also bulk load Agent Desktop records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

### 7.3.6 Agent Desktop Fields

This table shows the tabs and fields available for the Agent Desktop resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Ring no answer time</td>
<td>The maximum number of seconds a call will to ring at the agent’s station before being redirected. This can be from 1 to 120 seconds (2 minutes).</td>
<td>1 to 120</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>----------------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------</td>
<td>------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Ring no answer dialed number</td>
<td>Identifies the dialed number for a new re-route destination in the case of a ring no answer. The selection list consists of the dialed numbers configured for the system.</td>
<td>Select from list</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Logout non-activity time</td>
<td>The number of seconds during which the agent has been in the not ready state and inactive that the system will wait before logging out the agent. A blank entry will disable the timer.</td>
<td>10 to 7200</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Incoming work mode</td>
<td>Indicates whether the agent is allowed or required to enter work mode after an incoming call.</td>
<td>Select from list.</td>
<td>Required</td>
<td>Yes</td>
</tr>
<tr>
<td>Outgoing work mode</td>
<td>Indicates whether the agent is allowed or required to enter work mode after an outgoing call.</td>
<td>Select from list.</td>
<td>Required</td>
<td>Yes</td>
</tr>
<tr>
<td>Wrap-up time</td>
<td>The amount of time in seconds allocated to an agent to wrap up the call.</td>
<td>1 to 7200</td>
<td>7200</td>
<td>Yes</td>
</tr>
<tr>
<td>Assist call method</td>
<td>Indicates whether to use a consultative call or a blind conference call for the supervisor assistance request.</td>
<td>Select from list.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Emergency call method</td>
<td>Indicates whether to use a consultative call or a blind conference call for an emergency call request.</td>
<td>Select from list.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Recording Mode</td>
<td>Specifies whether calls are routed through the Peripheral Interface Manager (PIM)</td>
<td>Select from list</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------------</td>
<td>----------</td>
</tr>
<tr>
<td>Remote Agent Type</td>
<td>Indicates how mobile agent call routing is handled.</td>
<td>Select from list. One of</td>
<td>Local Only</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>• <strong>Local Only</strong>: mobile agent call routing is not required.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Call by Call Routing</strong>: the mobile agent is called individually for each call.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Nailed Connection Routing</strong>: the mobile agent is called at login and remains connected until log off.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Agent Chooses At Login</strong>: the mobile agent can choose the one of the two mobile agent call routing types at login.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>For information about configuring mobile agents, see <em>Administration Guide for Cisco Unified Contact Center Management Portal</em>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>A description of the desktop.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

**Details Tab > Miscellaneous**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Auto answer</td>
<td>Indicates calls to the agent are automatically answered.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Idle reason required</td>
<td>Indicates the agent must enter a Not Ready reason before entering the Idle state.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Logout reason required</td>
<td>Indicates the agent must enter a reason before logging out.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Auto record on emergency</td>
<td>Specifies that a record request (a request to record the call) is automatically sent when an emergency call request starts.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Silent Monitor Audible Indication</td>
<td>Specifies whether to indicate that silent monitoring has begun by a click.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Silent Monitor Warning Message</td>
<td>Specifies whether to indicate that silent monitoring has begun with a message box on the agent’s desktop.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Available after Incoming</td>
<td>Whether the agent is to be automatically considered available after handling an incoming call.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Available after Outgoing</td>
<td>Whether the agent is to be automatically considered available after handling an outgoing call.</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Remote Login Without Desktop</td>
<td>Allows the agent to log in to the contact center without using an agent desktop</td>
<td>Checked or Unchecked</td>
<td>Unchecked</td>
<td>No</td>
</tr>
</tbody>
</table>

**Details Tab > Outbound Access**

<p>| Outbound Access                     | For deployments where agents can make outbound calls, determines the type of outbound calls they can make. | Select one or more from International, National, Local private network, Operator assisted, PBX, Agent to Agent, Non ACD Calls, Initiate Supervisor Calls Allowed. | Unchecked | No       |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Agent Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agents</td>
<td>The agents with which the desktop is associated.</td>
<td>Select from lower list of available agents and click <strong>Add</strong> to include the checked agents in this desktop. To remove existing agents from this desktop, select from upper list and click <strong>Remove</strong>.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name used to identify the desktop within the system.</td>
<td>Unique. Up to 32 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Auto-generated from the name.</td>
<td>No</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the desktop will be active within the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the desktop will be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Custom Data Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null.</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click Add. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (&gt;Edit) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (&gt;Delete), then click OK to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.4 Agent Teams

#### 7.4.1 About Agent Teams

An agent team is a group of individuals that can be managed by a supervisor. Agents are assigned to agent teams individually. When configuring agent teams, be aware of the following rules:

- An agent can be a member of only one agent team (or of no teams).
- An agent team can have only one Primary Supervisor.
- A supervisor can be a supervisor of any number of agent teams.
- A supervisor for an agent team can also be a member of that agent team.
You can use System Manager to create, edit, and delete agent teams, and to assign agents and supervisors to a team.

### 7.4.2 Creating an Agent Team
To create an agent team:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the agent team.
2. In the Folder Tree panel, click Resource, and then click Agent Team.
3. Enter a unique name for the team.
4. Complete the remaining fields as described in section 7.4.6 "Agent Team Fields".
5. To assign agents to the team, check the boxes of one or more agents in the Agents tab, and click on Add above the list.

**Note**
The Selected Path drop-down opens up a folder tree so that you can also select agents from other folders to add to the team.

6. Once an agent is added to the team, you must also check their Member box to make them a member of the team. This is because it is possible to be involved with a team without being a member, by supervising it.
7. If an agent is a supervisor, a drop-down list appears in the right-hand column. You can use this to specify whether the agent has a supervisory role for this particular team.

**Note**
A team may have multiple secondary supervisors, but only one primary supervisor. If you replace an existing primary supervisor, the replaced supervisor will automatically become a secondary supervisor for that team.

8. Click Save.

### 7.4.3 Editing an Agent Team
To edit an agent team:

1. In System Manager, go to the folder containing the agent team you want to edit, and view the agent teams in that folder using the Items panel list view.
2. In the Items panel, click on the agent team you want to edit. The details of this agent team are displayed in the Details panel.
3. Click through the tabs and edit the fields you want to change.
4. To remove agents from a team, click on the Agents tab and check the boxes of the agents you wish to remove from the team. Click Remove.
5. Click Save.

7.4.4 Deleting an Agent Team
To delete one or more agent teams:
1. In System Manager, go to the folder containing the agent teams you want to delete, and view the agent teams in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the agent teams to be deleted.
3. Click Delete.
4. In the Delete Agent Teams dialog box, click OK. The agent teams will be deleted.

7.4.5 Bulk Uploading Agent Teams
In addition to creating agent teams one at a time, you can also bulk load agent team records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.4.6 Agent Team Fields
This table shows the tabs and fields available for the Agent Team resource.
For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the team.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The peripheral to associate with the team.</td>
<td>Select from list.</td>
<td>Default peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Supervisor script dialed number</td>
<td>The dialed number identifier for the agent team.</td>
<td>Select from list.</td>
<td>None</td>
<td>No</td>
</tr>
</tbody>
</table>

**Agents Tab**

<table>
<thead>
<tr>
<th>Agents</th>
<th>Individual agents associated with this team.</th>
<th>Select from lower list of available agents and click Add to include the checked agents in this agent team. To remove existing agents from this agent team, select from upper list and click Remove.</th>
<th>Null</th>
<th>No</th>
</tr>
</thead>
</table>

**Advanced Tab**

<table>
<thead>
<tr>
<th>Enterprise Name</th>
<th>The name that will represent the team within the network</th>
<th>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</th>
<th>From Name and Peripheral</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which this team must be active within the network.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which this team will be deleted from the system.</td>
<td>Either leave Forever checked, or uncheck Forever and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
### Custom Data Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (⇧) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (-trash), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.5 Attributes

#### 7.5.1 About Attributes

An attribute is some user-defined information that can be associated with an agent. It defines the agent’s knowledge or experience in a particular area and the level of that knowledge or experience. An attribute has a *name*, which identifies the attribute, and a *value*, which indicates the level an agent has attained for that attribute.

Attribute values can be:

- *boolean* (the agent either has that attribute or does not have that attribute)
- graded according to *proficiency* (the agent has attained a specific grade of expertise in that attribute)
Attributes are used in Precision Queues (see section 7.20.1 "About Precision Queues") to define rules for routing calls based on agent attributes.

You can use System Manager to create, edit and delete user-defined attributes and to assign attributes to agents.

**Note**
Attributes can only be created on tenants that are associated with a Unified CCE instance running Unified CCE version 9.0 or later.

### 7.5.1.1 Attribute Examples

An attribute called Mortgage_Training may be defined with a boolean value to indicate whether an agent has been trained to sell mortgages. This attribute can then be associated with a number of agents, and for each agent, the value of the Mortgage Training attribute can be set to either True or False, depending on whether the agent has had the training or not.

Another example could be an attribute called Spanish_Speaker with a proficiency value to indicate how fluent the agent is in the Spanish language. If an agent does not speak Spanish, then this attribute can be set to 1 (the lowest possible proficiency value). If the agent is a native Spanish speaker, the attribute can be set to 10 (the highest possible proficiency value). If the agent knows some Spanish but is not very fluent, the attribute could be set to 5.

### 7.5.2 Creating an Attribute

To create an attribute:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the attribute.
2. In the Folder Tree panel, click Resource, and then click Attribute.
3. Enter a unique name for the attribute.
4. Complete the remaining fields as described in section 7.5.6 "Attribute Fields".
5. To assign agents to the attribute, on the Agents tab check the boxes of one or more agents, and click on Add above the list. For each agent you add, click on the drop-down arrow in the Value column to select the value of that attribute for that agent.

**Notes**

1. The Selected Path drop-down at the top allows you to select agents from other folders to associate with the attribute.
2. If you change the attribute type on the Details tab after you have assigned attribute values to agents, a warning message will be displayed and all agent attribute values will be reset to the default value for the new attribute type.

6. Click Save to create the attribute and assign it to the specified agents.

### 7.5.3 Editing an Attribute

To edit an attribute:

1. In System Manager, go to the folder containing the attribute you want to edit, and view the attributes in that folder using the Items panel list view.

2. In the Items panel, click on the attribute you want to edit. The details of this attribute are displayed in the Details panel.

3. Click through the tabs and edit the fields you want to change.

4. To remove an attribute from one or more agents, click on the Agents tab and check the boxes of the agents you wish to remove the attribute from. Click Remove.

5. To change the attribute value associated with an agent, click on the Agents tab, locate the agent you want modify, click on the drop down arrow beside the attribute value and select the new value.

6. Click Save.

### 7.5.4 Deleting an Attribute

**Note**

You cannot delete an attribute that is included in a Precision Queue. This reference must be removed before the attribute can be deleted.

To delete one or more attributes:

1. In System Manager, go to the folder containing the attributes you want to delete, and view the attributes in that folder using the Items panel list view.

2. In the Items panel, check the box or boxes of the attributes to be deleted.

3. Click Delete.

4. In the Delete Attributes dialog box, click OK. The attributes will be deleted.

**Note**

Deleting an attribute automatically removes the attribute association from any agents that were associated with that attribute.
7.5.5 **Bulk Uploading Attributes**

In addition to creating Attributes one at a time, you can also bulk load Attribute records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.5.6 **Attribute Fields**

This table shows the tabs and fields available for the Attribute resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the attribute.</td>
<td>Unique. Up to 50 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the attribute.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Data Type</td>
<td>The data type of the attribute value.</td>
<td>Select from list. Values are:</td>
<td>Boolean</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Boolean</strong>: the value can be True or False</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Proficiency</strong>: the value can be a whole number between 1 and 10 (1 is least proficient and 10 is most proficient).</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default Value</td>
<td>The default value to be used when this attribute is associated with an agent.</td>
<td>Select from list</td>
<td>True (Boolean attributes) or 1 (proficiency attributes)</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
<td>----------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Agents Tab</strong></td>
<td></td>
<td>Select from lower list of available agents and click <strong>Add</strong> to associate this attribute with the selected agents. To remove this attribute from existing agents, select from upper list and click <strong>Remove</strong>. To specify the value for this attribute associated with a particular agent, select the value from the drop down list in the value column.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Agents</td>
<td>Agents associated with this attribute.</td>
<td>Select from lower list of available agents and click <strong>Add</strong> to associate this attribute with the selected agents. To remove this attribute from existing agents, select from upper list and click <strong>Remove</strong>. To specify the value for this attribute associated with a particular agent, select the value from the drop down list in the value column.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the attribute within the network</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Autogenerated</td>
<td>Yes</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the attribute should be active in the system</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the attribute should be deleted from the system</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click Add. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (↑) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (🗑️), then click OK to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.6 Call Types

#### 7.6.1 About Call Types

##### 7.6.1.1 Overview

A call type is a category of incoming routable task. Specific call types are associated with Dialed Numbers. In this association, each call type has a schedule that determines which routing script or scripts are active for that call type at any time.

You can use System Manager to create, edit, and delete call types.

##### 7.6.1.2 Call Types and Dialed Number Associations

There are two classes of call type/dialed number associations:
- **Voice**: Voice call type/dialed number combinations such as phone calls are categorized by the dialed number (DN), caller-entered digits (CED), and calling line ID (CLID). The CED and CLID can be optional, depending on the call.

- **Non-voice**: Non-voice type/dialed number combinations (such as e-mail and text chat) are categorized by the Script Type Selector, Application String 1, and Application String 2. Application String 1 and Application String 2 can be optional, depending on the application.

### 7.6.1.3 Call Types and Routing Scripts

Because the call type determines which routing script is run for a call, the call type defines call treatment.

In routing scripts you can change the call type at specific points in the script to indicate that a transaction has been completed. For example, if the customer is calling a bank and successfully checks his or her account balance using a Self-Service script, you may want to change the call type to indicate that the account balance transaction has completed and a new transaction has begun. You can also change call type in a script to invoke a new routing script associated with that call type. For example, if a call is not answered at an agent's desktop, you can change the call type in the script to redirect the call to a different script designed for Redirection on No Answer. The Redirection on No Answer script assigns a different agent to handle the call.

### 7.6.2 Creating a Call Type

To create a call type:

1. In **System Manager**, in the Folder Tree panel, select the folder where you want to create the call type.
2. In the Folder Tree panel, click **Resource**, and then click **Call Type**.
3. Enter a unique name of up to 32 characters for the call type. This can contain alphanumeric characters, periods, and underscores only.
4. Complete the remaining fields as described in section 7.6.5 "Call Type Fields".
5. Click **Save**.

Once you have created a call type you can reference it in a dialed number configuration through Unified CCE.
7.6.3 Deleting a Call Type

Note
You cannot delete the default call type.

To delete one or more call types:
1. In System Manager, go to the folder containing the call types you want to delete, and view the call types in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the call types to be deleted.
3. Click Delete.
4. In the Delete Call Types dialog box, click OK. The call types will be deleted.

Note
Deleting a call type automatically removes it from any dialed number mappings in which it is referenced.

7.6.4 Bulk Uploading Call Types

In addition to creating call types one at a time, you can also bulk load call type records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.6.5 Call Type Fields

This table shows the tabs and fields available for the Call Type resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Bucket Interval</td>
<td>The count of Answered or Abandoned calls that are used as intervals for the Call Type</td>
<td>Select from list</td>
<td>System Default</td>
<td>No</td>
</tr>
<tr>
<td>Service level threshold</td>
<td>Optionally, use to indicate whether this call type will use a service level threshold other than the system default.</td>
<td>Select from Use Global, None, and Use Specified. For Use specified, you must also enter a number in seconds between 0 and 2147483647.</td>
<td>Use global</td>
<td>No</td>
</tr>
<tr>
<td>Service level type</td>
<td>Optionally, use to indicate how abandoned calls should be factored in calculating service levels.</td>
<td>Select from Use global setting, Ignore Abandoned Calls, Abandoned Calls Have Negative Impact, and Abandoned Calls Have Positive Impact.</td>
<td>Use global setting</td>
<td>No</td>
</tr>
</tbody>
</table>

### Advanced Tab

<p>| Field               | Description                                                                 | Entry                                                                 | Default                      | Required |
|---------------------|------------------------------------------------------------------------------|                                                                      |                             |          |
| Enterprise Name     | The name that will represent the Call Type within the network.               | Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric. | Auto-generated from Name    | No       |
| Department          | (Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with. | Select from the drop-down list of available departments.             | None            | No       |
| Active From Date    | The date from which this Call Type should be active within the system       | Select date from calendar.                                          | Current date                | Yes      |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active To Date</td>
<td>The date after which this Call Type should be deleted from the system</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Custom Data Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (') and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (⨉), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.7 Departments

#### 7.7.1 About Departments

A Department is a way of grouping related resources according to user-defined business needs. You can create a department, then add various resources to it, to reflect your particular organization.

The following resources can be added to a department:

- Agents
- Agent Desktops
- Agent Teams
- Precision Attributes
- Call Types
- Dialed Numbers
- Enterprise Skill Groups
- Network VRU Scripts
- Persons
- Precision Queues
- Services
- Skill Groups

For example, you may create a department called **Sales** then include in it all the Agents, Agent Teams, Call Types, Dialed Numbers and Skill Groups that relate to the sales function. A resource can only be included in one department.

You can use System Manager to create, edit, and delete departments. To add a resource to a department or remove a resource from a department, you must edit the resource you want to add or remove, not the department.

**Note**
Department resources can only be created on tenants that are associated with a Unified CCE instance running Unified CCE version 10.0 or later.

### 7.7.2 Creating a Department

To create a Department:

1. In **System Manager**, in the Folder Tree panel, select the folder where you want to create the department.
2. In the Folder Tree panel, click **Resource**, and then click **Department**.
3. Enter a unique name of up to 32 characters for the Department. This must consist of alphanumeric characters, periods, and underscores only.
4. Complete the remaining fields as described in section 7.7.6 "Department Fields".
5. Click **Save**.

### 7.7.3 Editing a Department

To edit a Department:

1. In **System Manager**, go to the folder containing the department you want to edit, and view the departments in that folder using the Items panel list view.
2. In the Items panel, click on the department you want to edit. The details of this department are displayed in the Details panel.
3. Click through the tabs and edit the fields you want to change.
4. Click Save.

**Note**
To add a resource to a department or remove a resource from a department, you must edit the resource you want to add or remove, not the department.

### 7.7.4 Deleting a Department

**Note**
You cannot delete a Department that has any resources associated with it. All resources must be removed from the department before it can be deleted.

To delete one or more departments:
1. In **System Manager**, go to the folder containing the departments you want to delete, and view the departments in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the departments to be deleted.
3. Click **Delete**.
4. In the Delete Departments dialog box, click **OK**. The departments will be deleted.

### 7.7.5 Bulk Uploading Departments

In addition to creating Departments one at a time, you can also bulk load Department records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

### 7.7.6 Department Fields

This table shows the tabs and fields available for the Department resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".
### Device Profiles

#### 7.8.1 About Device Profiles

A device profile is a telephone template that a user can use to retain their specific phone configuration across a number of different physical phones. A device profile may be associated with more than one user allowing it to be shared by multiple Unified CM users. A device profile may contain a number of directory number mappings.

You can use System Manager to create, edit, and delete Unified CM extension mobility device profiles.

---

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the Department within the network.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>From Name</td>
<td>Yes</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Department will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the Department should be deleted from the system.</td>
<td>Either leave Forever checked, or uncheck Forever and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
7.8.2 Creating a Device Profile
To create a device profile:
1. In System Manager, in the Folder Tree panel, select the folder where you want to create the device profile.
2. In the Folder Tree panel, click Resource, and then click Device Profile.
3. On the Directory Numbers tab, optionally add directory numbers by checking the boxes of numbers to add and clicking Add.
4. On the Users tab, optionally add associated users that may use the device profile by checking the boxes of those users and clicking Add.
5. Complete the remaining fields as described in section 7.8.4 "Device Profile Fields".
6. Click Save.

7.8.3 Deleting a Device Profile
To delete one or more device profiles:
1. In System Manager, go to the folder containing the device profiles you want to delete, and view the device profiles in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the device profiles to be deleted.
3. Click Delete.
4. In the Delete Device Profiles dialog box, click OK. The device profiles will be deleted.

7.8.4 Device Profile Fields
This table shows the tabs and fields available for the Device Profile resource.
For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".
<table>
<thead>
<tr>
<th><strong>Field</strong></th>
<th><strong>Description</strong></th>
<th><strong>Entry</strong></th>
<th><strong>Default</strong></th>
<th><strong>Required</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the device profile.</td>
<td>Unique. Up to 100 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the device profile.</td>
<td>Up to 128 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Directory Numbers Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Directory Numbers</td>
<td>The lines to be associated with the device profile.</td>
<td>To associate a directory number with this device profile, select a directory number from the lower list of available directory numbers and click Add. To remove a directory number association from this device profile, select the directory number from the upper list and click Remove.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Index</td>
<td>The port on the IP Phone that the line is plugged into.</td>
<td>Number.</td>
<td>Next in sequence.</td>
<td>No</td>
</tr>
<tr>
<td><strong>Users Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Users</td>
<td>The users to be associated with the device profile.</td>
<td>To associate a user with this device profile, select a user from the lower list of available users and click Add. To remove a user association from this device profile, select the user from the upper list and click Remove.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the device profile within the network.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>—</td>
<td>—</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the device profile will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the device profile should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td><strong>Custom Data Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null.</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon () and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes.</td>
</tr>
</tbody>
</table>
7.9  Dialed Numbers

7.9.1  About Dialed Numbers
A dialed number (DN) is the number a caller dials to initiate a call. It is sent as part of the call detail information in the route request message sent from the routing client. The Dialed Number plays an integral role in routing calls. Dialed Numbers are required pieces of call types, which are used to identify the appropriate routing script for each call. In addition to answered calls, Dialed Numbers also need to be set up for ring on no answer, dialed number plan entries, and for supervisor/emergency calls.

You can use System Manager to create, edit, and delete dialed numbers and associate them with other resources such as Agent Desktops or Labels.

7.9.2  Creating a Dialed Number
To create a dialed number:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the dialed number.
2. In the Folder Tree panel, click Resource, and then click Dialed Number.
3. Enter unique name of up to 32 characters for the Dialed Number. This must consist of alphanumeric characters, periods, and underscores only.
4. Complete the remaining fields as described in section 7.9.5 "Dialed Number Fields".
5. Click Add to specify the call types and other dialing information to be associated with this dialed number.

Note
The order of the entries in the Dialed Number mapping table reflects the order in which call types are processed for the Dialed Number.

6. Click Save.

7.9.3  Deleting a Dialed Number

Note
You cannot delete a Dialed Number that is referenced in a script. This reference must be removed before the Dialed Number can be deleted.

To delete one or more dialed numbers:
1. In **System Manager**, go to the folder containing the dialed numbers you want to delete, and view the dialed numbers in that folder using the Items panel list view.

2. In the Items panel, check the box or boxes of the dialed numbers to be deleted.

3. Click **Delete**.

4. In the Delete Dialed Numbers dialog box, click **OK**. The dialed numbers will be deleted.

### 7.9.4 Bulk Uploading Dialed Numbers

In addition to creating dialed numbers one at a time, you can also bulk load dialed number records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

### 7.9.5 Dialed Number Fields

This table shows the tabs and fields available for the Dialed Number resource. For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Dialed Number</td>
<td>For voice MRD only, the string value by which the Agent/IVR Controller identifies this Dialed Number. This must be the value the Agent/IVR Controller uses for calls to this number. For example: 8005551212</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Permit Application Routing</td>
<td>Indicates whether Application Routing is allowed</td>
<td>Check box.</td>
<td>Disabled</td>
<td>No</td>
</tr>
<tr>
<td>Routing Client</td>
<td>The routing client (such as NIC or PG) that this number should use to submit routing requests to the Unified CCE</td>
<td>Drop-down list. <em>Cannot be edited after dialed number has been created.</em></td>
<td>First in list</td>
<td>Yes</td>
</tr>
<tr>
<td>Media Routing Domain</td>
<td>A description of how contact is made</td>
<td>Select from a drop-down list. <em>Cannot be edited after dialed number has been created.</em></td>
<td>Cisco Voice</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Agent Desktops Tab**

| Agent Desktops               | The Agent Desktops associated with this Dialed Number.                      | Select from lower list of available agent desktops and click **Add** to associate the checked agent desktops with this dialed number. To remove an agent desktop association from this dialed number, select from upper list and click **Remove**. | Null    | No       |

**Agent Teams Tab**

| Agent Teams                  | The Agent Teams associated with this Dialed Number.                         | Select from lower list of available agent teams and click **Add** to associate the checked agent teams with this dialed number. To remove an agent team association from this dialed number, select from upper list and click **Remove**. | Null    | No       |
### Labels Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Labels</td>
<td>The Labels associated with this Dialed Number.</td>
<td>Select from lower list of available labels and click <strong>Add</strong> to associate the checked labels with this dialed number. To remove a label association from this dialed number, select from upper list and click <strong>Remove</strong>.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

### Call Types Tab

| Call Types  | The Call Types associated with this Dialed Number. These specify onward routing for certain calls. The call types are listed in priority order. | Either click:  
- **Add** to add a details for a new call type  
- select an existing call type from list and click:  
  - **Edit** to edit existing call type details  
  - **Remove** to delete existing call type details  
The Call Type dialog box is displayed.  
**Note:** You can select a call type from the list then click **Up Arrow (↑)** to move the call type up the priority list or click **Down Arrow (↓)** to move the call type down the priority list. | Null    | No       |

#### Call Types Tab > Call Type dialog box

<table>
<thead>
<tr>
<th>Call Type</th>
<th>The call type for this call type routing.</th>
<th>Select from list.</th>
<th>First in list</th>
<th>Required</th>
</tr>
</thead>
</table>
| Calling Line ID | The calling line identification (CLID) to associate with this call type and routing. | Select one of the options.  
|                 | **All:** route all calls  
**Region:** route all calls from specified region  
**Prefix:** route all calls where number starts with this prefix  
**Match:** route calls from this number only | All               | Yes      |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
</table>
| Caller Entered Digits    | The caller entered digits (CED) to associate with this call type and routing.| Select one of the options.  
  **All**: route all calls regardless of CED  
  **None**: route calls with no CED  
  **CED**: route calls with this CED only.  
  If you choose None, you can also optionally check one or both of:  
  **None Required**: caller wasn’t asked for any CED  
  **None Entered**: caller was asked for CED but didn’t respond | All     | Yes      |

**Advanced Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the Dialed Number within the network.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>From Name</td>
<td>Yes</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Dialed Number will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the Dialed Number should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>
### Field Description Entry Default Required

#### Custom Data Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon ( MODIFY ) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon ( DELETE ), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Note**
The Self Care tab is only shown for existing resources. It is not shown when the resource is first created.

### 7.10 Directory Numbers

#### 7.10.1 About Directory Numbers

A directory number is an extension line which is attached to an IP Phone. You can use System Manager to create, edit, and delete directory numbers.

#### 7.10.2 Creating a Directory Number

To create a Directory Number:
1. In System Manager, in the Folder Tree panel, select the folder where you want to create the directory number.
2. In the Folder Tree panel, click Resource, and then click Directory Number.
3. Select whether the number is contact center enabled.
4. Complete the remaining fields as described in section 7.10.4 "Directory Number Fields".
5. Click Save.

7.10.3 Deleting a Directory Number
To delete one or more directory numbers:
1. In System Manager, go to the folder containing the directory numbers you want to delete, and view the directory numbers in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the directory numbers to be deleted.
3. Click Delete.
4. In the Delete Directory Numbers dialog box, click OK. The directory numbers will be deleted.

7.10.4 Directory Number Fields
This table shows the tabs and fields available for the Directory Number resource.
For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 100 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 50 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Contact Center Enabled</td>
<td>Determines whether a Device Target must be created on the Unified CCE for this number.</td>
<td>Check box. This check box must be selected for:</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• any directory number added using a separate provisioning system</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• any directory number that will be used by mobile agents (for more information, see Administration Guide for Cisco Unified Contact Center Management Portal).</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Advanced Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Communications Manager</td>
<td>The Cisco Unified Communications Manager to be associated with the Directory Number.</td>
<td>Select from the list of Communications Managers available for the tenant.</td>
<td>Default Communications Manager</td>
<td>Yes</td>
</tr>
<tr>
<td>Route Partition</td>
<td>The group of numbers (such as area codes or internal numbers) that this Directory Number is to be associated with.</td>
<td>Select from list.</td>
<td>Default Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>--------------</td>
<td>-----------</td>
</tr>
<tr>
<td>Automatically Allocate a Number Pattern/Number Pattern</td>
<td>Whether to automatically allocate the number to be used for this Directory Number.</td>
<td>Check box. Either leave box checked or clear to enter number of 1-20 digits manually in the Number Pattern text box.</td>
<td>Checked</td>
<td>Yes</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Directory Number will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the Directory Number should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or clear <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td><strong>Key</strong></td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Value</strong></td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click Add. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (éd) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (ê), then click OK to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.11 Enterprise Skill Groups

#### 7.11.1 About Enterprise Skill Groups

An Enterprise Skill Group is a logical grouping of skill groups joined together for reporting purposes. Enterprise skill groups can include skill groups from different media routing domains.

You can use System Manager to create, edit, and delete enterprise skill groups.
7.11.2 Creating an Enterprise Skill Group

To create an enterprise skill group:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the enterprise skill group.
2. In the Folder Tree panel, click Resource, and then click Enterprise Skill Group.
3. Enter a unique name for the group.
4. Complete the remaining fields as described in section 7.11.5 "Enterprise Skill Group Fields".
5. To assign skill groups to the group, click the Add button below the Skill Groups box and select one or more skill groups.

Note
The Selected Path drop-down at the top allows you to select skill groups from other folders to add to the enterprise skill group.

6. Click Save.

7.11.3 Deleting an Enterprise Skill Group

To delete one or more enterprise skill groups:

1. In System Manager, go to the folder containing the enterprise skill groups you want to delete, and view the enterprise skill groups in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the enterprise skill groups to be deleted.
3. Click Delete.
4. In the Delete Enterprise Skill Groups dialog box, click OK. The enterprise skill groups will be deleted.

7.11.4 Bulk Uploading Enterprise Skill Groups

In addition to creating enterprise skill groups one at a time, you can also bulk load enterprise skill group records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.11.5 Enterprise Skill Group Fields

This table shows the tabs and fields available for the Enterprise Skill Group resource.
For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of this enterprise skill group.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Skill Groups Tab</strong></td>
<td>Skill groups associated with this enterprise skill group.</td>
<td>Select from lower list of available agents and click <strong>Add</strong> to include the checked agents in this agent team. To remove existing agents from this agent team, select from upper list and click <strong>Remove</strong>.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name by which the Enterprise Skill Group will be known within the system.</td>
<td>Unique. Up to 32 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Auto generated</td>
<td>No</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
</tbody>
</table>
### Field Description Entry Default Required

**Active From Date**  
The date from which the Enterprise Skill Group should be active in the system.  
Select date from calendar.  
Current date  
No

**Active To Date**  
The date from which the Enterprise Skill Group should be deleted from the system.  
Either leave *Forever* checked, or uncheck *Forever* and select date f from calendar.  
Forever  
No

**Custom Data Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click Add. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (✓) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (✗), then click OK to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.12 Expanded Call Variables

#### 7.12.1 About Expanded Call Variables

An expanded call variable (ECC) is a named object which is used by a VRU script to exchange call information with the Unified CCE.

You can use System Manager to create and delete expanded call variables.
7.12.2 Creating an Expanded Call Variable

To create an expanded call variable:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the expanded call variable.
2. In the Folder Tree panel, click Resource, and then click Expanded Call Variable.
3. Complete the remaining fields as described in section 7.12.4 "Expanded Call Variable Fields". Active from and to dates can be set in the Advanced tab.
4. Click Save.

7.12.3 Deleting an Expanded Call Variable

To delete one or more expanded call variables:

1. In System Manager, go to the folder containing the expanded call variables you want to delete, and view the expanded call variables in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the expanded call variables to be deleted.
3. Click Delete.
4. In the Delete Expanded Call Variables dialog box, click OK. The expanded call variables will be deleted.

7.12.4 Expanded Call Variable Fields

This table shows the tabs and fields available for the Expanded Call Variable resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the call variable</td>
<td>Unique. Up to 27 characters, letters, numbers, and underscore characters only. Must begin with letter or number. Will be automatically prefixed with 'user.' by the system.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the call variable</td>
<td>Up to 255 characters</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Maximum Length</td>
<td>The maximum length of the value of the call variable</td>
<td>A whole number between 1 and 210.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Provided by Cisco</td>
<td>Whether the call variable provided by Cisco. This is normally determined by the system.</td>
<td>Check box.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Persistent</td>
<td>Whether the variable is written to the historical database with the TCD/RCD record</td>
<td>Check box.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Enabled</td>
<td>Whether the call variable is currently enabled</td>
<td>Check box.</td>
<td>Checked</td>
<td>No</td>
</tr>
<tr>
<td>ECC Array</td>
<td>Whether the variable is an array</td>
<td>Check box.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required?</td>
</tr>
<tr>
<td>---------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Maximum Array Size</td>
<td>The maximum size of elements in the array represented by the call variable</td>
<td>Up to 255. The equation <code>&lt;Maximum Length&gt; * &lt;Maximum Array Size&gt; + &lt;Maximum Array Size&gt; + 5</code> must not exceed 299. For example, if the Maximum Length was 97, the array size could not exceed 3.</td>
<td>Null</td>
<td>If ECC Array checked</td>
</tr>
</tbody>
</table>

**Advanced Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active From Date</td>
<td>The date from which the variable will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>No</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the variable should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Custom Data Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required?</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon ( ) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon ( ), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes.</td>
</tr>
</tbody>
</table>
7.13 IP Phones

7.13.1 About IP Phones
A IP phone (or telephone) is the IP device that the contact center agent uses to make or receive calls. The IP phone has a single line (typically line 1 if using a Cisco multi-line phone), whose number is known to the call routing software. The agent logs into the contact center using the login name and password allocated by the Manage Agent page and the line number allocated in this page. Line numbers may be allocated automatically by Unified CCMP or entered manually through the user interface.

You can use System Manager to create, edit, and delete IP Phones.

7.13.2 Creating an IP Phone
To create an IP Phone:
1. In System Manager, in the Folder Tree panel, select the folder where you want to create the IP phone.
2. In the Folder Tree panel, click Resource, and then click IP Phone.
3. Select the phone type from the drop-down.
4. Complete the remaining fields as described in section 7.13.4 "IP Phone Fields".
5. Optionally add directory numbers by checking the boxes of numbers to add and clicking Add.
6. Click Save.

7.13.3 Deleting an IP Phone
To delete one or more IP phones:
1. In System Manager, go to the folder containing the IP phones you want to delete, and view the IP phones in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the IP phones to be deleted.
3. Click Delete.
4. In the Delete IP Phones dialog box, click OK. The IP phones will be deleted.

7.13.4 IP Phone Fields
This table shows the tabs and fields available for the IP Phone resource.
For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 100 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the record.</td>
<td>Up to 128 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Communications Manager</td>
<td>The Communications Manager to be associated with the IP Phone.</td>
<td>Select from the list of Communications Managers available for the tenant.</td>
<td>Default Communications Manager</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The Peripheral to be associated with the IP Phone.</td>
<td>Select from the list of Peripherals associated with the selected Unified CM.</td>
<td>Default Peripheral</td>
<td>No</td>
</tr>
<tr>
<td>Product</td>
<td>Type of Telephone</td>
<td>Select from list.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Protocol</td>
<td>The type of protocol the telephone should use for communication.</td>
<td>Select from list.</td>
<td>Depends on product.</td>
<td>Yes</td>
</tr>
<tr>
<td>Template</td>
<td>The XML template to be used to configure the IP Phone.</td>
<td>Select from list of templates available for the specific phone model.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>Button Template</td>
<td>The configuration to use for the buttons</td>
<td>Select from list of button templates set up.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>MAC Address</td>
<td>The MAC Address of the IP phone used to uniquely identify it.</td>
<td>12-digit hexadecimal number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Extension Mobility</td>
<td>Used to configure the Extension Mobility service on the phone. When selected, users may log on to the phone using their associated device profile.</td>
<td>Check box.</td>
<td>Depends on template selected.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Directory Numbers Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory Numbers</td>
<td>The lines to be associated with the IP Phone.</td>
<td>To associate a directory number with this IP phone, select a directory number from the lower list of available directory numbers and click <strong>Add</strong>. To remove a directory number association from this IP phone, select the directory number from the upper list and click <strong>Remove</strong>.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Index</td>
<td>The port on the IP Phone that the line is plugged into.</td>
<td>Number.</td>
<td>Next in sequence.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Advanced Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Pool</td>
<td>A pool of phones that have similar character.</td>
<td>Select from the list of Device Pools available to the logged in user.</td>
<td>Default Device Pool</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the IP Phone will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the IP Phone should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or clear <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Custom Data Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click Add. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (✍️) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (🗑️), then click OK to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

### 7.13.5  More About IP Phones

#### 7.13.5.1  Using Unified CCMP with Other Provisioning Systems

When using a separate provisioning system to add IP phones to a Unified CM, check the **Contact Center Enabled** check box for all the Directory Numbers provisioned by the external system to ensure that they are added correctly to Unified CCE. Do not use Unified CCMP to make any other changes to phones on that Unified CM.
7.13.5.2 **Advanced Information**

The Unified CCMP web application automatically links or adds default additional information to Unified CCE as follows:

- Links the Unified CM *calling search space* from the tenant owning folder
- Links the Unified CM *route partition* from the tenant owning folder
- Links the Unified CM *location* from the parent folder
- Links the Unified CM *owner user ID* from the PG user id allocated to the tenant
- Creates a Unified CCE *device target* for the phone/line.
- Creates a Unified CCE *label* for each combination of *device target* and routing client (to route calls to a Unified CCE agent, you must have defined a *label* associated with the *device target*).

7.14 **IVR Apps**

7.14.1 **About IVR Apps**

A IVR App is a voice XML (VXML) application that runs on a CVP IVR app server and is used to control call routing. IVR apps can be created using Cisco Call Studio.

Unified CCMP allows you to upload an existing IVR app to a CVP IVR app server and to edit the IVR app details.

IVR apps are uploaded as zip files that contain the various application components. One zip file can contain more than one IVR app.

7.14.2 **Creating an IVR App**

**Note**

This process creates a Unified CCMP IVR app resource and uploads the associated IVR app file to an IVR app server. The IVR app file must already exist and be formatted as a .zip file. The IVR app file may contain more than one IVR app, and if so, multiple Unified CCMP IVR app resources will be created.

To create (upload) an IVR app:

1. In **System Manager**, in the Folder Tree panel, select the folder where you want to create the IVR app resource. This folder must be located on a tenant that has a remote equipment mapping to a CVP Operations Console.
2. In the Folder Tree panel, click Resource, and then click IVR App. If the IVR App option is not available, then check that the selected folder is on a tenant that is mapped to a CVP Operations Console.

3. If you want to change the location in the Unified CCMP folder tree where the IVR app will be created, click the drop-down arrow beside Path and select the new location.

4. Select the IVR app server or servers where you want the IVR app to be uploaded to.

5. Click Add Files (may appear as Browse in some older browsers), select a .zip file containing one or more IVR apps to be uploaded and click Open. The selected file is added to the list of files to be uploaded. You can click Add Files (or Browse) again to add more files if required, or Cancel to remove a file from the list to be uploaded.

6. Click Save to upload the files to the selected IVR app servers. As each file is uploaded, you will see the upload status.

7. If an upload succeeds, the file is unzipped and each IVR app in the file is copied to the IVR app server. The corresponding resources or resources (one for each IVR app in the file) will be imported into Unified CCMP in the next import cycle. If an upload fails, you can rest the mouse briefly on the upload status to see more information.

7.14.3 Editing an IVR App

To edit an IVR app:

1. In System Manager, go to the folder containing the IVR app you want to edit, and view the IVR apps in that folder using the Items panel list view.

   Note
   IVR apps can only exist on tenants that have a remote equipment mapping to a CVP Operations Console.

2. In the Items panel, click on the IVR app you want to edit. The details of this IVR app are displayed in the Details panel.

3. Make your required changes, then click Save.

7.14.4 Deleting an IVR App

1. In System Manager, go to the folder containing the IVR apps you want to delete, and view the IVR apps in that folder using the Items panel list view.

2. In the Items panel, select the check boxes beside the IVR app or apps to be deleted.
3. Click Delete.
4. In the confirmation dialog box, click OK. The selected IVR apps will be deleted.

**7.14.5 IVR App Fields**

This table shows the tabs and fields available for the IVR app resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique enterprise name for the record.</td>
<td>Unique. Up to 100 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the IVR app.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

**7.15 Labels**

**7.15.1 About Labels**

In Unified CCE the label represents a string that is passed to a routing client for each network target. Unified CCMP will automatically create labels for many high level operations but the functionality is included for specific label creation such as blind transfers. The only label type supported will be type Normal, the only network target is device target.

You can use System Manager to create, edit, and delete labels.

**7.15.2 Creating a Label**

To create a label:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the label.
2. In the Folder Tree panel, click Resource, and then click Label.
3. Enter a unique name of up to 32 characters for the label. This can only contain alphanumeric characters, periods and underscores.
4. Complete the remaining fields as described in section 7.15.5 "Label Fields".
5. Click Save.
7.15.3 Deleting a Label

To delete one or more labels:

1. In System Manager, go to the folder containing the labels you want to delete, and view the labels in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the labels to be deleted.
3. Click Delete.
4. In the Delete Labels dialog box, click OK. The labels will be deleted.

7.15.4 Bulk Uploading Labels

In addition to creating labels one at a time, you can also bulk load label records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.15.5 Label Fields

This table shows the tabs and fields available for the Label resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Label</td>
<td>The string value used to identify the label by the routing client</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Routing Client</td>
<td>The enterprise name of the routing client associated with this label</td>
<td>Select from the supplied list of routing clients that the logged in user has the security permissions to see.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Dialed Numbers Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dialed Numbers</td>
<td>The Dialed Numbers to associate with this label</td>
<td>Select from lower list of available dialed numbers and click <strong>Add</strong> to associate the checked dialed numbers with this label. To remove a dialed number association from this label, select from upper list and click <strong>Remove</strong>.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which this label should be active within the system</td>
<td>Select date from calendar.</td>
<td>Current</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which this label should be deleted from the system</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td><strong>Custom Data Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon ( ✂️) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon ( ❌), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Note
The Self Care tab is only shown for existing resources. It is not shown when the resource is first created.

7.16 Media Files

7.16.1 About Media Files
A Media File is a .wav file that is used by IVR to play back prompts and messages to callers. Media files are stored on CVP media servers.

Unified CCMP allows you to upload media files to CVP media servers in the Unified CCMP cluster, and to change the audio associated with an existing media files.

7.16.2 Creating a Media File
To create (upload) a media file:
1. In System Manager, in the Folder Tree panel, select the folder where you want to create the media file resource. This folder must be located on a tenant that has a remote equipment mapping to a CVP Operations Console.
2. In the Folder Tree panel, click Resource, and then click Media File. If the Media File option is not available, then check that the selected folder is on a tenant that is mapped to a CVP Operations Console.
3. If you want to change the location in the Unified CCMP folder tree where the media file will be created, click the drop-down arrow beside Path and select the new location.
4. Select the media file server or servers where you want to the media file to be uploaded to.
5. In the Remote Path field, specify the location where the files are be uploaded to. This is a folder location on the media file server. You may include "/" characters to denote subfolders. If the folder does not exist, it will be created. Note that Unified CCMP does not validate this field, and if it is invalid, the upload will fail.
6. Click Add Files (may appear as Browse in some older browsers), select a .wav media file and click Open. The selected file is added to the list of files to be uploaded. You can click Add Files (or Browse) again to add more files if required, or Cancel to remove a file from the list to be uploaded.
7. Click **Save** to upload the media files to the specified location on the selected media file servers. As each media file is uploaded, you will see the upload status.

8. If an upload succeeds, the media file resource is available immediately in Unified CCMP and on the CVP server. If an upload fails, you can rest the mouse briefly on the upload status to see more information.

### 7.16.3 Editing a Media File

To edit a media file:

1. In **System Manager**, go to the folder containing the media file you want to edit, and view the media files in that folder using the Items panel list view.

   **Note**
   Media files can only exist on tenants that have a remote equipment mapping to a CVP Operations Console.

2. In the Items panel, click on the media file you want to edit. The details of this media file are displayed in the Details panel.

3. To change the name of the media file resource in Unified CCMP, in the **Details** tab, enter the new name in the **Name** field. You can view the Remote Path but cannot change it.

4. To change the media file associated with this resource, in the **Media** tab, click the drop-down by **Servers** and select the server or servers you want to upload the new media file to. Then click **Add Files** (may appear as **Browse** in some older browsers), locate the media file to upload, and click **Open**.

5. Click **Save** to replace the existing media file with the new one. After the upload completes, you will see the upload status.

6. If an upload fails, you can rest the mouse briefly on the upload status to see more information.

### 7.16.4 Deleting a Media File

To delete one or more media files:

1. In **System Manager**, go to the folder containing the media files you want to delete, and view the media files in that folder using the Items panel list view.

2. In the Items panel, select the check boxes beside the media file or files to be deleted.

3. Click **Delete**.
4. In the confirmation dialog box, click **OK**. The selected media files will be deleted.

### 7.16.5 Media File Fields

This table shows the tabs and fields available for the Media File resource. These fields are available when the Media File is edited.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique enterprise name for the record.</td>
<td>Unique. Up to 100 characters.</td>
<td>The name of the uploaded media file.</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the media file.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Remote Path</td>
<td>The path on the media file server where the media file is stored.</td>
<td>Read only.</td>
<td>The remote location of the uploaded media file.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

| **Media Tab** |                                                  |                                |                                              |          |
| Servers       | The media file server or servers where the new media file is be uploaded to. | Select the media file server or servers from the list. | None | Yes |
| New audio file | The new media file to upload.                     | Click **Add Files** (or **Browse**), select a media file to be uploaded and click **Open**. | None | Yes |
digits). One or more Network VRU scripts may be called by a Unified ICME routing script to handle the interaction with the caller and hence route the call appropriately.

You can use System Manager to create, edit, and delete Network VRU Scripts.

7.17.1.1 Micro-Applications

Network VRU Scripts invoke Unified CVP micro-applications which are used to provide prompts, collect user responses and play .wav files while callers are queuing. Network VRU Scripts can invoke the following micro-applications.

- **Play Media (PM)**: plays a message that is contained in a media file or streaming audio file. This may be used, for example, to play a welcome message, or to play music while the caller is in a queue.

- **Play Data (PD)**: retrieves data from a storage area and plays it to the caller in a specific format, called a data play back type. This data may be, for example, information retrieved from a database, or information entered by the caller.

- **Get Digits (GD)**: plays a media file and retrieves one or more digits from the caller. For example, this micro-application may be used to prompt a caller to enter a password.

- **Menu (M)**: plays a menu media file and retrieves a single digit from the caller. This is similar to the Get Digits micro-application, but it only accepts a single digit, and also checks that it is valid. This micro-application may be used, for example, to offer the caller several options in a menu, and retrieve the option chosen by the caller.

- **Get Speech (GS)**: collects voice or tone dialing (DTMF) input from the caller. This micro-application may be used, for example, to retrieve a spoken "Yes" or "No" response from the caller or to detect that the caller has pressed the # key.

- **Capture (CAP)**: captures and stores data about the call at that point in the routing script. The data collected can be used for analysis purposes.

**Note**

Use the Capture micro-application sparingly. It places a heavy processing load on the system, and may capture a lot of data that is not required along with data that is useful. Overuse of the Capture micro-application may reduce the call handling capability of the system.

7.17.1.2 Network VRU Script Configuration

To define the Network VRU Script configuration you need to specify:
- **the VRU script name**, a composite string containing the micro-application to run, the associated media file (if required by the micro-application) and any parameters required by the micro-application. The value specified for the VRU script name is used to derive the name to be used for the media file when it is uploaded.

- **the configuration parameters** to be passed to the Network VRU Script when it runs. This is a string, and the format depends on the micro-application specified.

- **the audio file** to upload and associate with the Network VRU Script (where applicable). When the audio file is uploaded, it will be named with the media file name specified in the VRU script name string. If you specify an incorrectly formatted VRU script name string, you will not be able to upload the audio file.

**Note**
The audio file cannot be specified when the Network VRU Script is first created. You must first create the Network VRU Script item, then edit it to specify the audio file.

For more information about the Unified CVP micro-applications, the corresponding VRU script name strings and the configuration parameters, see the *Configuration and Administration Guide for Cisco Unified Customer Voice Portal*, section "Writing scripts for Unified CVP".

### 7.17.2 Creating a Network VRU Script

To create a Network VRU Script:

1. In **System Manager**, in the Folder Tree panel, select the folder where you want to create the Network VRU Script.

2. In the Folder Tree panel, click **Resource**, and then click **Network Vru Script**.

3. Enter a unique name of up to 32 characters for the Network VRU Script. This can only contain alphanumeric characters, periods and underscores.

4. Complete the remaining fields as described in section 7.17.7 "Network VRU Script Fields". You will not be able to upload an audio file when you first create the Network VRU Script.

5. Click **Save**.

### 7.17.3 Associating an Audio File with a Network VRU Script

To set or change the audio file associated with a Network VRU script:
1. In System Manager, go to the folder containing the Network VRU script you want to edit, and view the Network VRU scripts in that folder using the Items panel list view.

2. In the Items panel, click on the Network VRU script you want to edit. The details of this script are displayed in the Details panel.

3. Select the Audio tab and click Add Files(s) (may appear as Browse in some older browsers). Go to the folder on your machine where the audio file is stored, select the audio file and click Open.

4. Click Save to upload the .wav file and save any other changes to the Network VRU Script.

Notes
1. If Save is not enabled, then either the VRU script name specified on the Details tab is incorrectly formatted or the associated micro-application does not require an audio file.

2. The audio file will be saved under the name specified for the media file in the VRU script name field, and will replace any previous audio file.

3. If an upload error is reported, contact your system administrator to ensure that Unified CVP Media File Upload has been correctly configured on your system (see the Installation and Configuration Guide for Cisco Unified Contact Center Management Portal for more details).

7.17.4 Editing a Network VRU Script

To edit a Network VRU Script:

1. In System Manager, go to the folder containing the Network VRU Script you want to edit, and view the Network VRU Scripts in that folder using the Items panel list view.

2. In the Items panel, click on the Network VRU Script you want to edit. The details for this Network VRU Script are displayed in the Details panel.

3. In the Details panel, click on the appropriate tab and make the desired changes.

4. If you want to add or change the audio file associated with this Network VRU Script, select the Audio tab and click Add Files(s) (may appear as Browse in some older browsers). Go to the folder on your machine where the audio file is stored, select the audio file and click Open.

5. Click Save.
Notes
1. If Save is not enabled, then either the VRU script name specified on the Details tab is incorrectly formatted or the associated micro-application does not require an audio file.
2. If you change the audio file, it will be saved under the name specified for the media file in the VRU script name field, and will replace any previous audio file.
3. If an upload error is reported when you try to change the audio file, contact your system administrator to ensure that Unified CVP Media File Upload has been correctly configured on your system (see the Installation and Configuration Guide for Cisco Unified Contact Center Management Portal for more details).

7.17.5 Deleting a Network VRU Script
To delete one or more Network VRU Scripts:
1. In System Manager, go to the folder containing the Network VRU Scripts you want to delete, and view the Network VRU Scripts in that folder using the Items panel list view.
2. In the Items panel, select the Network VRU Scripts to be deleted.
3. Click Delete.
4. In the Delete Network VRU Script dialog box, click OK. The selected Network VRU Scripts will be deleted.

7.17.6 Bulk Uploading Network VRU Scripts
In addition to creating Network VRU Scripts one at a time, you can also bulk load Network VRU Script records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.17.7 Network VRU Script Fields
This table shows the tabs and fields available for the Network VRUScript resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Network VRU</td>
<td>The network VRU to associate with this Network VRU Script.</td>
<td>Select from list of available Network VRUs. If you do not have permission to access at least one Network VRU then you will not be able to create a Network VRU Script and will see a warning message instead.</td>
<td>Default Network VRU</td>
<td>Yes</td>
</tr>
<tr>
<td>VRU Script Name</td>
<td>The name of the VRU Script.</td>
<td>Up to 39 characters. This is a composite string identifying the micro-application to run, the name of the associated media file (if applicable) and any options that need to be specified for that micro-application. The format of this string is specified in the Configuration and Administration Guide for Cisco Unified Customer Voice Portal, section &quot;Writing scripts for Unified CVP&quot;. The VRU Script name must be unique on the Network VRU.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>--------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Configuration Parameter</td>
<td>A string to be passed to the Network VRU when the script runs to specify static options in the script. The contents of this string depend on the micro-application that is specified as part of the VRU Script Name field above. The format of this string is specified in the Configuration and Administration Guide for Cisco Unified Customer Voice Portal, section &quot;Writing scripts for Unified CVP&quot;.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Timeout</td>
<td>The number of seconds to wait for a response after the script starts executing.</td>
<td>0 to 2147483647.</td>
<td>0</td>
<td>Yes</td>
</tr>
<tr>
<td>Interruptible</td>
<td>Whether the execution of the script can be interrupted.</td>
<td>Check box. Select if the script execution can be interrupted, for example, when an agent becomes free to handle a call.</td>
<td>Unselected</td>
<td>No</td>
</tr>
<tr>
<td>Overridable</td>
<td>Whether the script can override the interruptible status during execution.</td>
<td>Check box. Select if the script is allowed to make itself interruptible or non-interruptible while executing.</td>
<td>Unselected</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Audio Tab (not available when item is first created)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>New Audio File</td>
<td>The file information of the audio file to associate with the VRU script.</td>
<td>Click <strong>Add Files(s)</strong> (or <strong>Browse</strong>), and locate the required <strong>wav</strong> file on your system. Click <strong>Save</strong> to upload the wav file to the server.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
<td>------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the Network VRU Script within the network.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>From Name</td>
<td>Yes</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Network VRU Script will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the Network VRU Script should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-----------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Custom Data Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null.</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon ( ⚙ ) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon ( ⚝ ), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**7.18 Peripherals**

**7.18.1 About Peripherals**

A peripheral is a connected system such as an ACD switch that routes customer phone calls to contact center staff.

You can use System Manager to view and edit the properties of a peripheral.

**Note**

Unified CCMP only allows you to view the peripheral details, change the display name and the application user associated with it. You cannot create or delete a peripheral through Unified CCMP, or edit any other fields.
7.18.2 Editing a Peripheral

Use the following steps to edit a peripheral.

1. In System Manager, go to the folder containing the peripheral you want to edit, and view the peripherals in that folder using the Items panel list view.

2. In the Items panel, click on the peripheral you want to edit. The details of this peripheral are displayed in the Details panel.

3. In the Details panel, click on the appropriate tab and make the desired changes.

4. Click Save.

7.18.3 Peripheral Fields

This table shows the tabs and fields available for the Peripheral resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique display name for the peripheral.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Name used by Unified CCE.</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An internal description of the peripheral.</td>
<td>You cannot change this value in Unified CCMP.</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the peripheral within the network.</td>
<td>You cannot change this value in Unified CCMP.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Field Description Entry Default Required

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default Application User</th>
<th>Yes</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application User</td>
<td>A user on the Unified CM, with whom new phones will be associated.</td>
<td>Select from list.</td>
<td>Default application user.</td>
<td>Yes</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the peripheral will be active in the system.</td>
<td>You cannot change this value in Unified CCMP.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the peripheral should be deleted from the system.</td>
<td>You cannot change this value in Unified CCMP.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 7.19 Persons

#### 7.19.1 About Persons

Each person item represents a single physical person who handles customer contacts. This person may be associated with a user account on Unified CCMP, or with one or more Agents.

You can use System Manager to create, edit, and delete individual persons, and to define their access to Unified CCMP (if any).

#### 7.19.2 Creating a Person

To create a person:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the person.
2. In the Folder Tree panel, click Resource, and then click Person.
3. Enter a first name, last name, login name and password for the person. Names can be up to 32 characters long, and must consist of letters, numbers, underscores and periods only.
4. On the equipment tab select the Unified CCEs and Unified Communications Managers to which the person should be added, specifying any equipment specific configuration.
5. Complete the remaining fields as described in section 7.19.6 "Person Fields". Active from and to dates can be set in the Advanced tab.
6. Click Save.
7.19.3 Changing a Person's Password

To change a person's password:

1. In System Manager, go to the folder containing the person you want to update, and view the persons in that folder using the Items panel list view.
2. In the Items panel, click on the person you want to edit. The details of this person are displayed in the Details panel.
3. On the Details tab, check the Reset Password check box.
4. Enter a new password and confirm.
5. Click Save.

7.19.4 Deleting a Person

To delete one or more persons:

1. In System Manager, go to the folder containing the person or persons you want to update, and view the persons in that folder using the Items panel list view.
2. In the Items panel check the box or boxes of the person or persons to be deleted.
3. Click Delete.
4. In the Delete Person dialog box, select OK. The person or persons will be deleted.

Note
All agents associated with those persons will also be deleted.

7.19.5 Bulk Uploading Persons

In addition to creating agents one at a time, you can also bulk load agent records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.19.6 Person Fields

This table shows the tabs and fields available for the Person resource.
For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

Notes
To associate a person with more than one Agent, each Agent must be on a different peripheral.

Persons may be created on multiple pieces of equipment. Common properties are inherited from those entered on the Details tab unless specifically over-written using the Equipment tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Reset Details on All Equipment</td>
<td>Only shown (with informational message) if person details are not the same on all items of linked equipment. If shown, but not selected, First Name, Last Name, Description and Login Name fields are disabled, as there is no common value to show. <strong>Note:</strong> This is not an error, although you may want to change this.</td>
<td>Select to enable First Name, Last Name, Description and Login Name fields. Enter the required values then click Save. This allows you to quickly reset the details for all linked equipment to the details on this page.</td>
<td>Clear</td>
<td>No</td>
</tr>
<tr>
<td>First Name</td>
<td>The person's first name. Disabled if Reset check box is shown but not selected.</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Last Name</td>
<td>The person's last name. Disabled if Reset check box is shown but not selected.</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the person. Disabled if Reset check box is shown but not selected.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>-------------------------------------------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
<tr>
<td>Login Name</td>
<td>A unique login name for the person to allow them to login to the peripheral. Disabled if Reset check box is shown but not selected. Note: Peripheral login names are not case sensitive. For example, &quot;joe_smith&quot; and &quot;JOE_SMITH&quot; are the same. Also, login names for agent login to agent desktop software (such as CTI OS) are not case-sensitive either.</td>
<td>Unique. Up to 32 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Password</td>
<td>The password that the person uses to log in to the system.</td>
<td>Unique. At least five letters long. Longer passwords, including numbers and other characters, may be required. Ask your system administrator for details.</td>
<td>Null</td>
<td>Depends on setting on underlying equipment</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>The same as for the Password field. This ensures that the person is not prevented from logging in by typographical errors made when setting his or her password.</td>
<td>Null</td>
<td>Depends on setting on underlying equipment</td>
<td></td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Equipment Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Unified CCE</td>
<td>Check this box to create the associated person onto an associated Unified CCE. Once selected you must choose the Unified CCE to add the person to.</td>
<td>Check box to select, and then check the required Unified CCE equipment. Click on the icon to edit the login details for the equipment.</td>
<td>Checked</td>
<td>No</td>
</tr>
<tr>
<td>Unified Communications Manager</td>
<td>Check this box to create the associated person onto an associated Unified Communications Manager. Once selected you must choose the Unified Communications Managers to add the person to.</td>
<td>Check box to select, and then check the required Unified Communications Manager equipment. Click on the icon to edit the login details for the equipment.</td>
<td>Unchecked</td>
<td>No</td>
</tr>
</tbody>
</table>

<p>| <strong>Equipment Tab &gt; Equipment Fields Dialog Box</strong> | | | | |
| First Name                     | Person's first name on this equipment.                                     | Up to 32 characters.                                                  | Same as First Name of Person | Yes      |
| Last Name                      | Person's last name on this equipment.                                      | Up to 32 characters.                                                  | Same as Last Name of Person  | Yes      |
| Description (UCCE Equipment only) | A description of the person.                                              | Up to 255 characters.                                                | Same as Description of Person | No       |
| Login Name                     | Person's login name on this equipment.                                     | Unique. Up to 32 characters, letters, numbers, and underscore characters only. Must begin with letter or number. | Same as Login Name of Person | Yes      |
| Reset Password (UCCE only)     | Select to reset password on this equipment.                               |                                                                      | Clear   | No       |
| Login Enabled (UCCE only)      | Select to enable login on this equipment.                                 |                                                                      | Clear   | No       |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Portal Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Portal Account</td>
<td>Click this link to show the Choose a User dialog box which can be used to associate the person with a Portal user account. It is advantageous for supervisors to have a Portal account in order to manage their teams.</td>
<td>Hyperlink</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td><strong>Portal Tab &gt; Choose a User dialog box</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Choose a User</td>
<td>The kind of user to associate the person with. Options are: <strong>None</strong>: no user is associated with this person. <strong>Create User</strong>: a new user is associated with this person. <strong>Existing User</strong>: an existing user is associated with this person.</td>
<td>Select one of the options.</td>
<td>None</td>
<td>Yes</td>
</tr>
<tr>
<td>Create User option &gt; Login Name</td>
<td>The unique name of the Portal user account. This can be the same as the login name for WebView reporting, or that for the peripheral.</td>
<td>Unique. Up to 50 characters. Any Unicode character is valid, except single quote ('), double quote (&quot;), and Unicode characters in the &quot;Symbol, Other&quot; category.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Create User option &gt; Password</td>
<td>The password that the user will use to log in to the Portal.</td>
<td>Unique. At least five letters long. Longer passwords, including numbers and other characters, may be required. Ask your system administrator for details.</td>
<td>Null</td>
<td>If creating a new user.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>------------</td>
<td>---------------------------</td>
</tr>
<tr>
<td>Create User option &gt; User’s Groups dialog box</td>
<td>Allows you to assign the user to one or more security groups, such as the Supervisors group. You can only assign a user to groups you have permission to modify.</td>
<td>If required, click Add then select security group from folder tree. Repeat to add user to more groups. Click Save to save details and create user.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Create User option &gt; Confirm Password</td>
<td>The same as for the Password field. This ensures that the user is not prevented from logging in by typographical errors made when setting his or her password.</td>
<td>Enter password confirmation, and then &gt;&gt; to continue to User’s Groups dialog box.</td>
<td>Null</td>
<td>If creating a new user.</td>
</tr>
<tr>
<td>Existing User option</td>
<td>Associates the person to a Portal user account that already exists.</td>
<td>Find and select the user in the folder tree that is displayed. Then click the &gt;&gt; button to continue to User’s Groups dialog box.</td>
<td>None</td>
<td>If selecting an existing user.</td>
</tr>
<tr>
<td>Existing User &gt; User’s Groups dialog box</td>
<td>Allows you to assign the user to one or more security groups, such as the Supervisors group. You can only assign a user to groups you have permission to modify.</td>
<td>If required, click Add then select security group from folder tree. Repeat to add user to more groups. Click Save to save details and amend user’s security groups.</td>
<td>None</td>
<td>No</td>
</tr>
</tbody>
</table>

**Advanced Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the person will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the person should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Custom Data Tab**

| Key              | The key for this custom data item.                                          | Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric. | Null      | No       |
| Value            | The value to associate with this key.                                       | Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click Add. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (=tmp), and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (,tmp), then click OK to confirm the deletion. | Null      | Yes      |
7.20 Precision Queues

7.20.1 About Precision Queues

A precision queue is a mechanism that defines how to route calls to agents depending on the agents’ proficiency attributes and availability. Precision queues can be referenced in routing scripts to define how calls are routed.

You can use System Manager to create, edit and delete precision queues containing one or more precision queue steps.

Note

Precision Queues can only be created on tenants that are associated with a Unified CCE instance running Unified CCE version 9.0 or later.

7.20.1.1 Precision Queue Steps

A precision queue contains one or more precision queue steps. Each step includes:

- some criteria defining a set of agent attributes that must be satisfied when choosing an agent to receive the call
- a time to wait for a suitable agent to become available, after which the criteria specified in the next step are considered instead (this feature is not available for the last step, since there is no next step after the last step).

Typically, the criteria specified in successive steps will get progressively less stringent. For example, the first step may specify that:

- the agent has been trained to sell mortgages (for example, Mortgage_Training is True)
- the agent is an excellent Spanish speaker (for example, Spanish_Speaker >= 8)
- the call will be held for up to 120 seconds waiting for an agent meeting these criteria to become available.

The next step is only considered if no agent becomes available in that time, and may specify that

- the agent has been trained to sell mortgages (for example, Mortgage_Training is True)
- the agent can speak Spanish (for example, Spanish_Speaker >= 3)
- the call will be held for up to 300 seconds waiting for an agent meeting these criteria to become available.
The final step may specify that the call can be routed to any available agent who can speak Spanish at any level (for example, Spanish_Speaker >= 1).

7.20.1.2 Consider If Conditions

Any step except the last step can have a Consider If condition associated with it. A Consider If condition allows you to specify additional criteria about the call to determine whether the step is relevant for that category of call.

For example, a Consider If expression may be used to include a specific step only if more than 100 calls of a certain type have been received in the last 24 hours.

The Consider If expression is passed directly to Unified CCE and validated there. For more information about Consider If expressions, see the Unified CCE documentation at [http://docwiki.cisco.com/wiki/Precision_Routing_Release_9.0](http://docwiki.cisco.com/wiki/Precision_Routing_Release_9.0(1))

7.20.1.3 Expressions

Each step consists of:
- one or more expressions
- the rules for combining those expressions.

An expression defines a set of requirements an agent must satisfy in order to receive the call. Expressions in a step can be combined using AND (both the latest expression and the previous one must be satisfied) or OR (either the latest expression or the previous one, or both, must be satisfied).

For example, a step may have two expressions, one specifying some skills an agent may have, and the other specifying some qualifications an agent may have. If these two expressions are combined in a step using AND, calls will only be routed to agents that have both the specified skills and the specified training. But if the expressions are combined using OR, calls can be routed to agents with either the skills or the training or both.

7.20.1.4 Attribute Comparisons

Each expression consists of:
- one or more attribute comparisons
- the rules for combining those attribute comparisons.

An attribute comparison is an attribute (see section 7.5.1 "About Attributes"), a value and a rule for the comparison. Some typical attribute comparisons are:
- Spanish_Speaker >= 8
- Mortgage_Training = True.

Like expressions in a step, attributes in an expression can be combined using AND or OR.
Tip
To keep your steps and expressions simple, you may like to:
- group your attribute comparisons into expressions using AND (for example, an expression is made up of attribute1 AND attribute2 AND attribute3)
- group your expressions into steps using OR (for example, a step is made up of expression1 OR expression2 OR expression3)

7.20.2 Creating a Precision Queue
To create a precision queue:
1. In System Manager, in the Folder Tree panel, select the folder where you want to create the precision queue.
2. In the Folder Tree panel, click Resource, and then click Precision Queue.
3. Enter a unique name for the precision queue.
4. Complete the remaining fields as described in section 7.20.6 "Precision Queue Fields".
5. Click Save to create the precision queue.

7.20.3 Editing a Precision Queue
To edit a precision queue:
1. In System Manager, go to the folder containing the precision queue you want to edit, and view the precision queue in that folder using the Items panel list view.
2. In the Items panel, click on the precision queue you want to edit. The details of this attribute are displayed in the Details panel.
3. Click through the tabs and edit the fields you want to change.
4. Click Save.

7.20.4 Deleting a Precision Queue
Note
You cannot delete a precision queue that is referenced in a routing script. This reference must be removed before the precision queue can be deleted.

To delete one or more precision queues:
1. In **System Manager**, go to the folder containing the precision queues you want to delete, and view the precision queues in that folder using the Items panel list view.

2. In the Items panel, check the box or boxes of the precision queues to be deleted.

3. Click **Delete**.

4. In the Delete Precision Queue dialog box, click **OK**. The precision queue will be deleted.

### 7.20.5 Bulk Uploading Precision Queues

In addition to creating Precision Queues one at a time, you can also bulk load Precision Queue records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

### 7.20.6 Precision Queue Fields

This table shows the tabs and fields available for the Precision Queue resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the precision queue.</td>
<td>Unique. Up to 50 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the precision queue.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------------------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Agent Order</td>
<td>The agent to allocate to a call if more than one agent satisfies the criteria in the precision queue.</td>
<td>Select from list. Values are:</td>
<td>Longest Available Agent</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Longest Available Agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Most Skilled Agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Least Skilled Agent</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Level Type</td>
<td>Optionally, use to indicate how to handle abandoned calls in service level calculations.</td>
<td>Select from:</td>
<td>Ignore Abandoned Calls</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Ignore Abandoned Calls: do not include abandoned calls in the calculation</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Abandoned Calls have Negative Impact: abandoned calls count as having exceeded the service level threshold.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Abandoned Calls have Positive Impact: abandoned calls count as having been promptly answered</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Level Threshold</td>
<td>The service level threshold, in seconds, for allocating the call to a suitable agent using the rules in the precision queue.</td>
<td>0 to 2147483647.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Add Step</td>
<td>Button to add a new precision step to the precision queue. A step consists of one or more conditional expressions.</td>
<td>Click to add another step to the list of steps. You can also change the order of steps by clicking on a step name and dragging the step to a new position in the list. <strong>Note:</strong> if you rearrange the steps, the steps in the sequence are renumbered starting with Step 1.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Wait Time</td>
<td>The time in seconds to wait before moving on to the next step if the criteria in this step cannot be satisfied.</td>
<td>0 to 2147483647. <strong>Note:</strong> Not applicable to last step in sequence. <strong>Note:</strong> If the steps are reordered as above, and the last step changes, the wait time is removed from the new last step, and the old last step is given a wait time of 0.</td>
<td>0</td>
<td>Yes, if precision queue has more than one step.</td>
</tr>
<tr>
<td>Step&lt;n&gt;</td>
<td>The name and definition of the nth step in the list.</td>
<td>The definition shows the details of the step and the number of agents that currently meet the criteria for that step. A warning is shown if fewer agents meet the criteria for a step than met the criteria for the previous step. Click on the name of a step to display a dialog box to edit the conditional expressions in that step. When you have finished editing the expressions in that step, click <strong>OK</strong> to save the step.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Consider If  | Criteria that determines whether the step is executed                       | Optionally, enter a scripting condition that will be evaluated to determine whether this step is considered for the call. If the condition is present but not satisfied by the call, the call passes to the next step in the precision queue. The scripting condition is validated by the remote equipment. Only the following scripting objects are valid in a Consider If expression:  
  - Call  
  - PQ  
  - Skillgroup  
  - ECC  
  - PQ Step  
  - Call Type  
  - custom functions. For more information about Consider If expressions, see [http://docwiki.cisco.com/wiki/Precision_Routing_Release_9.0(1)](http://docwiki.cisco.com/wiki/Precision_Routing_Release_9.0(1)). | Null    | No       |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
</table>
| Add Expression | Button to add a new expression to the precision step. An expression consists of one or more attribute comparisons. | Create an expression containing one or more attribute comparisons. The first attribute comparison is ready to complete. Click **Add Attribute** to optionally add more attribute comparisons. For each attribute comparison, complete the fields as described for Add Attribute. For each expression except the first, also click on the drop down beside the expression number to choose how this expression contributes to the results of the step:  
  - **AND** – the step will be satisfied if an agent is found that satisfies this expression and also satisfies the previous expressions in the step  
  - **OR** (default) – the step will be satisfied if an agent is found that satisfies this expression even if that agent does not satisfy the previous expressions in the step.  
  Click **X** to remove the expression from the step. | Null    | Yes      |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Attribute</td>
<td>Button to add a new attribute comparison to the expression. An attribute comparison consists of an attribute, a comparison type and a comparison value.</td>
<td>Click to add a new attribute comparison as follows:</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Click in the first box and start typing some characters to see a list of attributes that contain those characters.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Choose the attribute you want from the drop-down list</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Move to the next box and choose the comparison type from the following:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>== : equal to this value</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>!= : not equal to this value</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt; : less than this value</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&lt;= : less than or equal to this value</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt; : greater than this value</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>&gt;= : greater than or equal to this value</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Move to the final box and choose the value you want to compare against.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note.</strong> The last four comparison types above are only valid for proficiency attribute types.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>For each attribute in the expression except the first, also click on the drop down to the left of the attribute to choose how this attribute comparison contributes to the results of the expression:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>AND</strong> (default) – the expression will be satisfied if an agent is found that satisfies this attribute comparison and also satisfies the previous attribute comparisons in the expression</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>OR</strong> – the expression will be satisfied if an agent is found that satisfies this attribute comparison even if that agent does not satisfy the previous attribute comparisons in the expression.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Click X to remove the attribute comparison from the expression.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>----------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the precision queue within the network</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Autogenerate</td>
<td>Yes</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Bucket Interval</td>
<td>The count of Answered or Abandoned calls that are used as intervals for the Call Type</td>
<td>Select from list of available bucket intervals</td>
<td>System Default</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the precision queue should be active in the system</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the precision queue should be deleted from the system</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from the calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Custom Data Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null.</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (✏) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (.btnDelete), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes.</td>
</tr>
</tbody>
</table>

### 7.21 Services

#### 7.21.1 About Services

A service is a particular type of call processing required by the user, which is associated with a specific peripheral. Skill Groups may be associated with one or more services. For example, a Customer Support service might be associated with a Customer Support Skill Group.

You can use System Manager to create, edit, and delete services.

#### 7.21.2 Creating a Service

To create a service:
1. In System Manager, in the Folder Tree panel, select the folder where you want to create the service.

2. In the Folder Tree panel, click Resource, and then click Service.

3. Enter a unique name of up to 32 characters for the service. This can only contain alphanumeric characters, periods and underscores.

4. Complete the remaining fields as described in section 7.21.4 "Service Fields".

5. Click Save.

**7.21.3 Deleting a Service**

To delete one or more services:

1. In System Manager, go to the folder containing the services you want to delete, and view the services in that folder using the Items panel list view.

2. In the Items panel, check the box or boxes of the services to be deleted.

3. Click Delete.

4. In the Delete Services dialog box, click OK. The services will be deleted.

**7.21.4 Service Fields**

This table shows the tabs and fields available for the Service resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique name for the record.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the record.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>------------------------</td>
<td>-------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The peripheral to associate this service with.</td>
<td>Select from drop-down.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral Name</td>
<td>The name to be specified for this service at the peripheral</td>
<td>Up to 32 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Service Level Type</td>
<td>How the service level is calculated</td>
<td>Select from drop-down:</td>
<td>Default</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Default</strong> Use the default specified for the peripheral</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Ignore Abandoned Calls</strong> Do not include abandoned calls in the calculation</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Abandoned Calls have Negative Impact</strong> Abandoned calls count as exceeding</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the service level threshold</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Abandoned Calls have Positive Impact</strong> Abandoned calls count as having</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>been promptly answered</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> For services associated with a Communications Manager, this will</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>always be <strong>Ignore Abandoned Calls</strong>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Service Level Threshold</td>
<td>The acceptable time limit in seconds during which a call should be answered.</td>
<td>0 to 1000000, or blank, to disable service level calculation and</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>force the router to use the service level threshold of the</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>associated MRD peripheral.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skill Groups Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Skill Groups</td>
<td>The Skill Groups to associate with this service</td>
<td>Select from lower list of available skill groups and click <strong>Add</strong></td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>to associate the checked skill groups with this label. To remove a skill</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>group’s association from this service, select from upper list and click</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Remove</strong>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------------</td>
<td>----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the service within the network.</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>From Name</td>
<td>Yes</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Peripheral Number</td>
<td>The number to be specified for this service at the peripheral.</td>
<td>0 to 999999999.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Media Routing Domain</td>
<td>The media routing domain associated with this service.</td>
<td>Select from list.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which this service should be active within the system</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which this service should be deleted from the system</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>---------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Custom Data Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td></td>
<td>To add a new custom data key-value pair, complete both fields, and click Add. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon ( ), and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon ( ), then click OK to confirm the deletion.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### 7.22 Skill Groups

#### 7.22.1 About Skill Groups

A skill group is a collection of agents that share a common set of skills. Agents are assigned one or more skills by associating the agent with the desired skill groups.

Each skill group is associated with a specific media routing domain such as voice, chat, or e-mail. In a multichannel deployment (that is, a Unified CCE deployment that includes non-voice applications like Cisco Collaboration Server or E-Mail Manager), when an agent logs in the agent automatically logs into skill groups associated with that agent within the correct MRD. Then, as a task request for a specific MRD begins script execution, the Agent/IVR Controller considers only the skill groups associated with that specific MRD. This allows one script to be written to handle many MRDs.

You can use System Manager to create, edit, and delete skill groups, and to assign agents to these groups.
**Note**
Unified CCMP does not support "sub-skill groups" - skill groups defined as a subset of a parent group.

### 7.22.2 Creating a Skill Group

To create a skill group:

1. In **System Manager**, in the Folder Tree panel, select the folder where you want to create the skill group.
2. In the Folder Tree panel, click **Resource**, and then click **Skill Group**.
3. Enter a unique name for the group.
4. Complete the remaining fields as described in section 7.22.6 "Skill Group Fields".
5. To assign agents to the skill group, on the Agents tab, check the boxes of one or more agents, and click on **Add** above the list.

**Note**
The Selected Path drop-down at the top allows you to select agents from other folders to add to the skill group.

6. To create a route and assign it to the skill group, on the Routes tab, specify the name of the route, and an optional description, then click **Add**. A new route will be created and associated with the skill group when the skill group is saved.

7. Click **Save**.

### 7.22.3 Editing a Skill Group

To edit a skill group:

1. In **System Manager**, go to the folder containing the skill group you want to edit, and view the skill groups in that folder using the Items panel list view.
2. In the Items panel, click on the skill group you want to edit. The details of this skill group are displayed in the Details panel.
3. Click through the tabs and edit the fields you want to change.
4. To remove agents from a skill group, click on the **Agents** tab and check the boxes of the agents you wish to remove from the team. Click **Remove**.
5. To remove a route association from a skill group, on the Routes tab, click the **Delete** icon beside the route you want to remove. The route will be deleted, and the association with the skill group will be removed when the changes to the skill group are saved.

6. To edit the details of an existing route that is associated with a skill group, click the **Edit** icon beside the route, make the required changes, then click **OK** to confirm the changes. The route details will be changed when the changes to the skill group are saved.

7. Click **Save**.

### 7.22.4 Deleting a Skill Group

**Note**  
You cannot delete a skill group that is referenced in a script. This reference must be removed before the skill group can be deleted.

To delete one or more skill groups:

1. In **System Manager**, go to the folder containing the skill groups you want to delete, and view the skill groups in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the skill groups to be deleted.
3. Click **Delete**.
4. In the Delete Skill Groups dialog box, click **OK**. The skill groups and any routes associated with them will be deleted.

**Note**  
Deleting a skill group automatically removes it from any enterprise skill groups in which it is referenced.

### 7.22.5 Bulk Uploading Skill Groups

In addition to creating skill groups one at a time, you can also bulk load skill group records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

### 7.22.6 Skill Group Fields

This table shows the tabs and fields available for the Skill Group resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Name</td>
<td>A unique enterprise name for the record.</td>
<td>Unique. Up to 32 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the skill group.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Peripheral</td>
<td>The peripheral to be used for the agents in the skill group.</td>
<td>Select from list.</td>
<td>Default Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Media Routing Domain</td>
<td>A description of how contact is made</td>
<td>Select from list</td>
<td>Cisco_Voice</td>
<td>No</td>
</tr>
<tr>
<td>Contact Center Picks The Agent (IPTA)</td>
<td>A tick-box indicating whether Unified CCE selects the Agents within the Skill Group to receive calls</td>
<td>Check box</td>
<td>Checked</td>
<td>No</td>
</tr>
<tr>
<td>Service Level Type</td>
<td>Optionally, use to indicate how abandoned calls should be factored in calculating service levels.</td>
<td>Select from Default, Ignore Abandoned Calls, Abandoned Calls Have Negative Impact, and Abandoned Calls Have Positive Impact. Note: &quot;Default&quot; = Ignore Abandoned Calls.</td>
<td>Use Default</td>
<td>No</td>
</tr>
<tr>
<td>Service Level Threshold</td>
<td>The threshold, in seconds, for the Unified CCE service level.</td>
<td>0 to 2147483647.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Agents Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Agents</td>
<td>Agents associated with this skill group.</td>
<td>Select from lower list of available agents and click Add to include the checked agents in this skill group. To remove existing agents from this skill group, select from upper list and click Remove. To make this skill group the default skill group for an agent, check the Default box beside the agent. To revert the default skill group for this agent to the system default, uncheck the box.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Routes Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Route Name</td>
<td>The name of the route.</td>
<td>Unique. Up to 32 characters, letters, numbers, periods, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Route Description</td>
<td>A description of the route.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enterprise Name</td>
<td>The name that will represent the skill group within the network</td>
<td>Unique. Up to 32 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>From Name and Peripheral</td>
<td>Yes</td>
</tr>
<tr>
<td>Department</td>
<td>(Only shown for tenants associated with Unified CCE instances running Unified CCE version 10.0 or later). The department that this resource is associated with.</td>
<td>Select from the drop-down list of available departments.</td>
<td>None</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------------</td>
<td>------------------------------</td>
<td>----------</td>
</tr>
<tr>
<td>Peripheral Number</td>
<td>The number to be used on the peripheral for the Skill Group</td>
<td>0 to 16777215.</td>
<td>Generated automatically</td>
<td>No</td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the Skill Group should be active in the system</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>Yes</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the Skill Group should be deleted from the system</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
</tbody>
</table>

**Custom Data Tab**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null.</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (<strong><code>**), and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (**</code></strong>), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes.</td>
</tr>
</tbody>
</table>
7.23  User Variables

7.23.1  About User Variables

A user variable is a named object which can hold a value up to 40 characters long. User variables are used in routing scripts.

You can use System Manager to create and delete user variables.

Note

User variables can only be created and deleted. They cannot be edited.

7.23.2  Creating a User Variable

To create a user variable:

1. In System Manager, in the Folder Tree panel, select the folder where you want to create the user variable.
2. In the Folder Tree panel, click Resource, and then click User Variable.
3. Complete the remaining fields as described in section 7.23.5 "User Variable Fields". Active from and to dates can be set in the Advanced tab.

Note

Unified CCE requires that all user variable names begin with the string user. The Code Text will therefore automatically be prefixed with this string on saving. For example, if you enter a Code Text of Temp, the resulting user variable will be called userTemp.

4. Click Save.

7.23.3  Deleting a User Variable

To delete one or more user variables:

1. In System Manager, go to the folder containing the user variables you want to delete, and view the user variables in that folder using the Items panel list view.
2. In the Items panel, check the box or boxes of the user variables to be deleted.
3. Click Delete.
4. In the Delete User Variables dialog box, click OK. The user variables will be deleted.
7.23.4 **Bulk Uploading User Variables**

In addition to creating user variables one at a time, you can also bulk load user variable records previously output to a CSV (comma separated values) file. For more information see section 6.5.1 "About Bulk Upload".

7.23.5 **User Variable Fields**

This table shows the tabs and fields available for the User Variable resource.

For more information about tabs that are common to many resources, see section 6.1.4 "Common Details Panel Tabs".

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Code Text</td>
<td>The name of the user variable.</td>
<td>Up to 28 characters, consisting of letters, numbers, periods and underscores only. Will be automatically prefixed with 'user' by the system upon saving</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Object Type</td>
<td>The type of object with which to associate the variable. You may choose not to associate the user variable with an object by selecting OT_USER_VARIABLE.</td>
<td>Select from list</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Data Type</td>
<td>The data type for the variable.</td>
<td>Select from list</td>
<td>Long</td>
<td>Yes</td>
</tr>
<tr>
<td>Persistent</td>
<td>Whether the user variable retains value across Central Controller restarts.</td>
<td>Check box.</td>
<td>Checked</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the variable and how it should be used.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Path</td>
<td>Only shown when resource is first created. The location in the folder tree where the resource is to be created.</td>
<td>Click on the drop down arrow to show the folder tree, then select the required location.</td>
<td>Current location in folder tree</td>
<td>Yes</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active From Date</td>
<td>The date from which the variable will be active in the system.</td>
<td>Select date from calendar.</td>
<td>Current date</td>
<td>No</td>
</tr>
<tr>
<td>Active To Date</td>
<td>The date after which the variable should be deleted from the system.</td>
<td>Either leave <strong>Forever</strong> checked, or uncheck <strong>Forever</strong> and select date from calendar.</td>
<td>Forever</td>
<td>No</td>
</tr>
<tr>
<td><strong>Custom Data Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Key</td>
<td>The key for this custom data item.</td>
<td>Unique. Up to 50 characters, alphanumeric, period, and underscore characters only. Must begin with alphanumeric.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Value</td>
<td>The value to associate with this key.</td>
<td>Up to 500 characters. To add a new custom data key-value pair, complete both fields, and click <strong>Add</strong>. You can have a maximum of ten custom data key-value pairs. To edit an existing key-value pair, rest the mouse briefly on the entry, select the edit icon (´) and make your changes. Then select the tick to confirm the change, or the cross to undo the change. To delete an existing key-value pair, rest the mouse briefly on the entry, select the delete icon (ـ), then click <strong>OK</strong> to confirm the deletion.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>
8 Security Manager

8.1 Security Features

8.1.1 About Security

8.1.1.1 Security and the Folder Structure

Security management in Unified CCMP is folder based, and therefore a basic folder structure needs to be in place before security can be set up. Users are granted permissions to perform certain tasks within specified folders, and these permissions are inherited by the child folders and on down through the folder tree.

8.1.1.2 Inheritance and Policy Root Folders

By default, all folders except the tenant folder inherit the permissions of their parent. The tenant folder is therefore considered the root folder for a single security policy.

This inheritance link can be broken for individual folders, allowing separate permissions to be applied to them. These folders become policy roots, with their child folders inheriting their permissions.
Figure 8.1  Folders and Security Policies

Note
When changing a user's permissions on a folder, checking the Change permissions for sub-folders box forces the system to propagate the changes into any policy roots below it in the tree.

8.1.2 About Users and Groups

Users can belong to groups of users that have the same permissions. The permissions assigned to that group apply to all members of that group.

Groups may be members of other groups. For example, if you wanted users with permissions over the San Francisco policy root to have permissions only within the San Francisco tree, but users with permissions within the New York policy root to have permissions within both New York and San Francisco, you could create a group for each policy which had permissions only within that policy, and then make the New York group a member of the San Francisco group.
Both users and groups may be members of more than one group.

Users and groups are created, moved, edited and deleted using Tools > Users and Tools > Groups. To assign permissions to a user or group use Tools > Security.

### 8.1.3 About Default Groups

When you break the inheritance link for a folder, you create a new policy root folder. This automatically creates a number of default user groups within the policy root folder, with permissions over that policy. The default groups that are created, and the permissions they are assigned on folders, are set using Settings > System Settings.

Two default groups are also present in the Root folder. These are:

- **Everyone**: allows users to browse the Shared and Unallocated folders. When a user is created they are automatically assigned to this group.
- **Administrators**: provides the host administrator with full permissions throughout the system.

The details of these two groups cannot be changed, although users and groups may be assigned to them or removed from them as normal.

### 8.1.4 About Permissions

Individual permissions (or tasks), such as creating agents or viewing resources, are gathered together into roles. Permissions for users and groups are then granted by means of these roles. There are two kinds of role used to grant permissions:
- **Global roles** globally ‘switch on’ the ability to perform certain kinds of action within the system, such as the ability to access the Security Manager tool (see section 8.2.2 "About Global Roles" for more information about global roles).

- **Folder roles** specify the tasks which may be performed within individual folders, for example the ability to manage security within a specific tenant folder (see section 8.3.2 "About Folder Roles" for more information about folder roles).

For example, to manage security for a folder, a user needs a global role granting security management permissions, and a folder role granting permission to manage security within that folder.

### 8.1.5 About Default Roles

A number of default roles are provided with the system. These roles are shown below.

Default global roles:

- **Global Basic**: allows a user to perform basic provisioning and management functions.
- **Global Advanced**: allows a user to perform advanced provisioning and management functions, including all those allowed by the Global Basic global role.
- **Global Host**: allows a user to perform all licensed functions.

Default folder roles:

- **Supervisor**: allows a user to manage users and most resources in the specified folder.
- **Basic**: allows a user to browse most resources in the specified folder.
- **Advanced**: allows a user to browse and access to most resources in the specified folder, including all those allowed by the Basic folder role and the Supervisor folder role.
- **Full Permissions**: allows a user to perform all licensed functions in the specified folder.

### 8.1.6 About Security Management Tools

Unified CCMP provides the following functions to manage security.
<table>
<thead>
<tr>
<th>Function</th>
<th>Usage</th>
</tr>
</thead>
<tbody>
<tr>
<td>Global Roles</td>
<td>Allows you to create and manage global roles, and to assign these global roles to users and groups. (access via Tools &gt; Roles &gt; Roles)</td>
</tr>
<tr>
<td>Roles</td>
<td>Allows you to create and manage folder roles.</td>
</tr>
<tr>
<td>Users</td>
<td>Allows you to create and manage users, and to view the folder roles and global roles they have.</td>
</tr>
<tr>
<td>Groups</td>
<td>Allows you to create and manage groups, and to view the folder roles and global roles they have.</td>
</tr>
<tr>
<td>Security</td>
<td>Allows you to view and edit (but not create) folder roles, assign folder roles to users and groups, change folder security inheritance and view and edit users and groups.</td>
</tr>
<tr>
<td></td>
<td>Note. Use Tools &gt; Roles &gt; Global Roles to assign global roles to users and groups.</td>
</tr>
</tbody>
</table>

All these functions are available from Tools on the top menu.

8.2 Global Roles

8.2.1 About The Global Role Manager

The Global Role Manager allows you to create and manage global roles, and to assign these global roles to users and groups.

8.2.2 About Global Roles

Global roles are collections of tasks that specify the permissions a user has the potential to perform within the system. For example, a user assigned a global role that includes the 'System Manager' task has the potential to access the System Manager tool if they are assigned folder roles that require this. Global roles are not contained within individual folders, but exist throughout the system and can be applied to any user or group.

The roles that are needed in Unified CCMP are determined by the requirements of the different categories of user who will be working within that system.

Note

If some roles appear disabled and marked as unlicensed following an install or an upgrade, it may be that you need a license upgrade to access those features. Contact your reseller for further information.
8.2.3 Managing Global Roles

Global roles can normally only be managed by host administrators, but it is possible to allow tenant administrators to grant users and groups global permissions without assigning them full global security permissions by setting up global permissions groups in each tenant root, each of which has been uniquely assigned a particular global role.

To manage global roles, click **Tools > Roles** to start the Role Manager, then click **Global Roles**.

8.2.4 Creating a Global Role

To create a global role:

1. In the **Global Role Manager**, click **New**.
2. Give the new role a name reflecting the permissions it grants or the category of user it is intended for.
3. Add a description if necessary, such as a summary of the permissions granted.
4. Select the tasks to be included in this global role.
5. Click **Save**.

8.2.5 Assigning a Global Role

To grant or remove global permissions:

1. In the **Global Role Manager**, click the global role to be assigned to users or groups. The properties of the global role are displayed.
2. Click the **Members** tab.

To remove a user or group from this global role:

1. Click the **Delete** icon (🗑️) by the member, and then click **Confirm**.

To add a user or group to this global role:

1. Click the **Add Members** button. A dialog box will open.
2. Go to the folder containing the users or groups to be assigned this global role. You can use the fields at the top to filter this view to show only users or only groups, or to search for specific names.
3. Select the required members. You can select users and groups from multiple folders. Then click **OK**.
4. Close and **Save**.
8.2.6 Editing a Global Role

To edit a global role:
1. In the Global Role Manager, click the global role to be edited.
2. Click the Details tab and change the details if required.
3. Select Enabled to ensure that the global role is available to system users.
4. Select Hidden if you want the global role to be hidden from system users.
5. On the Tasks tab select the tasks you want to add to the global role, and clear the tasks you want to remove from the global role.
6. Click Save to save your changes.

8.2.7 Deleting a Global Role

To delete a global role:
1. In Global Role Manager, select the global role you want to delete and click Delete.
2. Click OK to confirm the deletion.

Note
You will not be able to delete a global role that still has members.

8.3 Folder Roles

8.3.1 About The Role Manager

The Role Manager allows you to create and manage folder roles.

Note
You cannot use the Role Manager to assign folder roles to users and groups. Use the Security Manager to assign folder roles to users or groups for specific folders.

8.3.2 About Folder Roles

Folder roles are sets of permissions that users and groups may be granted on specific folders. They are not contained within individual folders, but exist throughout the system and can be applied to any user or group for any folder.
The roles that are needed in Unified CCMP are determined by the requirements of the different categories of user who will be working within that system. For each folder role created there should be a global role which provides all the global permissions necessary to allow performance of the tasks specified. A global role with more permissions than needed can normally be safely used instead.

For example, if a folder role contains the task 'Manage Dimensions', there should also be a global role containing the 'System Manager' task along with tasks like 'Provision Agent', 'Provision Agent Desktop', depending on which resources the folder role allows users to manage.

Note
If some roles appear disabled and marked as unlicensed following an install or an upgrade, it may be that you need a license upgrade to access those features. Contact your reseller for further information.

8.3.3 Managing Folder Roles
To manage folder roles, click Tools > Roles.
To grant users roles on specific folders, use the Security Manager instead.

Note
By default, only host administrators can manage folder roles.

8.3.4 Creating a Folder Role
To create a folder role:
1. In the Role Manager, click New.
2. Give the new role a name reflecting the permissions it grants or the category of user it is intended for.
3. Add a description if necessary, such as a summary of the permissions granted or a list of the global roles that are suitable for use with this folder role.
4. Select the tasks to be included in this role.
5. Click Save.

8.3.5 Assigning a Folder Role
To assign a folder role to a folder, use the Security Manager tool (see section 8.6.1 "About the Security Manager").
8.3.6 **Editing a Folder Role**

To edit a folder role:

1. In **Role Manager**, click the folder role you want to edit.
2. Select **Enabled** to ensure that the folder role is available to system users.
3. Select **Hidden** if you want the folder role to be hidden from system users.
4. Select the tasks you want to add to the folder role, and clear the tasks you want to remove from the folder role.
5. Click **Save** to save your changes.

8.3.7 **Deleting a Folder Role**

To delete a folder role, in **Role Manager**, select the folder role you want to delete, click **Delete**, and then **OK**.

**Note**
You will not be able to delete a folder role that is still being used.

8.4 **Users**

8.4.1 **About The User Manager**

The User Manager allows you to create and manage users, and to view the folder roles and global roles they have.

8.4.2 **About Users**

Unified CCMP treats user accounts similarly to resources. That is, each user account must be contained within a specific folder, and users with appropriate permissions on that folder can change the properties of that user (for example, the password) or move or delete the user account.

The folder that contains a user account does not affect the permissions of that user.

8.4.3 **About ISE Enabled Users**

ISE enabled users are Unified CCMP users that are linked to Unified CCE users. When the linked Unified CCE user runs Cisco's Internet Script Editor (ISE), Unified CCMP security is applied to the scripts and resources shown. So the Unified CCE user is only able to access the ISE scripts and resources that the linked Unified CCMP user is able to access.
There are two ways to create a linked Unified CCE and Unified CCMP user so that Unified CCMP security can be applied to ISE scripts and resources. Normally, you will create the user in Unified CCMP, specify that it is ISE-enabled, and Unified CCMP will automatically create the linked Unified CCE user (see section 8.4.5 "Creating a User"). But if a suitable user already exists in Unified CCE, Unified CCMP will automatically import it. You can then configure the user as ISE-enabled in Unified CCMP (see section 8.4.13 "Configuring Imported UCCE Users for ISE Integration").

For more information about configuring ISE to use Unified CCMP security and creating ISE enabled users, see Administration Guide for Cisco Unified Contact Center Management Portal, chapter Remote Resource Provisioning, section Partitioned Internet Script Editor.

8.4.4 Managing Users

To manage users, select Tools > Users. This allows you to create, edit and delete users, add them to groups and remove them from groups.

To change the permissions (folder roles) a user has on specific folders, use Security Manager instead.

8.4.5 Creating a User

To create a user:

1. Select Tools > Users.
2. From the folder tree on the left, select the folder in which to create the new user.
3. Click the New option. The Create a New User page will open.
4. Enter the following details:
   - In the Login Name field enter the name for the new user account. The user will use this name to login to Unified CCMP.
   - In the Password field enter the password for the new user.

Note

For an Internet Script Editor enabled user (see section 8.4.3 "About ISE Enabled Users"), the login name must correspond to an existing Windows active directory user. This name must be formatted as <username>@<domainname>, where <username> is the Windows username and <domainname> is the fully qualified Windows domain name, for example, isuser1@testdomain.local.
Notes
You will not be asked for a password or password confirmation if your installation uses single sign on.

The user's password cannot be the same as their Login Name, and must meet any password restrictions that are specified by the system administrator in Settings > Security Settings.

Additionally, for an Internet Script Editor enabled user (see section 8.4.3 "About ISE Enabled Users"), the password must match the password for the corresponding Windows active directory user.

- In the Confirm Password field re-enter the selected password.
- In the First Name and Last Name fields enter the user's details.
- In the Email field enter the email address (if any) of the new user.
- In the Description field, optionally enter any explanatory text, such as a job title.
- Enter the User Home Folder that the user will start in when they log in. If you leave this blank, it will automatically be set to the folder the user is created in.
- If required, select Create a new folder for this user, to create a new folder for the user below the User Home Folder. The name of the new folder will be the user’s Login Name followed by the default folder suffix specified in Settings > Security Settings > User Folder Suffix.

Note
Basic users will only be able to view their home folder.

5. Select any of the following check boxes which are applicable:

- Select the Advanced Mode check box if the user is to be assigned global roles that allow them to access advanced mode tools such as the System Manager.

Note
The number of advanced users should be limited as far as is practical.

- Select the Account Enabled check box to ensure that the user is live in the system. If unchecked the new user account will be saved in the system, but the user will not be able to login.
- Select the User must change password at next Logon check box to prompt the new user to change their password after their first login.
**8 Security Manager**

- Select the **Password Never Expires** check box to assign the password to the new user indefinitely.
- Select the **User cannot change password** check box to prevent the new user from changing their own password (it can still be changed by administrators).
- Select the **Internet Script Editor Enabled** check box to specify that this user is ISE-enabled (see section 8.4.3 "About ISE Enabled Users"). This also creates a linked Unified CCE user that can access Cisco's Internet Script Editor using VIM security partitioning.

**Note**
If you select **Internet Script Editor Enabled** you must also ensure that:
- the Login Name is in the format specified above for ISE-enabled users
- the user has the **Browse Dimensions** permission on the folders containing the scripts and resources that the linked Unified CCE user needs to be able to access in Cisco's Internet Script Editor.

6. If you wish to create more than one user, select the **Create Another** check box to remain on the Create a new user page after you have created this user.
7. Click **Save**.

**Note**
You can also create a user in **System Manager** (in the Folder Tree panel, select **System > User**).

### 8.4.6 Editing User Details

To edit user details in User Manager:

1. Select **Tools > Users**.
2. From the folder tree on the left, select the folder containing the user to be edited.
3. Click on the user. A page showing the user details opens.
4. Edit details as desired. The user's password can be changed from the **Password** tab, and the user can be added or removed from groups using the **Groups** tab.
8.4.7 Moving a User

To move a user in User Manager:

1. Select Tools > Users.
2. From the folder tree on the left, select the folder containing the user to be moved.
3. Select the check box beside the user to be moved.
4. Click the Move option. The Move a user page will open.
5. Go to the folder you want to move the user to.
6. Click Save.

Note
You can also move a user in System Manager by clicking on the user in the Items panel (list view).

8.4.8 Deleting a User

To delete a user:

1. Select Tools > Users.
2. From the folder tree on the left, select the folder containing the user to be deleted.
3. Select the check box beside the user to be deleted.
4. Click the Delete option and confirm the deletion when prompted.

Note
You can also delete a user in System Manager by selecting the check box beside the user in the Items panel (list view) and clicking Delete.

8.4.9 Copying a User

To copy a user thus copying all of the user’s settings, group memberships and roles:

1. Select Tools > Users.
2. From the folder tree on the left, select the folder containing the user to be copied.
3. Click on the user. A page showing the user details will open.
4. Click on the Copy option. A dialog displaying empty user fields will be displayed.
5. Fill in the details of the new user.
6. Click the Copy button on the dialog.

8.4.10 Viewing User Permissions

To see a user’s permissions (folder roles and global roles):
1. Select Tools > Users.
2. From the folder tree on the left, select the folder containing the user.
3. Click on the user. A page showing the user details will open.
4. Click on the Access option. You can see the folders the user can access, the roles the user can perform on each folder and the global roles the user has.

Note
The Access option does not show whether these permissions have been assigned directly to the user or through group memberships.

If there is an asterisk (*) beside a folder role or global role in the list, then that permission is not currently active. This may be:
- because the folder role or global role is not enabled
- because the user has inherited the permission by being a member of a group that has the permission, but the group is not enabled.

8.4.11 Changing User Permissions

To change the permissions (folder roles) a user has in a folder, use the Security Manager tool (see section 8.6.1 "About the Security Manager").

To change the global roles that a user has, use the Global Role Manager (see section 8.2.1 "About The Global Role Manager").

Note
For ease of maintenance, it is recommended that you assign user permissions to groups, not to individual users.
8.4.12 Changing the Groups a User Belongs To

To change the groups a user belongs to, use the Groups tab:

1. Select Tools > Users.
2. From the folder tree on the left, select the folder containing the user to be updated.
3. Click on the user. A page showing the user details will open.
4. Select the Groups tab.
5. From the Groups tab, you can remove the user from groups by clicking on the Delete icon (Dé) beside each group.
6. You can add the user to new groups, as follows:
   - Click the Add to Group button. A dialog box opens.
   - Go to the folder containing the group the user is to be added to.
   - Select the check box of the group or groups. You can select groups from multiple folders.
7. Click Close and Save.

8.4.13 Configuring Imported UCCE Users for ISE Integration

Existing Unified CCE administrator users are automatically imported into Unified CCMP in a format which supports Internet Script Editor (ISE) partitioning. These Unified CCMP users need to be configured before the corresponding Unified CCE users can use the ISE for partitioned editing.

To configure an imported Unified CCE user for partitioned ISE access:

1. Select Tools > Users or Tools > System Manager and locate the user to be edited. The user name will be formatted as <username>@<domainname>, where <username> is the Windows user name and <domainname> is the fully qualified Windows domain name. An example of an imported user name could be iseuser1@testdomain.local. The imported user will be in your default import location unless you have moved the user after the import.
2. Click the user to view the details.
3. On the Details tab, select Account Enabled to enable the user.
4. Give this user Browse Dimensions permission on the Unified CCE folders and resources that they need to access using the Cisco Internet Script Editor. You can do this in one of the following ways:
   - Select the Groups tab and add the user to a group that already has the required permissions.
Alternatively, after you have finished the remaining steps in this section, select **Tools > Security**. On the **Users** tab, select the check box beside the user, then click **Change Permissions**. Identify a suitable folder role that includes **Browse Dimensions**, and assign it to this user for each of the folders containing the scripts and resources you want this linked user to be able to access.

5. Click **Save** to update the user details for the linked Unified CCMP user.

6. If your Unified CCMP installation does not use single sign on, then before this user can be used to access ISE, you must log in to Unified CCMP as this user, and supply a password when prompted. This password must be the same as the password for the corresponding Windows active directory user. If your VIM installation uses single sign on, this step is not required.

---

**Note**

For more info about ISE enabled users, see section 8.4.3 "About ISE Enabled Users" and *Administration Guide for Cisco Unified Contact Center Management Portal*, Chapter Remote Resource Provisioning, section Partitioned Internet Script Editor.
## 8.4.14 User Fields

### 8.4.14.1 Fields Available When Creating a User

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Login Name</td>
<td>A unique login name for the Portal user.</td>
<td>Unique. Up to 50 characters. Any Unicode character is valid, except single quote ('), double quote (&quot;), and Unicode characters in the &quot;Symbol, Other&quot; category. Additionally, for an Internet Script Editor enabled user, the login name must correspond to an existing Windows active directory user. This name must be formatted as <code>&lt;username&gt;@&lt;domainname&gt;</code>, where <code>&lt;username&gt;</code> is the Windows username and <code>&lt;domainname&gt;</code> is the fully qualified Windows domain name, for example, <code>iseuser1@testdomain.local</code></td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the Portal user.</td>
<td>Up to 50 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the Portal user.</td>
<td>Up to 50 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Email</td>
<td>The user’s email address</td>
<td>Up to 255 characters. Must be a valid email address in the format <code>name@domain.extension</code>.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Culture</td>
<td>The language and location setting for this user.</td>
<td>Select from the drop-down list</td>
<td>Culture setting of the user creating the new user</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the Portal user.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Advanced Mode</td>
<td>Indicates whether this user has advanced mode functionality.</td>
<td>Check this box to specify whether the user has advanced mode functionality.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------</td>
<td>-----------</td>
<td>----------</td>
</tr>
<tr>
<td>Account Enabled</td>
<td>Indicates whether this user is currently active on the system.</td>
<td>Check this box to specify that the user is currently active. If this box is not checked then this user will not be able to log on to the Portal web application.</td>
<td>Selected</td>
<td>No</td>
</tr>
<tr>
<td>User must change password at next login</td>
<td>Indicates whether this password is only valid for a single log in.</td>
<td>Check this box to force the user to change their password the next time they log in.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Password never expires</td>
<td>Indicates whether the password will never expire.</td>
<td>Check this box to specify that the user’s password never expires. If this box is not checked, the user’s password will expire after the number of days specified in Settings &gt; Security Settings &gt; Password Expiry.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>User cannot change password</td>
<td>Indicates whether the user cannot change their password.</td>
<td>Check this box to specify that the user cannot change their password. If this box is not checked, the user can change their password using Settings &gt; Change Password.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>User Home Folder</td>
<td>The user’s home folder.</td>
<td>From the folder tree, select the location of the home folder that the user will be taken to on login.</td>
<td>/</td>
<td>Yes</td>
</tr>
</tbody>
</table>
| Internet Script Editor Enabled      | Indicates whether the user is linked to a Unified CCE user.                | Check this box to create a linked Unified CCE user that can access Cisco's Internet Script Editor using the security settings of this VIM user. In this case, the following apply:  
  - The login name must correspond to an existing Windows active directory user.  
  - If the installation does not use single sign on, the specified password must match the password for the corresponding active directory user. | Cleared    | No       |
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create a new folder for this user</td>
<td>Indicates whether to create a new folder for this user.</td>
<td>Check this box to create a new folder for the user below the User Home Folder. The name of the new folder will be the user’s Login Name followed by the default folder suffix specified in Settings &gt; Security Settings &gt; User Folder Suffix.</td>
<td>Cleared</td>
<td>No</td>
</tr>
<tr>
<td>Password</td>
<td>The password that the user will use to log in to the system.</td>
<td>Only required if the installation does not use single sign on. The user’s password cannot be the same as their Login Name, and must meet any password restrictions that are specified by the system administrator in Settings &gt; Security Settings. Additionally, for an Internet Script Editor enabled user, the password must match the password for the corresponding Windows active directory user.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>The same as for the Password field. This ensures that the user is not prevented from logging in by typographical errors made when setting his or her password.</td>
<td>Only required if the installation does not use single sign on. Enter password confirmation. This must match the value specified in the Password field.</td>
<td>Null</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### 8.4.14.2 Fields Available When Editing a User

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Details Tab</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Login Name</td>
<td>A unique login name for the Portal user.</td>
<td>Unique. Up to 50 characters. Any Unicode character is valid, except single quote ('), double quote (&quot;), and Unicode characters in the &quot;Symbol, Other&quot; category. Additionally, for an Internet Scrip Editor enabled user, the login name must correspond to an existing Windows active directory user. This name must be formatted as <code>&lt;username&gt;@&lt;domainname&gt;</code>, where &lt;username&gt; is the Windows username and &lt;domainname&gt; is the fully qualified Windows domain name, for example, <code>iseuser1@testdomain.local</code></td>
<td>Current value</td>
<td>Yes</td>
</tr>
<tr>
<td>First Name</td>
<td>The first name of the Portal user.</td>
<td>Up to 50 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Last Name</td>
<td>The last name of the Portal user.</td>
<td>Up to 50 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Email</td>
<td>The user's email address</td>
<td>Up to 255 characters. Must be a valid email address in the format <a href="mailto:name@domain.extension">name@domain.extension</a></td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the Portal user.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>User Home Folder</td>
<td>The user's home folder</td>
<td>From the folder tree, select the location of the home folder that the user will be taken to on login.</td>
<td>/</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced Mode</td>
<td>Indicates whether this user has advanced mode functionality.</td>
<td>Check this box to specify whether the user has advanced mode functionality.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>Account Enabled</td>
<td>Indicates whether this user is currently active on the system.</td>
<td>Check this box to specify that the user is currently active. If this box is not checked then this user will not be able to log on to the portal web application.</td>
<td>Selected</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
</tr>
<tr>
<td>------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| Internet Script Editor Enabled | Indicates whether the user is linked to a Unified CCE user                  | Check this box to create a linked Unified CCE user that can access Cisco's Internet Script Editor using the security settings of this VIM user. In this case, the following apply:  
  - The login name must correspond to an existing Windows active directory use.  
  - If the installation does not use single sign on, the specified password must match the password for the corresponding active directory user. | Cleared | No       |

**Password Tab (only present if the installation does not use single sign on)**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset Password</td>
<td>Whether to reset the password for this user.</td>
<td>Check this box to reset the user’s password.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>
| Password                     | Only shown if Reset Password is checked. The new password for this user.    | The user’s password cannot be the same as their Login Name, and must meet any password restrictions that are specified by the system administrator in Settings > Security Settings.  
Additionally, for an Internet Script Editor enabled user, the password must match the password for the corresponding Windows active directory user. | Null    | Yes      |
| Confirm Password             | Only shown if Reset Password is checked. The same as for the Password field. | Enter password confirmation. This must match the value specified in the Password field.                                                                                                                 | Null    | Yes      |
| User exceeded maximum login attempts | Set by the system if the user has been locked out of the system because the maximum number of login attempts has been exceeded. | Clear this box to re-enable the user if the user has been locked out for exceeding the maximum number of login attempts.  
The user will not be able to log on to the portal until this box has been cleared. | Null    | No       |
### Groups Tab

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password never expires</td>
<td>Indicates whether password will never expire.</td>
<td>Check this box to specify that the user’s password never expires. If this box is not checked, the user’s password will expire after the number of days specified in Settings &gt; Security Settings &gt; Password Expiry.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>User cannot change password</td>
<td>Indicates whether the user cannot change their password.</td>
<td>Check this box to specify that the user cannot change their password. If this box is not checked, the user can change their password using Settings &gt; Change Password.</td>
<td>Null</td>
<td>No</td>
</tr>
<tr>
<td>User must change password at next login</td>
<td>Indicates whether this password is only valid for a single log in.</td>
<td>Check this box to force the user to change their password the next time they log in.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

### Groups

#### 8.5.1 About The Group Manager

The Group Manager allows you to create and manage groups, and to view the folder roles and global roles they have.

#### 8.5.2 About Groups

Unified CCMP treats groups similarly to resources. That is, each group must be contained within a specific folder, and any user with appropriate permissions on that folder can change the properties of the group.

The folder that contains a group does not affect the permissions of that group.
8.5.3 Managing Groups

To manage groups, click Tools > Groups. This allows you to create, edit and delete groups, add users or other groups to them and remove users or other groups from them.

To change the permissions (folder roles) a group has on specific folders, use Security Manager instead.

8.5.4 Creating a Group

To create a group:
1. Select Tools > Groups.
2. From the folder tree on the left, select the folder in which to create the new group.
3. Click the New option. The Create a new group page opens.
4. Enter the following details:
   - In the Name field enter the name for the new group. Groups in different folders may have the same name.
   - In the Description field enter a description for the group, such as a summary of its permissions or the categories of users it is intended for.
   - If you want to create more than one group, select the Create Another check box to remain on the Create a new group page after you have created this group.
5. Click Save.

Note
You can also create a group in System Manager (in the Folder Tree panel, select System > Group).

8.5.5 Editing Group Details

To edit group details:
1. Select Tools > Groups.
2. From the folder tree on the left, select the folder containing the group to be edited.
3. Click on the group. A page showing the group details opens.
4. Edit details as desired. Members of the group can be added or removed using the Members tab, and the group itself can be added to or removed from other groups using the Groups tab.

**Note**
You can also edit a group in System Manager by clicking on the group in the Items panel (list view).

### 8.5.6 Moving a Group
To move a group:

1. Select **Tools > Groups**.
2. From the folder tree on the left, select the folder containing the group to be moved.
3. Select the check box beside the group to be moved.
4. Click **Move**. The Move a group page opens.
5. Go to the folder you want to move the group to.
6. Click **Save**.
7. Alternatively, click on the group name and click the **Move** option from the details page.

**Note**
You can also move a group in System Manager by selecting the check box beside the group in the Items panel (list view) and selecting **Move**.

### 8.5.7 Deleting a Group
To delete a group:

1. Select **Tools > Groups**.
2. From the folder tree on the left, select the folder containing the group to be deleted.
3. Check the group's check box.
4. Click the **Delete** option and confirm the deletion when prompted.

**Note**
You can also delete a group in System Manager by checking the box beside the group in the Items panel (list view) and selecting **Delete**.
### 8.5.8 Viewing Group Permissions

To view the permissions of a group (folder roles and global roles):

1. Select **Tools > Groups**.
2. From the folder tree on the left, select the folder containing the group.
3. Click on the group. A page showing the group details will open.
4. Click on the **Access** option. You can see the folders that members of this group can access, the roles that they can perform on each folder and the global roles the user has.

**Note**

The Access option does not show whether these permissions have been assigned directly to the group or are inherited through membership of other groups.

If there is an asterisk (*) beside a folder role or global role in the list, then that permission is not currently active. This may be:

- because the folder role or global role is not enabled
- because the group has inherited the permission by being a member of a larger group that has the permission, but the larger group is not enabled
- because the group is not enabled.

### 8.5.9 Changing Group Permissions

To change the permissions (folder roles) members of a group have in a folder, use the Security Manager (see section 8.6.1 "About the Security Manager").

To change the global roles that members of a group have, use the Global Role Manager (see section 8.2.1 "About The Global Role Manager").

### 8.5.10 Changing the Members in a Group

To change the members of a group, use the **Members** tab:

1. Select **Tools > Groups**.
2. From the folder tree on the left, select the folder containing the group.
3. Click on the group. A page showing the group details will open.
4. Select the **Members** tab.
5. From the Members tab, you can remove members by clicking on the Delete (🗑️) icon beside their names.
6. From the Members tab, you can add members as follows:
   - Click the **Add Members** button. A pop-up will open.
• Go to the folder containing the users or groups to be added to the current group. You can use the fields at the top to filter this view to show only users or only groups, or to search for specific names.

• Check the check box of the new members. You may select users and groups from multiple folders.

7. Click Close and Save.

Note
You can also change the members in a group in System Manager by clicking on the group in the Items panel (list view).

8.5.11 Changing the Groups a Group Belongs To

To change the groups that a group belongs to, use the Groups tab:

1. Select Tools > Groups.

2. From the folder tree on the left, select the folder containing the group to update.

3. Click on the group. A page showing the group details opens.

4. Select the Groups tab.

5. From the Groups tab, you can remove the group from other groups it is a member of click the Delete icon (Trash) by the group.

6. From the Groups tab, you can add the group to other groups as follows:
   • Click the Add to Group button. A dialog box will open.
   • Go to the folder containing the group the current group is to be added to.
   • Check the check box of the group or groups. You may select groups from multiple folders.

7. Click Close and Save.

Note
You can also change the groups a group belongs to in System Manager by clicking on the group in the Items panel (list view).
### 8.5.12 Group Fields

#### 8.5.12.1 Fields Available When Creating a Group

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the group.</td>
<td>Unique. Up to 50 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>A description of the group.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
</tr>
</tbody>
</table>

#### 8.5.12.2 Fields Available When Editing a Group

<table>
<thead>
<tr>
<th>Details Tab</th>
<th>Field</th>
<th>Description</th>
<th>Entry</th>
<th>Default</th>
<th>Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>A unique name for the group.</td>
<td>Unique. Up to 50 characters, letters, numbers, and underscore characters only. Must begin with letter or number.</td>
<td>Null</td>
<td>Yes</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>A description of the group.</td>
<td>Up to 255 characters.</td>
<td>Null</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Enabled</td>
<td>Indicates whether this group is currently active on the system.</td>
<td>Check this box to specify that the group is currently active. If this box is not checked then any access that has been granted to users through this group is not available.</td>
<td>Selected</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Entry</td>
<td>Default</td>
<td>Required</td>
<td></td>
</tr>
<tr>
<td>--------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------</td>
<td></td>
</tr>
<tr>
<td>Members Tab</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Members</td>
<td>Add members to this group or remove members from this group.</td>
<td>To add one or more members to this group, click Add Members, go to the folder that contains the users to add, then select the user or users and click OK. To remove a user member from this group, click ✗ beside the user you want to remove from the group.</td>
<td>Null</td>
<td>No</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Groups</td>
<td>Add this group to another group or remove this group from another group.</td>
<td>To add this group to another group, click Add to Group, go to the folder that contains the group you want to add this group to, then select the group and click OK. To remove this group from another group, click ✗ beside the group you want to remove this group from.</td>
<td>Null</td>
<td>No</td>
<td></td>
</tr>
</tbody>
</table>

### 8.6 The Security Manager

#### 8.6.1 About the Security Manager

The Security Manager tool allows you to:

- view the folder roles assigned to users and groups for a particular folder
- assign folder roles to users and groups for a particular folder
- change the folder role inheritance for a folder
- view and edit the permissions available in a folder role
- view and edit users
- view and edit groups.

To start the Security Manager, click Tools > Security.

**Note**

You cannot use the Security Manager to assign global roles to users and groups. Use the Global Role Manager to assign global roles to users and groups.
8.6.2 Viewing Folder Roles Assigned to a Folder
To see the folder roles that users and groups have on a particular folder, select that folder from the folder tree on the left. All the folder roles that users or groups have on the selected folder are shown in the Permissions tab.

8.6.3 Assigning Folder Roles to Users and Groups
To use Security Manager to assign folder roles to users or groups:
1. In Security Manager, click on the location in the folder tree that contains the users or groups you want to assign folder roles to. Then:
   - either click on the Users tab to see the users in that folder
   - or click on the Groups tab to see the groups in that folder.
2. Check the box or boxes beside the users or groups that you want to edit the permissions for.
3. Click Change Permissions to change the folder roles for the selected users or groups.
4. If you see a message telling you that the current folder is inheriting permissions, and you want to break the inheritance and set different permissions for this folder, click Edit Item Security then OK to confirm the action. Cancel if you do not want to break the inheritance.
5. If you are continuing to set folder roles, in the Folder Permissions dialog box, select a folder location from the folder tree on the left hand side of the screen, and one or more folder roles from the right hand side of the screen.
6. Check the Change Permissions for Subfolders if you want to copy the changed permissions to the subfolders of the selected folder also.
7. Click Save to see a summary of the folder roles that will be changed.
8. Click Confirm to apply the new folder roles.

Note
When assigning folder roles, be aware that, in some cases, to modify an item, users may need browse permissions on related items as well as needing permissions to modify the item itself. For example, in order to modify Agent and/or Skill Group configuration, a user must be able to see the Peripheral that they belong to.

8.6.4 Changing the Inheritance for a Folder
To change a folder's inheritance rule:
1. In **Security Manager**, from the tree on the left, select the folder to change.

2. In the **Permissions** tab, clear the **Inherit permissions from parent** check box to break the inheritance with the parent (or select it to reapply inheritance).

3. Click **OK** to confirm.
   - If you break the inheritance, the initial permissions will be set to those that currently exist on the folder. These can then be changed if necessary.
   - If you recreate the inheritance, the security settings for the folder will be replaced with those of its parent folder.

### 8.6.5 Viewing and Editing Folder Roles

To view the folder tasks that are included in a folder role:

1. In **Security Manager**, select a folder from the folder tree and click the **Permissions** tab to view the folder roles that apply to the selected folder.

2. Click on the folder role that you want to view or edit, to see a list of tasks that could be included in this folder role.

3. Check the **Enabled** check box to ensure that the folder role is available to system users.

4. Check the **Hidden** check box if you want the folder role to be hidden from system users.

5. Check the tasks you want to add to the folder role, and uncheck the tasks you want to remove from the folder role.

6. Click **Save** to save your changes.

**Note**

You can also use the **Role Manager** tool to view or edit the folder tasks included in a folder role (see section 8.3.6 "Editing a Folder Role").

### 8.6.6 Editing User Details

To edit user details in Security Manager:

1. In **Security Manager**, click on a location in the folder tree, and click on the **Users** tab to see the users in that folder.

2. Edit the user details as described in section 8.4.6 "Editing User Details".

3. Click **Save**.
8.6.7 **Editing Group Details**

To edit group details in Security Manager:

1. In **Security Manager**, click on a location in the folder tree, and click on the **Groups** tab to see the groups in that folder.
2. Edit the group details as described in section 8.5.5 "Editing Group Details".
3. Click **Save**.
9 System Administration Tasks

9.1 About Administrator Tasks
This section identifies the main tasks that users with tenant administrator permissions perform in Unified CCMP. Tasks do not need to be performed in the order shown below, however, this order reflects the dependency of certain item types on the existence of others.

Note
Users with System Administrator permissions can also perform all of the tasks in this section.

9.2 Agent and Group Related Tasks
The tasks listed below pertain to agent record creation and agent groupings.
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Where</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Agent Desktops</td>
<td>An Agent Desktop associates a set of permissions or characteristics with specific agents, such as how and when calls to these agents are redirected, how and when they enter various works states, and whether they can make outbound calls. You can create a Default Desktop that is the set of permissions automatically assigned to all new agents unless overridden.</td>
<td>Manage Agent Desktops page</td>
</tr>
<tr>
<td>Create Agents and Agent Supervisors. Assign desk settings to agents.</td>
<td>In order to use the back-end system, all prospective agents first need an account which includes a login name and password. You can designate certain agents as supervisors, allowing them to be later designated as supervisors of agent teams. You can assign different desk settings to different agents based on their needs, and, as necessary, temporarily suspend their login permissions or turn on Agent State Trace, which allows you to track their transition through various states of readiness.</td>
<td>Manage Agents page</td>
</tr>
<tr>
<td>Create Skill Groups and assign agents to skill groups.</td>
<td>A skill group is a collection of agents that share a common set of skills. Skill groups are one of the primary devices for call routing. An agent can be associated with multiple skill groups and each skill group is associated with a specific media routing domain (MRD) such as voice, chat, or e-mail.</td>
<td>Manage Skill Groups page</td>
</tr>
<tr>
<td>Create Agent Teams. Assign agents and supervisors to teams.</td>
<td>Agent teams allow you to associate a set of agents with a specific supervisor. This association allows Unified CCE to determine which supervisor to route an agent's Supervisor Assist requests to.</td>
<td>Manage Agent Teams page</td>
</tr>
<tr>
<td>Optionally, create Enterprise Skill Groups. Assign skill groups to enterprise skill groups.</td>
<td>An enterprise skill group is a logical grouping of skill groups, and can include skill groups from different MRDs. Unlike the Skill Groups page, the Enterprise Skill Groups page can display skill groups from all MRDs.</td>
<td>Manage Enterprise Skill Groups page</td>
</tr>
</tbody>
</table>

### 9.3 Contact Routing Tasks

The tasks listed below relate to contact (voice and non-voice) routing configuration.
<table>
<thead>
<tr>
<th>Task</th>
<th>Description</th>
<th>Where</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Call Types.</td>
<td>A call type is a category of incoming routable task. Specific call types are associated with Dialed Numbers. In this association, each call type has a schedule that determines which routing script(s) are active for that call type at any time. Because the call type determines which routing script is run for a call, the call type defines call treatment in a Unified CCE system. There are two classes of call type/dialed number associations: voice and non-voice.</td>
<td>Manage Call Types page</td>
</tr>
<tr>
<td>Create Dialed numbers. Map Call Types to Dialed Numbers.</td>
<td>You set up a Dialed Number List, which identifies all of the phone numbers in your contact center that customers can dial to initiate contact. Dialed numbers are mapped to call types; this mapping is used to identify the appropriate routing script for each call. A typical call center requires a number of dialed number definitions. In addition to answered calls, dialed numbers also need to be set up for ring on no answer, dialed number plan entries, and for supervisor/emergency assist calls.</td>
<td>Manage Dialed Numbers page</td>
</tr>
</tbody>
</table>
Glossary

A

Advanced Mode
A CCMP operation mode that provides access to all CCMP functionality and tools that a user is allowed to access. Compare with Basic Mode.

Agent
Any contact center operative dealing with customers, usually by answering incoming phone calls. Each agent is associated with a peripheral and can be a member of one or more skill groups.

Agent Desktop
the phone settings for an enterprise or Unified CCE agent. Agent Desktops can be associated with each Unified CCE agent or with a Unified CCE peripheral.

Agent Team
A functional grouping of agents. An agent team is generally served by the same peripheral and has a common business focus such as a specific aspect of technical support.

Available
A call state in which the logged in agent is ready to accept calls. The equipment will not route a call to an agent unless they are available. This is a key metric monitored by supervisors to ensure the readiness of their team to accept calls. A careful balance is required to ensure that there are enough Agents available to accept calls without overstaffing or understaffing.

B

Basic Mode
A CCMP operation mode that provides a simple user interface for supervisors to manage agent teams and skills. Compare with Advanced Mode.

Breadcrumb Trail
A trail of links indicating the user’s current location in a folder hierarchy or a set of related pages. You can usually click on a link in the breadcrumb trail to go directly to that location.
C

Call Type
A category of incoming call, associated with one or more dialed numbers.

CCMP Resource
A resource that is created and managed by CCMP. These resources are local to CCMP, and not provisioned onto the remote equipment, for example, folders, users, groups. A CCMP resource may or may not be associated with a tenant. Also known as a System Resource. See also Resource. Compare with Remote Resource.

Cisco Unified Communications Manager (Unified CM)
A computer platform that provides the facilities of a traditional private branch exchange telephony system (PBX) to packet devices such as Voice over IP (VoIP) gateways.

Cisco Unified Contact Center Enterprise (Unified CCE)
Cisco call routing platform.

Cisco Unified Customer Voice Portal (Unified CVP)
A telephone system that allows callers to use touchtone signals or their own voice to request self-service information.

Comma Separated Variable (CSV)
A method of representing a spreadsheet using a text file. The values are separated by commas, and each record is ended by a line break. The column headers are contained in the first record.

CSV
See Comma Separated Variable.

D

Dialed Number
The telephone number dialed by the calling party.

Dimension
Another name for a resource.
**Drill down, Drill up**
To navigate through trees or data hierarchies. Drill down to view child folders or data in finer detail and drill up to view parent folders or summarized data values.

**E**

**Enterprise Service**
An organizational grouping of agents within a company, perhaps spanning several contact centers and served by different peripherals, providing a specific customer service, such as technical support.

**Enterprise Skill Group**
Organizational association of contact center agents within a company, perhaps spanning several contact centers and served by different peripherals. Agents in a skill group share common talents such as technical or language abilities, or skills in dealing with complaints.

**Exception**
A value which falls outside set parameters. Exceptions may be highlighted for ease of identification. See Thresholds.

**Extensible Markup Language (XML)**
A markup language used to create special-purpose markup languages. It allows data to be shared across different systems, particularly systems connected via the Internet.

**Extension (filenames)**
The characters that end a filename, and which identify the type of data in that file, and hence which program or programs that can access it.

**Extension (telephone)**
Either a telephone number that is local to the switch or a telephone station served by a PBX.

**F**

**Folder Role**
A collection of folder-based security tasks that a user or group is able to do. A user or group that has a specific folder role on a specific folder is able to perform all the tasks in that folder role on that folder. They can also perform those tasks in any subfolders that inherit their security.
permission from that parent folder. In some cases, access to a folder role task is controlled by a Global Role task that allows access to the required functionality. For example, a Supervisor folder role may be defined which allows various supervisor tasks like managing users and information notices. A user or group that has the Supervisor folder role assigned to a folder will be able to do these tasks in that specific folder. See also Role, Global Role, Task.

G

Global Role
A collection of global tasks that a user or group is allowed to perform. A user or group that has a specific global role is able to do the tasks in that global role. For example, a global role called Basic User may be defined, which allows basic functionality like accessing information notices and modifying their own user settings. A user or group that has the Basic User global role will be able to do these tasks, provided they have an appropriate Folder Role in any related folder. See also Role, Folder Role, Task.

Group
A collection of one or more users who share the same security roles. See also Roles, User.

H

HCS
See Hosted Collaboration Solution

Hosted Collaboration Solution
A unified communications and collaboration platform for service providers and partners who want to offer Cisco collaboration technologies using hosted and managed models.

HTML
See Hypertext Markup Language.

Hypertext Markup Language (HTML)
A markup language used to build web pages and other information that can be viewed in a web browser.
I

Information Notice
A notice used to inform contact center staff of general information or new announcements.

Interactive Voice Response (IVR)
See Voice Response Unit.

Internal in
An internal (non-customer) call received by an agent.

Internal out
An internal (non-customer) call initiated by an agent.

IP Phone
A telephone that can be integrated into a network.

IVR
See Voice Response Unit.

L

Label
An identifier, usually a destination number, which is associated with a specific peripheral target or with a specific network target used for call routing purposes.

Login Name
The name that a user uses to log on to CCMP. Sometimes called User Name.

M

Media Routing Domain (MRD)
A collection of skill groups and services associated with a particular contact medium, such as voice or email.
Micro-application
A VRU function that can be invoked from a Network VRU Script, to communicate with the caller, for example, to play a message to the caller, or to retrieve digits that the caller has entered on the keypad.

MRD
See Media Routing Domain.

N
Not Ready
A call state in which the logged in agent is not involved in call activities but is also not ready to accept calls.

P
Peripheral
A device or switch that routes customer phone calls to contact center staff. The term peripheral is also used to describe parts of a contact center enterprise that receive calls from the device (see also Peripheral Agent, Peripheral Service and Peripheral Skill Group).

Peripheral Gateway (PG)
Software developed by Cisco Systems that enables the Unified CCE to communicate with other network devices such as an ACD, IVR or PBX.

Peripheral Service
A group of contact center agents that receive calls routed from the same peripheral device and provide a specific customer service, such as technical support.

Peripheral Skill Group
See Skill Group.

Person
The representation of a physical person on the contact center system. A person may be linked to a CCMP Login Name and to one or more Agents. See also Agent, Login Name.
PG
See Peripheral Gateway.

Prefix
A character or characters added to a folder to specify where to place imported resources.

Prefix Rule
A rule that specifies where to locate imported items that have a specified prefix.

R
Ready (agent state)
An agent state where an agent is logged in and available to receive a call.

Ready (resource state)
A resource state where a resource is active in the system and has no pending edits to be applied.

Remote Resource
A resource that exists on the remote equipment. Some remote resources can be created or edited in CCMP and provisioned onto the remote system. Other remote resources can be accessed by CCMP but cannot be created, edited or provisioned in CCMP. A remote resource is always associated with a tenant. See also Resource, CCMP Resource.

Remote Tenant
A tenant that exists on remote equipment.

Reserved
A call state in which an agent is waiting for a specific call and is unavailable to take general incoming calls.

Resource
An entity that represents an asset belonging to a customer, for example, a dialed number, an agent, a call route. Resources are stored in folders. Also see Remote Resource or CCMP Resource.
Role
A collection of tasks that are commonly performed by the same group of people (for example, defined by their business role or position). A role can be a Global Role (defining a collection of general tasks) or a Folder Role (defining a collection tasks that are associated with folders). See also Folder Role, Global Role and Task.

Script
A program that performs a specific simple, repeated task such as determining where to route a call.

Skill Group
An organizational association of contact center agents sharing common talents (for example, technical or language abilities). Skill groups are associated with a particular peripheral and allow the Unified CCE to route calls to the most appropriate available agent. Several skill groups at different contact centers are served by different peripherals and may be collectively combined in an Enterprise Skill Group.

State (resource)
The provisioning status of a resource. There are five states: Pending Active, Error, Ready, Delete Pending and Deleted.

Supervisor
A person responsible for a team of agents. A supervisor can add and remove agents and view statistics for the team that they supervise. A supervisor may also be an agent. See also Agent Team.

System Administrator
The highest level of user in the management system. The System Administrator is responsible for creating more users and granting user permissions and access permissions.

System Resource
See CCMP Resource.
T

Task
An action that a user may or may not be able to perform, depending on the security permissions they have been assigned. The task may be a global task (for example, running the Security Manager tool, provisioning an agent) or a task that is associated with a folder (for example, creating a user in a specific folder, managing information notices in a specific folder). Tasks are collected together to create Roles. See also Folder Role, Global Role and Role.

Tenant
The CCMP representation of a real world organizational unit. Tenants are used to group contact center resources in isolation, providing customers with a security partitioning mechanism.

Tenant Folder
A folder exclusive to a particular tenant. It is the same as a system folder except that a tenant folder does not inherit the security permissions of a parent folder and is a stand-alone entity. Compare with Folder.

Toolbar
In the CCMP GUI, a row of one or more buttons at the top of a panel that shows a list of functions or options. These buttons are used to access the various functions and options available to the user.

Top Menu
In the CCMP GUI, the options shown at the top right of all pages. These commonly include Home, Tools, Help, Settings and Logout, and may be customized.

Transfer
A call forwarded to an agent.

Trunk
A collection of telephone lines associated with a single peripheral and usually used for a common purpose.
U

Unified CCE
See Cisco Unified Contact Center Enterprise.

Unified CM
See Cisco Unified Communications Manager.

Unified CVP

User
A CCMP user, identified by a Login Name.

V

Voice Response Unit (VRU)
A device capable of automatically routing a call using a customer's replies to a series of prompted messages. A VRU may respond directly to a customer's voice or to a sequence of caller entered digits. Also called Interactive Voice Response Unit (IVR).

X

XML
See Extensible Mark-up Language.